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Harga Rp. 6.000,- (Pulau Jawa), Rp. 6.500,- (Luar Jawa)
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Kirim Naskah
ke PCplus?

Apabila Anda
memiliki ide, gagasan,
kiat, trik, seputar dunia
komputer dan teknologi
informasi, PCplus menerima
kiriman naskah dari Anda.
Syaratnya:

1. Naskah harus bersifat
orisinal dan belum pernah
dimuat/dikirimkan ke
media lain.

2. Naskah dikirim dalam
format RTF. Bila dalam
naskah terdapat gambar,
gambar dikirim terpisah
dan tidak dimasukkan
dalam body text. Format
gambar dikirim dalam
format JPG.

3. Naskah dikirimkan
melalui e-mail ke
naskah@e-pcplus.com.

4. Penulis harus
mencantumkan NAMA
ASLI PENULIS, ALAMAT E-
MAIL, dan NOMOR
REKENING PENULIS.

5. Naskah yang dimuat akan
mendapatkan honor
sepantasnya. Penentuan
layak tidaknya pemuatan
artikel dan besarnya
honor yang diterima
penulis merupakan
wewenang penuh dari
Tabloid PCplus dan tidak
dapat diganggu gugat.

6. Pengiriman honor artikel
yang dimuat dilakukan
paling cepat dua minggu
setelah pemuatan di
Tabloid PCplus. Apabila
setelah empat minggu
honor belum diterima,
silakan Anda
menghubungi Sdr. Dian/
Putri dengan alamat
dian@e-pcplus.com atau
putri@e-pcplus.com untuk
mendapatkan kepastian
transfer honor artikel
Anda.

Semarak Festival Pesta Digital

Seperti janji kami minggu lalu, edisi ini kami tampil lebih wah. Kertas
lebih putih, halaman lebih banyak, dan (maaf beribu maaf untuk yang
satu ini) harga sedikit lebih mahal. Semarak Festival Komputer Indonesia 5
membikin kami harus tampil spesial buat Anda. Kami berembug dengan
bagian keuangan dan iklan serta produksi, supaya Anda benar-benar
menikmati sajian yang istimewa. Sebagai pemberitahuan, kenaikan harga
PCplus menjadi 6000 rupiah, hanya berlaku untuk edisi yang spesial ini.
Kompensasinya memang tak tanggung-tanggung: kertas HVS yang lebih
putih, cetakan penuh warna alias full color, dan jumlah halaman lebih
banyak (40 halaman).

Kami juga menurunkan sajian utama yang spesial. PlusFokus kali ini
hadir dengan dua tema, yakni pengujian motherboard yang
menggunakan chipset Intel i865 (Springdale) serta pembahasan mengenai
Linux yang lebih mendetail. Tentu saja, kami juga menyuguhkan beragam
artikel menarik lainnya di rubrik-rubrik unggulan kami.

Yang tak kalah menarik adalah kegiatan below the line kami.
Mengiringi FKI 5 kali ini, sebagaimana telah kami sampaikan sebelumnya,
PCplus menggelar beraneka lomba, baik di Jakarta maupun di Surabaya.
Lomba-lomba ini pun materinya diambil dari serangkaian workshop yang
pernah diselenggarakan PCplus. Tentu saja, karena keterbatasan tempat
dan waktu, kami terpaksa membatasi jumlah peserta. Kalau memang
tertarik, buruan segera daftar!

Kami juga ingin menjadikan FKI ini benar-benar festival bernuansa
pesta digital. Di jaman serba digital begini, apa sih yang tidak terendus
oleh bau-bau digital? Oleh karenanya, lomba memotret dengan kamera
digital menjadi salah satu acara unggulan kami. Menggabungkan unsur
digital dan keceriaan festival, lomba diharapkan membuka kesadaran
masyarakat akan aroma digital yang telah menaungi kita beberapa tahun
belakangan ini. Don’t miss it! Anda pasti akan menyesal tidak
menyempatkan waktu, minimal sekadar melongok kegiatan lombanya.

Selamat menikmati semarak festival, selamat berlomba, selamat
berpesta digital!

Salam hangat dari Palmerah
Redaksi

SOLUSI MASALAH PC
Redaksi PCplus di tempat.

Saya salah satu dari sekian
banyak orang yang mengenal IT
dari PC+. Seringkali membaca
PC+ lama kelamaan saya jadi
tertarik dan ingin mempunyai
sebuah PC. Berbekal
pengetahuan dari PC+ saya jadi
mengerti dalam menentukan
konfigurasi PC. Tapi sekarang
saya ada masalah, PC saya
menggunakan INTEL P4 1.8Ghz,
memori 256MB PC 2700, HDD
30GB 7200 RPM yang saya
partisi jadi 2 bag untuk  WIN98
& WIN XP. Yang jadi pertanyaan
adalah:

1. Mengapa pada WIN XP
ketika shutdown kok lama
sekali? Bagaimana trik untuk
membuatnya lebih cepat?

2. Apakah normal suhu
prosesor sampai 58' C?
Padahal kipas tambahan
sudah terpasang 2 buah.

3. DDR PC2700 memiliki clock
berapa MHz? Setting-an dari
toko pada BIOS adalah
200MHz, namun begitu saya
default menjadi 266Mhz.
Apakah berbahaya bila
tetap di-setting 200MHz?

4. Apa yang dimaksud clock
ratio? Pada BIOS saya, di-
setting 23x, sedangkan kalau
di default hanya 15x.
Apakah ini juga berbahaya?

Saya ucapkan terima kasih
atas jawabannya.

Bayu
mmscadm@mms.telkomsel.com

Red: Masalah Anda cukup menarik,
Bung. Kami menjawab pertanyaan
Anda melalui rubrik plusKiat di edisi
depan.

BAHAS LINUX
Hai PC plus... Bahas Linux

donk, kan Linux open source..
jadi smua pembaca tau dan bisa
mempelajari Linux, jadi bisa
punya OS yang legal bukan
BAJAKAN !!!. Apa sih kelebihan
dan kekurangan dari distro Linux
RedHat, Suse, Debian, Mandrake,
Dll....????? (bales yaa, gue lagi
butuh banget informasi itu..)
Thank's yaaa

Muhammad Syafrudin
aput13@yahoo.com

Red: Mulai edisi 130, kami sudah
membahasnya Bung. Tunggu
kejutan kami selanjutnya setelah
pembahasan di rubrik Linux di
PCplus. Kami sedang merencanakan
sesuatu dengan Linux. Mudah-
mudahan terealisasi dalam waktu
dekat.

PERKARA HAK CIPTA
Saya pikir penertiban

undang-undang hak cipta

merupakan hal yang benar.
Dengan kata lain, kami
membenarkan adanya
penertiban tersebut karena
penghargaan terhadap hak cipta
atas suatu karya sangat dijunjung
tinggi oleh masyarakat
internasional. Dengan adanya
penertiban itu, tingkat
pembajakan yang terjadi di
Indonesia akan berkurang, yang
dirasakan sekarang ini masih
sangat besar, termasuk di
kalangan kami sebagai
mahasiswa teknik di suatu
perguruan tinggi Indonesia.
Namun permasalahan di sini,
apakah kami sanggup untuk
membeli setiap program sah
(dengan lisensi product) yang
kami butuhkan, terutama
operating system yang harganya
sulit dijangkau, apalagi oleh para
mahasiswa seperti kami. Sudah
sekian banyak orang-orang yang
berpikiran sama seperti kami,
namun mereka juga terbentur
oleh situasi yang sama seperti
kami. Sekian pendapat dari kami,
terima kasih dan tolong
diberikan tanggapannya.

Angga Wicaksana
gha_insaneyahoo.com

Red: Makanya, kami juga
menawarkan rubrik baru Linux, salah
satunya untuk menjawab
problematika hak cipta tersebut.
Harapannya, dengan rubrik baru ini
masyarakat terangsang untuk
menggunakan software open
source. Microsoft sendiri sebagai
salah satu perusahan software
terbesar dan produk (bajakannya)
banyak dipakai masyarakat juga
menyiapkan software edisi bahasa
Indonesia, yang mudah-mudahan
bisa dijual secara lebih murah,
apalagi untuk keperluan pendidikan.

SOFTWARE E-BOOK
Redaksi PCplus, Saya usul

agar PC Plus memuat tulisan
selengkap mungkin tentang cara
membuat ebook dengan format
PDF dan HTML. Untuk PDF
menggunakan software yang
mudah diperoleh. Sedangkan
untuk ebook COMPILER HTML
menggunakan Sbook (FREEWARE
). Saya sudah mencari-cari
software pembuat ebook PDF
yang gratisan tetapi kok nggak
dapat. Ada Easy PDF tetapi kok
untuk file XML. Jangan hanya
segi perangkat saja ya yang
dibahas tetapi juga content-nya
semacam buku elektronik.
Soalnya banyak lho yang belum
menguasai teknologi ini.
Langkah-langkahnya yang jelas
ya dan mudah dipahami. Kalau
perlu pakai screenshot. O ya
bagaimana ya cara buat
screenshot? Terima kasih,
wasalam.

Lukyastirin
Yogyakarta

Red: Usulan akan diperhatikan,
Luky.

BUKU PCPLUS LAGI DAN
CARA LANGGANAN

Nama saya Andi Wibowo
dari Bandung dengan e-mail
andi_wibowo_2000@yahoo.com.
Beberapa waktu lalu saya
pernah bertanya tentang
CD-RW, pasti Anda ingat,
tetapi sekarang saya mau
bertanya tentang hal lain, kalau
boleh. Sebelumnya dan
sesudahnya saya ucapkan terima
kasih atas jawaban yang
diberikan oleh Saudara M.
Firman. Pertanyaan saya dan
mungkin juga sebagai usulan
dan saran bagi PCplus, saya
ucapkan terima kasih atas
terbitnya dan beredarnya buku
tentang cara cara merakit dan
mencocokkan hardware, saya
sudah membelinya dan sangat
berguna bagi saya.
Pertanyaannya, kapan PCplus
mengeluarkan buku semacam itu
lagi dan apa temanya? Kalau
boleh saya bertanya tentang
buku, kapan PCplus
mengeluarkan buku bertema
Upgrade dan overclock serta
cara-caranya? Oh yah, apakah
buku tentang cara cara meng-
overclock dan cara cara meng-
upgrade sudah pernah atau
sampai saat ini masih ada di
pasaran ? Kalau ada tolong
beritahukan kepada saya judul,
pengarang, dan yang
menerbitkannya dan di mana
saya bisa mendapatkannya?
Terima kasih dan semoga PCplus
selalu jaya. Oh yah, bagaimana
caranya saya berlangganan
PCplus, saya berdomisili di
Bandung. Kalau ada kantor
cabangnya atau kantor
langganan, saya harus
mendaftar ke mana? Terima
kasih atas perhatiannya. Hidup
PCplus..........

Andi Wibowo
andi_wibowo_2000@yahoo.com

Red: Nuhun banget masukannya
Mang Andi. Kami telah
memikirkannya, tetapi untuk
merealisasikan masih menunggu
waktu yang tepat. Untuk
berlangganan, Anda bisa langsung
menghubungi agen koran terdekat
dari rumah tinggal Anda.

PINGIN WORKSHOP DAN
BUKU PCPLUS

Dear ....... PCplus tolongin
saya dong..... Saya pingin sekali
mengikuti workshop merakit
komputer yang diadakan oleh
PCplus. Tapi sayang, karena jarak
yang cukup jauh serta
keterbatasan waktu saya tidak
dapat mengikutinya..... So, saya
akan sangat berterima kasih
sekali apabila saya dapat
memperoleh ataupun dengan
cara membeli buku workshop

merakit komputer tersebut kalo
ada disertai dalam bentuk CD-
nya.... Bagaimana saya dapat
membelinya dari PCplus? Kalo
bisa saya harus transfer ke
rekening mana.... atau bisa
nggak lewat wesel pos saja.
Tolongin saya ya PCplus. Trim's.
Saya tunggu konfirmasinya
segera.

Indrat Susanto
indrat_susanto@yahoo.com

Red: Kami sudah jawab melalui e-
mail prosedur pemesanannya.
Thanks banget atas apresiasinya
terhadap workshop yang
diselenggarakan PCplus.
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Workshop Merakit PC STMIK
Nurdin Hamzah Jambi. Melanjutkan program
workshop
merakit PC ke
daerah, kali ini
workshop digelar
di Jambi. Kali ini
workshop diikuti
oleh sekitar 250
peserta yang
terdiri dari
Mahasiswa
STMIK Nurdin
Hamzah, kampus
–kampus
sekitarnya, pelajar, dan masyarakat umum. Bahkan ada peserta yang
jauh-jauh datang dari Palembang, khusus untuk mengikuti acara ini.

Hari pertama acara yang digelar di aula kampus pada tanggal
23-25 Juni sempat terganggu oleh pemadaman listrik oleh PLN di
seluruh kota Jambi.”Terpaksa penginstalan Windwos XP untuk sesi 1
dan sesi 2 pada kami pindah ke hari Kamis pagi 26 juni,” jelas Teuku
Syamsul Bahri sebagai koordinator acara

Setiap sesi juga dimeriahkan oleh presentasi dari Asus tentang
motherboard P4C800 yang di bawakan oleh Alfian, technical
support yang rajin hadir di acara workshop merakit PC mewakili
Astrindo.

Salah satu peserta berpendapat bahwa biaya yang dikeluarkan
sesuai dengan apa yang diperoleh, selain memperoleh sertifikat,
buku merakit, Tabloid PCplus, juga ada hadiah yang disediakan oleh
PCplus dan sponsor pendukung. (***)

Matrox Rilis Driver terbaru
untuk Produk Parhelia dan
Millennium P-Series. Driver yand disebut
Windows Hardware Quality Labs (WHQL) tersebut merupakan
dukungan driver terbaru kartu grafis Matrox pada platform Win-
dows XP dan Windows 2000. Dengan rilis ini, Matrox menawarkan
suatu fitur grafis untuk pekerjaan-pekerjaan yang bersifat CAD
(computer aided design). (snu)

Serba-serbi Memori Dual Kanal. Dual-channel sebenarnya bukanlah
konsep yang baru. Sekitar 1 atau 2 tahun yang lalu, produk dengan dual-channel memory telah
memasuki pasaran, tetapi masih dengan basis arsitektur yang terpadu dan berakhir dengan harga yang
tidak dapat diterima, karena tidak seimbang dengan kinerja. Produk seperti itu tidak memiliki
kesempatan untuk bertahan.

Jadi apa perbedaan antara 1 dan 2 channel? Perbedaan mendasar adalah seperti jalan tol
1 jalur dan 2 jalur. Jalan tol dengan 2 jalur dapat mengakomodasi kendaraan 2 kali lebih banyak,
yang berarti lalu lintas akan lebih lancar dibandingkan dengan jalan tol dengan 1 jalur saja. Untuk
sistem yang menggunakan single-channel arsitektur untuk data processing, berarti user harus
menunggu CPU menyelesaikan suatu pekerjaan sebelum melanjutkan yang lainnya.

Bagaimana cara menghitung bandwidth memory? Bandwidth = bus speed x bus frequency. Untuk
menghitung dalam satuan MB/detik, bus speed harus dibagi 8 untuk mengubah bit menjadi byte. Jika
kita ambil contoh DDR266 memiliki bandwidth sebesar 64 bit x 266MHz/8, sama dengan 2128MB/detik
atau 2100MB/detik. Inilah sebabnya DDR266 disbut juga PC2100. Sama juga halnya dengan DDR333
yaitu 64 bit x 333MHz/8, sama dengan 2664MB/detik atau 2700MB/detik atau DDR400 yaitu 64 bit x
400MHz/8, sama dengan 3200MB/detik.

Sistem seperti apa yang mendukung teknologi dual-channel? Pertama-tama, supaya dual-channel
dapat bekerja, motherboard dan chipset harus mendukung teknologi dual-channel juga. Kedua, Anda
harus memasang dua buah modul memori pada motherboard dengan chipset dual-channel, dan kedua
memori harus identik. Jika tidak, kinerja sistem anda akan sama dengan single-channel motherboard
dengan 2 buah modul.

Chipset Intel dual-channel sebelumnya, i850, i850E dan i860, mendukung RIMM, tetapi biaya yang
mahal membuat teknologi ini terhenti penggunaannya beberapa waktu. Baru-baru ini, Intel
mengeluarkan lagi chipset dual-channel, tetapi kali ini menggunakan memori DDR. Chipset E7205,
E7501, E7505, Canterwood  (i875P)  dan Springdale  (i865PE) dilengkapi dengan DDR dual-channel.
E7501 dan E7505 dirancang untuk server Xeon dan E7205, Canterwood dan Springdale untuk Pentium
4. SIS dan nVidia juga mengeluarkan chipset SIS 655 dan Nvidia Nforce2 yang mendukung teknologi
dual-channel. (snu)

Perangkat Lunak dan PDA Berbasis Keagamaan
Islam. Frazer-Nash dan Islamic Research Centre memperkenalkan perangkat lunak multimedia
berbasiskan keagamaan Islam: Al Murshid yang telah lulus dari proses tashih (pengkajian) oleh
Departemen Agama RI.  Perangkat lunak yang dikemas dalam CF Card Sandisk 256 Megabyte ini dapat
bekerja di PDA (Personal Digital Assistant) HP iPAQ tipe 3970.  Fitur yang disajikan antara lain: bacaan
dan terjemahan ayat-ayat suci Al Quran (30 Juz) dalam bahasa Ingris, Arab, Melayu, dan Indonesia,
diiringi suara lantunan ayat suci al Quran oleh Sheik Mohamed Gebril dari Universitas al Azhar Cairo,
waktu sholat berbagai belahan dunia, kompas arah kiblat, multi time zone clock, serta tuntunan ibadah
haji plus lafalan doa-doa.  PT BeSMART Sarana Martindo adalah perwakilan Islamic Research Center
serta pemasar produk ini di Indonesia. (vin)



4 |

plusTechnews IV • 09 - 15 Juli 2003
PCplus 134

HP Luncurkan Pocket PC, Note-
book, dan Desktop PC Terbaru.
Hewlett-Packard kembali meluncurkan produk-produk IT
terbarunya berupa pocket PC, notebook, serta desktop PC di Hotel
Mulia, Jakarta, 2 Juli lalu.  Jajaran pocket PC yang diperkenalkan
adalah seri iPAQ h2210, h1930, h1940, serta h5550. Tipe h2210
menggunakan prosesor Intel X-scale PXA255 400 MHz, dilengkapi
dual slot expansion untuk
CF card tipe II dan SD
card, bluetooth wireless,
serta aplikasi software
Nevo universal remote
control.  Seri h1930 dan
h1940 memiliki fasilitas
tambahan wireless
memory card melalui
SDIO expansion slot dan
menggunakan prosesor
Samsung S3C2410 203-
266 MHz.  Sementara seri
h5550 ditujukan untuk SOHO dan enterprise dengan menyediakan
unparallel 128 MB RAM, integrated biometric security, serta
wireless LAN network access yang lebih dikenal sebagai Wi-Fi.

Sementara itu, notebook yang diperkenalkan adalah seri
nx7000 yang menggunakan layar ultra widescreen XGA.  HP nx7000
menggunakan prosesor Intel M berteknologi Centrino1,4-1,6GHz,
chipset Intel 855PM, kartu grafis ATI Radeon 9200, harddisk 40-
60GB, RAM DDR 2GB.  Selain itu, dilengkapi dengan slot SD
memory card, 3 port USB, port IEEE 1394.  Kemampuan yang
disertakan adalah konektivitas WiFi dan Bluetooth.

Tak ketinggalan, PC desktop masih tetap menjadi sasaran
pengembangan HP.  Kehadiran seri d330 dan d530 adalah buktinya.
Kedua desktop PC ini dilengkapi dengan Kensingtron lock, port
controls, smart keyboard reader, hood sensor serta pre-installed
smart cover lock. HP D530 dilengkapi dengan HP ProtectTools untuk
mengacak (enkripsi) data, e-mail ataupun sandi melalui drag and
drop yang user friendly. Desktop PC ini menggunakan prosesor
Intel Celeron atau Pentium 4, chipset 865G, harddisk 160GB, RAM
DDR 4GB, DVD-ROM, dan CD-RW.  Sedangkan “adik”nya, seri d330
menggunakan RAM DDR 128 MB dan harddisk 40GB. (vin)

HP Luncurkan Server Kokoh  yang Memberi Definisi
Baru Terhadap Data Center Ekonomis. Serangkaian server terkuat
berbasiskan prosesor Intel Itanium2 1,5GHz yang menghadirkan definisi baru terhadap data center
ekonomis, di mana server tersebut mampu melakukan penghematan sampai dengan $1 juta dalam tiga
tahun dibanding pesaing-pesaingnya.

Keluarga server yang disebut sebagai Integrity ini cukup beragam, mulai dari satu dan dua prosesor
untuk entry-level systems sampai dengan HP Integrity Superdome yang menggunakan 64-prosesor dan
menawarkan efisiensi biaya, performa tinggi, infrastruktur sistem multioperasi, yang dibutuhkan dalam
menghadapi tantangan bisnis dalam membentuk adaptive enterprise.

“Sekarang sistem berbasis Itanium 2 telah menjadi tren,” kata Michael Muller, vice president,
Enterprise Storage and Servers, Enterprise Systems Group, HP Asia Pasifik. Sebagai fondasi dari strategi
server berbasis standar, HP bermaksud untuk mempertahankan dua arsitektur standar industri jangka
panjang, yakni IA-32 dan IA-64/Itanium. HP mengumumkan rencana untuk melakukan upgrade server
HP ProLiant DL560, DL580, ML570, DL740, dan DL760, serta ProLiant BL40p blade server dengan prosesor
Intel Xeon MP mutakhir berkecepatan sampai dengan 2.8 GHz, yang diperkirakan tersedia di
pertengahan bulan Juli

Server HP Integrity Superdome adalah mesin tercepat di dunia dengan harga lebih baik dari pesaing
high-end lainnya dan tersedia dalam konfigurasi 16, 32, dan 64 prosesor. Memperkuat jaringan di
belakang Itanium, HP mengumumkan bahwa lebih dari 700 aplikasi software dan tools komersial dan
tekhnis tersedia atau kini bergerak menuju lini server Integrity dan Workstation HP Itanium 2.  Aplikasi
tersebut termasuk perangkat lunak dari BEA, Microsoft, Oracle, PeopleSoft, SAP, SAS, dan Siebel.  HP
mengharapkan lebih dari 1,000 aplikasi akan tersedia untuk system Itanium di akhir tahun ini. (snu)

Jajaran Printer Laser Baru “Linux Ready” dari
Samsung. Dukungan terhadap sistem operasi Linux kini semakin bertambah dengan
diperkenalkannya tiga seri printer laser dari
Samsung, yaitu: ML-1710, ML-1750, serta ML-
2151N. Seri ML-1750 (dengan prosesor Samsung
166 MHz, memori 8MB, kecepatan 17 ppm
resolusi 1200dpi), seri ML-2151N (dengan
memori 16MB, kecepatan 21 ppm resolusi 1200
dpi, kemampuan cetak halaman ganda dan
double sided alias duplex), dan seri ML-2151N
(performa tertinggi untuk area jaringan dan
memiliki kemampuan wireless LAN atau Wi-Fi)
merupakan printer kantoran. Seri ML-1710
(dengan prosesor Samsung 66MHz, kecepatan
17 ppm 600 dpi) adalah printer tangguh di
kelasnya. (vin)

ARE/PCplus

ARE/PCplus
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KUIS
Dapatkan 3 buah CD-RW SW-252 bagi 3 orang pemenang  yang

beruntung dan menjawab pertanyaan kuis di bawah ini dengan benar.
Tuliskan jawaban Anda pada sehelai kartu pos. Cantumkan identitas

Anda dengan jelas, meliputi: NAMA, ALAMAT, NO. KTP/SIM, USIA,
PEKERJAAN, NO. TELP, JENIS KELAMIN. Gunting dan tempelkan kupon asli
yang tersedia pada halaman ini (di bawah), lalu kirimkan ke:

Redaksi PC-PLUS
Gedung Grasindo Lantai 2
Jl. Palmerah Selatan No. 12,
Jakarta 12070

Jawaban kami terima paling akhir tanggal 19 September 2003, dan
pemenang akan diumumkan pada Tabloid PCplus Edisi 147

PERTANYAAN

1. Bila Anda mau membeli CD-ROM/CD-RW/DVD-ROM, apakah yang
    menjadi pertimbangan Anda?

a. Harga
b. Brand / Merk
c. Spesifikasi
d. Lain-lain: …………………………

2. Apakah yang Anda tahu tentang Technology pada Optical Disc Drives
    (ODD) khususnya CD RW? ………………

3. Model seperti apa yang Anda miliki sekarang?
a. Single Drive ( CD, DVD, CD RW drive )
b. Combo drive ( DVD RW drive )

    Bila jawaban Anda a, Apakah dalam waktu dekat Anda akan
    menggantinya/upgrade menjadi Combo drive?

a. Ya, sebab ....
b. Tidak, sebab ...

4. Software apa yang paling mudah dioperasikan?
a. Nero
b. In CD
c. Easy Creator
d. Copy CD
e. Lain-lain: …………………………

5. Apakah CD-ROM/CD-RW/DVD-ROM yang Anda miliki se-
    karang ini ada masalah dengan kompabilitasnya dengan OS?

a. Ya, merk produk…..  dengan OS .…..
b. Tidak K
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Drive CD-RW SW-252:
Menulis Secepat Membaca

Ketika kecepatan rekam CD mencapai 40x beberapa waktu yang lalu, orang
sebenarnya sudah bisa menghitung bahwa kecepatan tersebut bisa ditingkatkan

sampai 52x. Tetapi bagi sebagian produsen, justru timbul keraguan. Untuk apa
membuat drive CD-RW dengan kecepatan sampai secepat itu, padahal

konsekuensinya bahkan mungkin lebih tinggi daripada tambahan manfaatnya?
Dengan kecepatan 40x saja banyak CD akhirnya justru menjadi rusak, tidak

terekam dengan baik, bahkan ada yang pecah berkeping-keping.

Tetapi manusia memang tidak akan puas jika belum sampai limit, dan dengan
kecerdasannya, konsekuensi itu pun bisa dihindarkan --paling tidak, dieliminasi. Baru-baru ini, PT Samsung
Electronics Indonesia (SEIN) menghadirkan wajah baru lagi pada jajaran Optical Media Solutions (OMS)-nya, yaitu
drive CD-RW SW-252. Produk baru ini, yang mulai dipasarkan di Indonesia sejak awal Juni lalu, memiliki
kemampuan rekam secepat kemampuannya membaca, yaitu 52x. Untuk ukuran saat ini --dan mungkin sampai
nanti-- kecepatan baca-tulis CD ini adalah yang paling cepat.

TEKNOLOGI PENAHAN GETAR
Sebenarnya, yang membuat orang membatasi kecepatan pemutar CD adalah karena getar yang dihasilkan

oleh kecepatan yang tinggi akan menyebabkan tekanan yang sangat besar terhadap media CD. Jika CD tidak kuat,
CD tersebut bisa pecah atau retak. Selain itu, pada waktu perekaman (burn) CD juga dituntut adanya aliran data
dari komputer ke perekam CD yang konstan. Jika kecepatan CD jauh melampaui kecepatan aliran data yang
sanggup disediakan oleh penyangga (buffer), maka akan terjadi error, atau perekaman CD menjadi tidak
sempurna.

Pada produk-produk pemutar CD atau perekam CD buatan SAMSUNG terbaru sudah dilengkapi dengan
teknologi yang disebut DVA (Dynamic Vibration Absorber). Selain menahan getar akibat putaran CD yang cepat,
teknologi ini juga akan meredam kebisingan (noise) yang dihasilkan.

MEREKAM CD 650MB DALAM 2.5 MENIT
Apakah arti kecepatan rekam yang tinggi yang dimiliki oleh CD-RW SW-252 beserta teknologi pendukungnya

bagi Anda? Secara sederhana, itu berarti Anda bisa membuat sebuah CD dengan kapasitas 650MB hanya dalam
waktu 2.5 menit! (bandingkanlah dengan waktu perekaman oleh drive CD-RW yang telah Anda miliki sekarang).
Drive SW-252 mendukung perekaman yang lebih stabil menggunakan memori penyangga (buffer) sebesar 8MB,
yang berarti 4 kali lebih baik dibandingkan produk yang lain.

Mungkin di sini akan timbul sebuah pertanyaan: bagaimanakah dengan waktu pemformatannya? Seringkali
ketika kita ingin menggunakan sebuah CD-RW untuk menyimpan data, kita diharuskan menunggu pemformatan
CD sekian lama. Pada SW-252 kita tidak perlu lagi membuang waktu karena SAMSUNG telah menyertakan sebuah
fungsi Mt. Rainier yang hanya akan memformat seksi Lead In. Sebuah pengurangan waktu format yang
mengagumkan.

PANGSA PASAR 50%
Drive CD-RW SW-252 kompatibel secara sempurna dengan keping CD-R (yang hanya merekam sekali) dan CD-

RW (yang bisa merekam lebih dari 1000 kali). SW- 252 juga kompatibel dengan software penyalinan CD. Dengan
kompatibilitas ini diharapkan SW-252 tidak hanya populer di kalangan pemakai umum, namun juga bagi para
pemakai profesional.

Selain itu, produk ini juga telah dirancang untuk memenuhi berbagai kebutuhan pemakai.  Hematnya ruang
penempatan  disk yang digunakan disebabkan produk ini bisa dioperasikan pada posisi vertikal sama baiknya
seperti horisontal untuk instalasi. Produk ini juga memiliki kemampuan untuk dapat secara otomatis mengetahui
fungsi yang dibutuhkan pemakai.

Menyadari kehandalan produknya tersebut, PT Samsung Electronics Indonesia kabarnya berencana menjual
SW-252 lebih dari 50% dari pasar CD-RW Indonesia.

SPESIFIKASI:
Jenis Produk Drive CD-RW
Tipe SW-252 (52x 24x 52x)
Kecepatan Baca 52x
Kecepatan Tulis 52x
Kecepatan Tulis-ulang 24x
Bundled Software Nero Burning ROM
Produsen PT Samsung Electronics Indonesia

DVD-ROM DAN CD-ROM YANG TIDAK BERISIK
Mungkin Anda termasuk yang sudah kesal terhadap kebisingan yang ditimbulkan oleh perputaran DVD atau

CD. Sudahkah Anda mencoba DVD-ROM tipe SD-816 dan CD-ROM tipe SC-152 buatan SAMSUNG? Dengan
teknologi DVA (Dynamic Vibration Absorber), getar dan bising (noise) yang ditimbulkan oleh kecepatan putaran
CD/DVD bisa ditekan sedemikian rupa sehingga Anda bisa mendengarkan suara musik atau video kesayangan Anda
tanpa terganggu lagi.

SPESIFIKASI:
Jenis Produk Drive DVD-ROM
Tipe SD-816
Transfer Data 16x
Fitur * Multi-read, bisa membaca DVD-R, DVD-RW, dan DVD-RAM

* Kompatibel dengan berbagai kartu MPEG II dan software MPEG
Produsen PT Samsung Electronics Indonesia

SPESIFIKASI:
Jenis Produk Drive CD-ROM
Tipe SC-152
Transfer Data 52x
Fitur * Multi-read, bisa membaca CD-R/RW, CD-DA, dan CD-ROM/XA, VCD,

   CD-I, Photo CD, CD-EXTRA, CD-TEXT
* Menggunakan dua teknologi untuk menahan getar dan meredam
   bising, yaitu DVA (Dynamic Vibration Absorber) dan ABS (Automatic
   Ball Balancing).

Produsen PT Samsung Electronics Indonesia
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Mengenal Bandwidth
dari Beberapa Interface

pada PC

Interface, kata yang
mungkin sudah sering

Anda dengar.
Interface atau

antarmuka dalam
bahasa Indonesia

memang merupakan
hal yang penting
dalam dunia PC.

Interface ini
menghubungkan dua
buah komponen yang

berbeda. Sehebat
apapun kinerja kedua

komponen tersebut,
bila interface yang

digunakan tidak bisa
mengimbangi, kinerja
yang diperoleh tidak

akan optimal. Oleh
karena itu, dalam

perkembangan PC,
interface ini seringkali

mendapat perhatian
yang besar.

alah satu fungsi
utama dari interface
itu dalam
menghubungkan

kedua komponen tersebut
adalah melakukan transfer
data. Transfer data ini bisa
dilakukan secara paralel
maupun secara serial.
Untuk clock kerja yang sama,
tentu saja paralel akan

mentransfer data yang lebih
banyak setiap detiknya.
Sementara itu dari sisi konektor
yang diperlukan, serial
membutuhkan konektor yang
lebih sedikit.
Saat ini kecenderungan ke arah
serial kelihatannya semakin
besar. Ihwal paralel dan serial ini
sudah pernah dibahas
sebelumnya.

PCI
PCI (Peripheral

Component
Interconnect)
merupakan interface
yang sudah menjadi
standar pada dunia
PC masa kini. PCI ini
sudah cukup lama
digunakan pada
dunia PC. Mungkin
tidak lama lagi PCI
ini akan mendapat
saingan yang berat
dari interface lain
yang memiliki

bandwidth yang lebih besar.
Untuk grafis sendiri,

tepatnya kartu grafis, PCI ini
telah digantikan oleh AGP
(Accelerated Graphics Port) yang
menawarkan bandwidth yang
jauh lebih besar dan beberapa
fitur lain yang menarik. Untuk
kartu tambahan internal lainnya,
PCI ini masih menjadi standar
dalam dunia PC.

PCI ini bekerja dengan lebar
data sebesar 32-bit dan memiliki
clock sebesar 33MHz. Hal ini
membuat bandwidth yang
dimiliki oleh PCI ini adalah
sebesar 133MB/s.

Bandwidth yang sebesar ini
adalah bandwidth yang dimiliki
oleh keseluruhan slot PCI.

Dengan kata lain bila slot PCI
yang tersedia ada lima buah,
maka bandwidth tersebut akan
dibagi pada kelimanya, selama
kelima slot itu digunakan.
Tentunya bila hanya ada satu
kartu tambahan internal yang
dipasangkan pada PCI slot
tersebut, bandwidth sebesar
133MB/s itu akan tersedia
seluruhnya untuk kartu
tambahan tersebut. Dengan
semakin besarnya kebutuhan
akan bandwidth dari berbagai
kartu tambahan saat ini, PCI
memang sering kali tidak
dapat lagi memenuhi
kebutuhan tersebut,
khususnya bila terpasang dua
atau lebih kartu tambahan
yang membutuhkan
bandwidth besar pada saat
yang bersamaan.

PCI masih menjadi interface yang umum
untuk berbagai kartu tambahan

AGP menawarkan kinerja yang lebih baik
dibandingkan dengan PCI
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USB 2.0 telah menajadi standar baru untuk interface
eksternal

AGP
AGP, seperti telah disebut-

kan di atas adalah interface yang
dikhususkan untuk grafis. Sebe-
lum AGP ini digunakan, kartu
grafis masih menggunakan inter-
face PCI yang hanya memiliki
bandwidth sebesar 133MB/s.
Kinerja kartu grafis dirasakan
terhalang oleh bandwidth dari
PCI yang hanya sebesar itu.

AGP ini memiliki lebar data
sebesar 32 bit seperti halnya
PCI, hanya saja clock yang di-
milikinya adalah 66MHz, lebih
besar dari PCI. Pada perkem-
bangan selanjutnya, clock
efektif dari AGP ini lebih besar
dari 66MHz dengan tersedianya
AGP 2x, AGP 4x, dan AGP 8x.
Bisa dikatakan clock yang
sebesar 66MHz itu adalah clock
efektif untuk AGP 1x.

Bandwidth
yang tersedia
pada
interface
AGP ini juga
beragam,
mulai dari
266MB/s
untuk AGP
1x hingga
2133MB/s
untuk AGP
8x. Di
samping
memiliki
bandwidth
yang lebih
baik, kartu

grafis yang menggunakan AGP
ini juga memiliki fitur lain seperti
kemampuan untuk mengguna-
kan memori utama sebagai tem-
pat penyimpanan tekstur se-
hingga menambah ruang kosong
pada lokal memori yang dimiliki
untuk digunakan menyimpan
data lain. Di samping itu AGP ini
juga terhubung secara langsung
pada northbridge, tidak seperti
PCI yang terhubung pada south-
bridge. Hal ini membuat berapa-
pun besar bandwidth antara
southbridge dengan northbridge
tidak akan menghambat kinerja
dari AGP ini.

ATA
ATA (dan juga ATAPI) meru-

pakan interface yang umum di-
gunakan untuk menghubungkan
sistem dengan peralatan

penyimpanan non-volatile seperti
halnya harddisk dan CD-Writer.
Saat ini ATA yang umum diguna-
kan masih mengusung teknologi
paralel atau mulai umum disebut
sebagai PATA. PATA (Parallel ATA)
ini sudah mendapat pengganti
yang menggunakan teknologi
serial dan disebut dengan SATA
(Serial ATA).

Parallel ATA yang banyak di-
gunakan saat ini memiliki band-
width sebesar 100MB/s atau
133MB/s. Sementara itu Serial
ATA yang baru saja diperkenal-
kan memiliki bandwidth sebesar
150MB/s. Dari segi bandwidth
teoritis maksimum yang ditawar-
kan sebenarnya Parallel ATA ini
masih sanggup menangani hard-
disk IDE yang digunakan saat ini.
Harddisk IDE tercepat yang ter-
sedia di pasaran saat ini jelas
masih memiliki kecepatan trans-
fer yang lebih lambat dari 70MB/s.
Harddisk yang menggunakan
interface Serial ATA sendiri belum
banyak tersedia di pasaran,
namun tidak beberapa lama lagi
(setahun atau lebih), kemung-
kinan besar Serial ATA ini akan
mulai digunakan. Di samping me-
miliki bandwidth yang lebih baik,
teknologi serial yang digunakan
jelas mengurangi banyaknya
konektor yang diperlukan.

USB
Bila PCI, AGP dan ATA bisa

dikatakan sebagai interface
internal, maka USB (Universal

Serial Bus) merupakan interface
eksternal yang telah menjadi
standar pada PC masa kini. USB
ini ditujukan untuk mengganti
berbagai interface eksternal yang
tersedia sebelumnya. USB ini
menggunakan teknologi serial
sehingga tidak memerlukan
konektor dalam jumlah yang
banyak.

Saat ini sebagian besar
peralatan eksternal telah
menyediakan USB ini sebagai
interface-nya, paling tidak salah
satu interface-nya. Pada awalnya

USB ini hanya memiliki band-
width sebesar 12Mb/s ataupun
1,5MB/s. Bandwidth sebesar ini
sering kali tidak memadai bila
digunakan untuk menghubung-
kan peralatan yang memiliki ke-
cepatan tinggi pada sistem. Salah

satu contohnya adalah harddisk
eskternal yang memiliki
kecepatan transfer tinggi.

Setelah bertahan berapa
lama dengan bandwidth
sebesar 1,5MB/s tersebut,
akhirnya pada USB 2.0, USB ini
memiliki bandwidth yang jauh
lebih besar dan dirasa sudah
cukup memadai untuk saat ini.
Adapun bandwidth yang
dimiliki adalah sebesar 480Mb/s
atau 60MB/s. Untuk masalah
daya, peralatan eksternal yang
hanya membutuhkan sedikit

daya bisa mengambil daya
tersebut langsung dari USB port
pada sistem. Bila daya yang
diperlukan adalah besar,
peralatan tersebut haruslah
memiliki catu dayanya
tersendiri. PC+

PATA adalah interface yang umum
digunakan untuk harddisk
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Siemens S57 Jaringan GSM 900/1800/1900
Rp. 2.150.000 Layar Warna 256 warna

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Camera (separated)
Dimensi/Berat 101 x 46 x

19mm / 85gr
Bicara/Stand-by 6 jam / 300 jam

Sony Jaringan GSM 900/1800
Ericsson T310 Layar Warna 4096 warna
Rp. 1.575.000 SMS/EMS/MMS SMS/EMS/MMS

Polyphonic Ya
GPRS/WAP/HSCSD WAP 1.2.1
Plus Camera (separated)
Dimensi/Berat 99 x 43 x

17.7mm / 75gr
Bicara/Stand-by 1.5 jam - 5 jam /

60 jam - 180 jam

Sony Jaringan GSM 900/1800/1900
Ericsson T610 Layar Warna 65.000 warna
Rp. 3.550.000 SMS/EMS/MMS SMS/EMS/

MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 2.0/

HSCSD
Plus Camera (separated)
Dimensi/Berat 102 x 44 x

19 mm  / 95gr
Bicara/Stand-by 14 jam / 400 jam

Motorola Jaringan GSM 900/1800
E360 Layar Warna 4096 warna
Rp. 1.065.000 SMS/EMS/MMS SMS/EMS/MMS

Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus -
Dimensi/Berat 114 x 40 x

20 mm / 80gr
Bicara/Stand-by 2.5 jam / 165 jam

Motorola Jaringan GSM 900/1800
T720 Layar Warna 4096 warna
Rp. 1.940.000 SMS/EMS/MMS SMS/EMS

Polyphonic -
GPRS/WAP/HSCSD GPRS/WAP
Plus
Dimensi/Berat 36 x 19 x

10 mm / 100gr
Bicara/Stand-by 3 jam / 165 jam

Nokia 6800 Jaringan GSM 900/1800
Rp. 3.390.000 Layar Warna 4096 warna

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus Keyboard flip
Dimensi/Berat 119 x 55 x

23mm / 122gr
Bicara/Stand-by 3 jam - 7 jam /

7 hari - 15 hari

Nokia 7210 Jaringan GSM 900/1800/1900
Rp. 2.850.000 Layar Warna 4096 warna

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus -
Dimensi/Berat 106 x 45 x

17.5mm / 83gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 7250 Jaringan GSM 900/1800/1900
Rp. 3.350.000 Layar Warna 4096 warna

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD WAP 1.0
Plus Built in camera
Dimensi/Berat 105 x 44 x

19mm / 92gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 7650 Jaringan GSM 900/1800
Rp. 3.375.000 Layar Warna 4096 warna

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Built in camera
Dimensi/Berat 114 x 56 x

26mm / 154gr
Bicara/Stand-by 4 jam / 150 jam

Siemens M55Jaringan GSM 900/1800/1900
Rp. 1.800.000 Layar Warna 4096 warna

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Camera (separated)
Dimensi/Berat 101 x 46 x

21mm / 83gr
Bicara/Stand-by 6 jam / 250 jam

Nokia 3650 Jaringan GSM 900/1800/
Rp. 3.125.000 1900

Layar Warna 4096 warna
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Midi/Wav Ringtone
GPRS/WAP/HSCSD GPRS/HSCSD
Plus Built in camera
Dimensi/Berat 130 x 57 x

26mm / 130gr
Bicara/Stand-by 3 jam - 4 jam /

150 jam - 200 jam

Nokia 5100 Jaringan GSM 900/1800/
Rp. 2.600.000 1900

Layar Warna 4096 warna
SMS/EMS/MMS SMS/EMS/

MMS
Polyphonic Ya
GPRS/WAP/HSCSD -
Plus Rubber cover
Dimensi/Berat 108.5 x 49.5 x

22mm / 104gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 6100 Jaringan GSM 900/1800/
Rp. 2.400.000 1900

Layar Warna 4096 warna
SMS/EMS/MMS SMS/EMS/

MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus -
Dimensi/Berat 105.5 x 47.5 x

22.5mm / 92gr
Bicara/Stand-by 2 jam 20 menit -

3 jam  50 menit /
60 jam - 170 jam

Nokia 6610 Jaringan GSM 900/1800/
Rp. 2.050.000 1900

Layar Warna 4096 warna
SMS/EMS/MMS SMS/EMS/

MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP

1.2.1/HSCSD
Plus -
Dimensi/Berat 106 x 45 x

17.5mm / 84gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Harga Ponsel CDMA

Sanex Jaringan 800/1900MHz
SC-9889 CDMA 2000 1X
Rp. 1.589.000 Digital

Layar Warna -
SMS/EMS/MMS SMS
Polyphonic Ya
GPRS/WAP/HSCSD -
Plus -
Dimensi/Berat -
Bicara/Stand-by -

Nokia 3585 Jaringan 800MHz CDMA /
Rp. 1.700.000 800MHz AMPS

Layar Warna -
SMS/EMS/MMS SMS
Polyphonic -
GPRS/WAP/HSCSD -
Plus -
Dimensi/Berat 119 x 49.7 x

23.3mm / 116gr
Bicara/Stand-by 3.75 jam /

9 hari

Nokia 3586 Jaringan CDMA 2000 1x
Rp. 1.900.000 Layar Warna 4096 warna

SMS/EMS/MMS SMS
Polyphonic MIDI ringtone
GPRS/WAP/HSCSD -
Plus -
Dimensi/Berat 117 x 49 x

24mm / 116.6gr
Bicara/Stand-by 3 jam / 7 hari

Ponsel-ponsel Layar Warna

Nokia 3530 Jaringan GSM 900/1800
Rp. 1.080.000 Layar Warna 4096 warna

SMS/EMS/MMS SMS/EMS/
MMS

Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus -
Dimensi/Berat 118 x 49.6 x

17.1mm / 108gr
Bicara/Stand-by 2 jam 30 menit -

4 jam 30 menit /
13 hari
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Siemens M55:
Sangar dan Garang

Jarang-jarang ada
ponsel yang

diasosiasikan dengan
ikon yang agak-agak
menakutkan seperti

Siemens M55. Simbol
yang dipilih untuk

mencitrai peranti ini
adalah scorpion alias

kalajengking. Ya,
berkesan jantan,

sangar, dan garang!
Tak heran jika tagline-

nya adalah: Fearless.

khir-akhir ini
Siemens memang lagi
rajin ngurusin desain
ponsel yang dikeluarin.

Setelah SL55 yang elegan dan
berkesan feminin, M55 ini
seakan hadir untuk
mengimbangi dengan desain
yang maskulin.

Tongkrongan Siemens M55
yang merupakan suksesor dari
M50 ini memang sudah langsung
berbicara. Warna-warna casing,
keypad, dan instrumen yang
dipilih bernuansa kelam dan
sangar. Tombol-tombol berbuku-
buku bersudut runcing
mengesankan bagian-bagian
tubuh kalajengking yang juga
sekaligus dapat diasosiasikan
dengan raga pria yang rajin ke
gym dan minum L-Men. “Parit-
parit” di antara keypad laksana
kaki-kaki yang menjulur, begitu
pula diulang dengan aksen
serupa di casing bagian
belakang.

Fitur yang paling menarik
dari ponsel ini adalah Cubasis
Mobile Synthesizer. Fitur ini
digunakan untuk membuat
ringtone yang polifonik. Dengan
composer ini pengguna bisa
memasukkan berbagai macam
instrumen musik sendiri dan
menyusunnya menjadi sebuah
komposisi musik yang utuh
untuk dipasang sebagai
ringtone. Jadi, selain mendapat
ringtone yang bagus, dengan
M55 kita juga bisa belajar
komposisi musik secara
sederhana.

Nada dering polifonik yang
disuguhkan oleh ponsel triband
yang bisa dioperasikan pada
GSM 900/1800/1900MHz memiliki
kapasitas 16 kanal.

Layar ponsel berdimensi
101 x 46 x 21mm ini bisa
menyuguhkan 4096 warna.
Cukup lebar karena
menampilkan 7 baris dengan
101x80 pixel. Sisi tampilan ini
sangat penting untuk
mendukung beberapa fitur
lainnya seperti kamera dan
MMS (Multimedia Messaging
Service).

M55 bisa ditancapi dengan

kamera Quick Pic IQP500 yang
dijual secara terpisah. Hasilnya
bisa disimpan atau dikirim dalam
bentuk MMS karena ponsel
seberat 83 gram ini juga support
MMS.

Kemampuan komunikasi
data ini ditopang oleh kapabilitas
GPRS kelas 8 yang dimilikinya.
Sayangnya, tidak ada metode
koneksi ke peranti atau jaringan
lain seperti inframerah dan

A

A
RE

/P
C

pl
us

bluetooth. “Lampu merah” sih
ada, ditempatkan di sisi kanan
body ponsel, digunakan sebagai
aksesoris yang mempertegas
kesan sangar.

Daya yang dicatu oleh
baterai Li-Ion 700 mAh mampu
bertahan selama 250 jam stand-
by. Jika digunakan untuk bicara
daya tahannya sampai 300 menit.
Sedang waktu untuk men-charge
adalah kurang dari 2 jam. PC+
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Alex Pangestu
alex@e-pcplus.com Informasi Virus Baru dari Situs

T

tersimpan di dalam sistem. Infor-
masi seperti pemencetan keyboard,
password, nomor rekening dan se-
bagainya bisa dicuri oleh virus je-
nis ini. Sama saja bahayanya, kan?

Adanya berbagai jenis virus
serta penyebarannya yang serba
cepat memerlukan suatu sistem
untuk mengawasi kemunculan
dan tingkat bahayanya. Beberapa
situs dibangun untuk mengawasi
virus-virus yang muncul. Tidak
hanya mengawasi, beberapa situs
memberikan ranking virus mana
yang paling berbahaya atau virus
mana yang paling cepat
penyebarannya.

Berikut ini PCplus
menjabarkan beberapa situs yang
berhubungan dengan virus. Situs-
situs tersebut antara lain
www.messagelabs.com,
www.viruslist.com dan
www.sophos.com.

MessageLabs
www.messagelabs.com

Situs ini adalah milik
MessageLabs, sebuah perusahaan
yang menyediakan layanan

keamanan e-mail untuk per-
usahaan-perusahaan. Message-
Labs menyaring semua e-mail

dari dan ke perusahaan yang
menjadi kliennya. Dengan demi-
kian, virus, spam atau e-mail lain
yang patut dicurigai sebagai
pengganggu, tidak akan sampai
ke tujuan.

www.messagelabs.com
secara khusus menampilkan virus-
virus yang menyebar melalui e-
mail. Hal ini tentu saja lumrah,
karena MessageLabs adalah
perusahaan yang menyediakan
keamanan e-mail. Pada situs ini
virus-virus diurutkan berdasarkan
berapa banyak e-mail yang berisi
suatu virus dihentikan. Semakin
banyak e-mail yang mengandung
suatu virus dihentikan, semakin
naik tingkatannya, yang berarti
pula bahwa virus tersebut sangat
agresif dalam menyebar.

Informasi mengenai virus
pada situs ini lumayan lengkap
dan disusun menjadi grafis
sehingga mengenakan
pengunjung dalam mengetahui
informasi. Informasi tersebut
berupa kapan e-mail yang
mengandung tersebut pertama
kali dihentikan oleh Message-

Labs, kapan terakhir kali
dihentikan, di negara
mana pertama kali di-
hentikan, jumlah e-mail
yang dihentikan karena
virus tersebut, kapan vi-
rus tersebut menyebar
paling banyak, kapan
puncaknya penyebaran
virus dan berapa rasio e-
mail yang didomplengi
oleh virus tersebut.

Informasi yang ba-
nyak itu masih ditambah

dengan informasi mengenai
tingkat bahaya virus. Ada tiga
buah penilaian, yaitu low,

medium, dan high. Penilaian ini
ditentukan berdasarkan tingkat
“agresivitas” dan kerusakan
yang di-
akibatkan
olehnya.

Selain
menyediakan
informasi
virus yang
menyebar
melalui e-
mail,
www.mess
agelabs.com
menyediakan informasi me-
ngenai e-mail spam serta e-mail
yang mengandung unsur porno-
grafi, walaupun informasinya
tidak selengkap virus, hanya
menampilkan grafik kapan
serangan paling banyak dan
bagaimana rasionya.

Virus List
www.viruslist.com

www.viruslist.com
merupakan situs Kaspersky Virus
Encyclopedia yang tidak hanya
menampilkan informasi
mengenai virus-virus, namun
juga menyediakan berita sepu-
tar perkembangan virus. Situs
ini merupakan “anak situs” dari
Kaspersky(www.kapersky.com),
sebuah perusahaan software
untuk memerangi virus, hacker
dan spam. Yang menarik dari
www.viruslist.com adalah
adanya Virus Calendar yang
menyediakan data virus apa
yang hari ini sedang “hot-hot”-
nya. Selain virus yang sedang
hot hari ini, para pengun-jung
bisa juga
melihat arsip
virus apa yang
hot di masa
lalu.
www.viruslist.
com tidak
menyediakan
informasi
mengenai
kapan virus
pertama kali
terdeteksi dan
sebagainya,
namun situs
ini menyajikan contoh isi e-mail
(body dari suatu e-mail) yang
mengandung virus tertentu.
Situs ini juga menyediakan
bagaimana virus menyerang
sistem dan bagaimana
akibatnya.

Pada bagian Encylopedia,
kita bisa melihat daftar
berbagai virus. Satu lagi yang
PCplus suka dari situs ini adalah,
jika suatu virus ditampilkan,
pada bagian Related Topic dan
Glossary ditampilkan hal-hal
yang berhubungan dengan
virus tersebut. Dengan demi-
kian, informasi lengkap menge-
nai virus dan berbagai informasi
yang berkenaan dengan virus
tersebut bisa dengan cepat dan
akurat diketahui.

Ada bagian yang menyedia-
kan virus-virus apa yang pada
beberapa bulan terakhir ini agre-
sif menyerang para pengguna

PC. Bagian tersebut bernama
Best Hits. 20 virus yang paling
banyak menyusahkan pengguna

PC ditampilkan di sini, berikut
pula berapa banyak virus yang
dimaksud menyerang.

Sophos
www.sophos.com

Sophos adalah sebuah
perusahaan software antivirus
yang pangsa pasarnya adalah
korporat. Pada situsnya,
www.sophos.com,
perusahaan yang tersebar di
berbagai negara ini
menyediakan berbagai
informasi seputar virus. Pada
halaman awalnya, mereka
menyediakan beberapa virus
baru yang muncul.

Situs Sophos menyediakan
Virus Analyses yang berguna
berisi penjelasan mengenai
berbagai virus yang pernah
tertangkap oleh software
antivirus keluaran Sophos.
Informasi virus ditampilkan
setelah pengunjung mengklik
nama virus. Informasi yang
ditampilkan adalah tipe virus,
kapan pertama kali virus

tertangkap oleh Sophos dan
penjelasan singkat mengenai
apa yang diserang oleh virus
serta bagaimana virus menye-
rang. Yang menarik, pada
beberapa virus disertakan pula
bagaimana untuk mengurangi
akibat serangan virus.

Selain virus, situs Sophos
juga menyediakan informasi
mengenai berbagai gangguan
yang disalurkan melalui e-mail
alias spam. Contohnya adalah
surat berantai, alarm palsu, dan
lain-lain.

Di dalam situs Sophos juga
diisi dengan pelajaran me-
ngenai virus. Pelajaran dimulai
dari pengenalan apa itu virus,
termasuk sejarah virus, dilanjut-
kan dengan petunjuk-petunjuk
bagaimana mengamankan
sistem dari serangan virus,
istilah-istilah dan petunjuk
pengamanan pada sekolah. PC+

www.messagelabs.com

www.viruslist.com

www.sophos.com

Trend virus sudah
beberapa kali

berubah. Jika dulu
penyebaran virus-virus

melalui pertukaran
file dengan

menggunakan disket,
sekarang virus

menyebar melalui
Internet, khususnya e-

mail.

entu saja
dengan menunggangi
Internet, kecepatan
penyebaran virus men-

jadi sangat cepat. Contohlah
virus BugBear.B pada bulan Juni
lalu. Hanya dalam hitungan
jam, pada tanggal 14-15 Juni
ribuan PC di seluruh dunia
terserang virus ini. “Virus
datang lebih cepat daripada
antivirus,” begitu kata Alfons
Tanujaya dari Vaksin.com

Virus-virus yang
mendompleng e-mail biasanya
memiliki subject yang menarik
untuk ditengok lebih lanjut.
Contohnya e-mail yang
memberikan attachment Anna
Kournikova.jpg.
Siapa yang tidak ter-
tarik untuk melihat
kecantikan petenis
asal Rusia tersebut?
Setelah attachment
dibuka, gambar yang
diharapkan tak
kunjung muncul,
yang terjadi malah
sistem terserang virus
Annakournikova.

Ada lagi jenis
virus yang tidak me-
rusak sistem namun tetap saja
sangat berbahaya, karena virus
jenis ini mencuri informasi yang
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Y.J Thurana
thurana@e-pcplus.com

S

Dasar - Dasar
Ber-Google

Dua tahun lalu, orang
akan berkata bahwa

mereka yang
mencoba menyaingi

Yahoo! sebagai search
engine terbaik adalah

orang bodoh. Tidak
ada yang tahu bahwa
dua tahun kemudian
bahkan Yahoo! pun

menggunakan
metode pencarian

yang dikembangkan
oleh Google

(www.google.com),
search engine terbaik
dan terpopuler yang

ada saat ini.

aking
populernya
Google, sampai-
sampai muncul istilah

baru dalam bahasa Inggris yaitu
googling. Diterjemahkan secara
bebas ke bahasa Indonesia
menjadi ber-Google, yang
artinya mencari informasi di
Internet dengan menggunakan
Google.

Dan memang boleh
dibilang bahwa informasi
macam apapun bisa Anda
temukan di dunia maya, asalkan
Anda tahu bagaimana
mencarinya. Saya tekankan kata
bagaimana, bukan di mana,
karena memang pencarian
informasi di Internet lebih
mengenai cara pencariannya.

Dasar-dasar
Ber-Google

Kalau mau jujur, saat ini
masih banyak pengguna
Internet yang belum
mengetahui prinsip dasar
pencarian informasi di Internet.
Sangat sulit mencari informasi
jika hasil yang didapatkan
amat-sangat-terlalu banyak
bukan? Mari kita lihat beberapa
trik yang akan mengefektifkan
pengalaman ber-Google Anda.

Aturan paling dasar dari
pencarian adalah mengetikkan
kata kunci pencarian (search
string) dari informasi yang Anda
inginkan.

Misalnya Anda ingin
mencari informasi mengenai
memori untuk komputer,
mengetikkan kata memory
tidak akan memberikan hasil

yang terbaik. Mungkin informasi
yang Anda inginkan ada di
antara sekian ratus ribu hasil
pencarian yang diperoleh… Kita
harus lebih spesifik dengan
menambahkan kata kunci lain,
seperti mereknya. Penambahan
tanda kutip pada kata kunci
pencarian akan memastikan
bahwa pencarian dibatasi hanya
pada frasa yang sama persis
dengan yang Anda cari.

Misalnya pencarian dengan
kata kunci Kingston
Technology akan menghasilkan
in Kingston they love
Technology, sedangkan
“Kingston Technology”
dengan tanda kutip itu akan
menghasilkan Kingston
Technology the leader in
computer memory.

Bagaimana jika Anda tidak
tahu merek memori yang dicari,
tetapi tahu persis bahwa merek-
nya bukan Kingston Technology?
Gunakan tanda minus (-) sebe-
lum kata yang tidak diinginkan.
Jadi pencarian dengan kata kunci
computer memory –“Kingston
Technology” akan menghasilkan
semua informasi mengenai me-
mori komputer yang tidak ada
kata Kingston Technology di da-
lamnya. Gunakan sebanyak-ba-
nyaknya tanda minus didepan ka-
ta-kata yang tidak Anda inginkan
untuk mempersempit pencarian.

Aturan Tambahan
Mohon diperhatikan bahwa

urutan kata akan mempenga-
ruhi hasil pencarian. Pencarian
kutu loncat akan memberikan
hasil yang berbeda dengan lon-
cat kutu. Sedangkan huruf besar
atau kecil tidak akan diperhati-
kan. Pencarian Goyang Dom-
bret akan memberikan hasil yang
sama dengan goyang dombret.

Kata-kata umum seperti the
dan and akan diabaikan dalam
pencarian. Begitu pula dengan
kata satu karakter seperti a atau
angka. Untuk mengikutsertakan
angka dalam pencarian gunakan

tanda plus (+). Jadi jika saya
mencari informasi mengenai
sinetron Tersanjung 9, misalnya,
saya akan menggunakan kata
kunci sinetron Tersanjung +9.

Perintah lain yang bisa di-
gunakan pada Google adalah OR
(atau). Penulisannya harus dalam
huruf besar, karena jika tidak akan
dianggap sebagai kata umum dan
diabaikan. Jadi jika saya mencari
informasi mengenai hotel Hilton
yang ada baik di Bandung
maupun Jakarta kata kunci yang
bisa digunakan adalah hotel
Hilton Bandung OR Jakarta.

Sebagai pencuci mulut dari
hidangan hari ini, ada trik kecil
yang bisa digunakan jika Anda
ingin mencari suatu informasi
khusus pada suatu situs tertentu.
Memang biasanya ada fasilitas
pencarian pada setiap situs di In-
ternet, tetapi jika tidak ada atau

jika hasilnya kurang memuaskan,
gunakan saja Google. Masuk ke
Google, tulis kata kunci diikuti
oleh kata site dan titik dua lalu
alamat situs yang dimaksudkan.
Misalnya saya ingin mencari
informasi mengenai Sukhoi dari

situs Detik.com, maka saya bisa
mencari di Google mengguna-
kan kata kunci sukhoi
site:www.detik.com. Semoga
trik kecil ini bisa membantu
pencarian informasi Anda.
Selamat ber-Google-ria!  PC+

menyuguhkan deretan panjang hasil
pencarian terlebih dahulu. Dengan kata
lain, Anda pasrah menyerahkan apapun
hasilnya kepada Google. Atau malah bisa
juga Anda sudah sangat yakin 99 persen
bahwa halaman yang akan dihasilkan
sudah sesuai dengan apa yang Anda
masukkan sebagai kata kunci pencarian
dan akan di-list pada urutan pertama.
Jadi, misalkan Anda mencari dengan kata
kunci tabloid pcplus, dan mengklik [I’m
Feeling Lucky], maka Anda akan segera
dibawa ke situs unofficial Tabloid PCplus
ini (tepatnya halaman Daftar Agen), ka-
rena memang dia akan tampil pada uru-
tan pertama dalam hasil pencarian. (fbi)

Arti Tombol [I’m
Feeling Lucky]

Tampilan Google terkenal sederhana.
Lihatlah, hanya ada sebuah kolom untuk
memasukkan pencarian, ditambah dengan
dua tombol saja di bawahnya. Yang
pertama, [Google Search], digunakan
untuk menyuruh si Google untuk segera
melakukan tugasnya.

Lalu, apa guna tombol yang
kedua, [I’m Feeling Lucky]?
Tombol [I’m Feeling Lucky] tersebut
membawa Anda langsung ke halaman
Web dari urutan pertama yang hasil
pencariannya. Otomatis. Tanpa
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Siapa Saja
yang Sedang Terhubung

ke Komputer Anda?

Mengubah
Fasilitas

Undo History
pada Excel 2000

Menonaktifkan
Fitur File

and Print Sharing

Andaikan, suatu ketika
Anda menjalankan sebuah
aplikasi yang berjalan di DOS
bersamaan dengan aplikasi
multimedia untuk mendengar-
kan musik. Kemudian Anda
menjalankan aplikasi lain untuk
membersihkan harddisk dari file
temporary dan beberapa apli-
kasi lain pada komputer dengan
memori berkapasitas kecil. Ma-
ka kondisi yang akan Anda da-
patkan adalah suara musik yang
terputus-putus dan aplikasi lain
tetap berjalan lambat. Ini ter-
jadi karena setiap program be-
kerja dalam prioritas yang sama.

Solusi untuk masalah ini
adalah dengan mengatur prio-
ritas setiap program yang se-
dang bekerja. Bagaimana
caranya? Ikuti langkah-langkah
berikut:
1. Klik kanan mouse pada

taskbar, kemudian pilih [Task
Manager] atau tekan
[Ctrl+Alt+Del] pada
keyboard.

2. Pada tab [Application], pilih
aplikasi yang ingin Anda
ubah prioritasnya, kemudian
klik kanan mouse dan pilih
[Go to process].

3. Task Manager akan
memindah tab ke [Processes]
dan file program Anda yang
sedang dieksekusi akan

disorot.
4. Klik kanan pada bagian

tersebut.
5. Kemudian sorot [Set Priority].

Di sana akan muncul pilihan
[Realtime], [AboveNormal],
[Normal], [BelowNormal], dan
[Low]. Anda dapat
mengaturnya sesuai dengan
keinginan Anda. Aplikasi yang
membutuhkan prioritas tinggi
seperti program multimedia
dapat diubah ke
[AboveNormal] dan yang
tidak membutuhkan prioritas

yang besar dapat diubah ke
[BelowNormal].
Untuk mendapatkan hasil

yang maksimal, Anda harus me-
ngatur prioritas sebijak mung-
kin agar program yang prioritas-
nya lebih rendah tetap dapat
bekerja dengan baik.Oleh ka-
rena itu Anda dapat mengatur
ulang prioritas dengan langkah-
langkah diatas jika dirasakan
program-program tidak lagi
nyaman untuk dijalankan.

Steven Andy Pascal
steven@e-pcplus.com

Saat Anda men-sharing
suatu file penting dijaringan,
mungkin Anda pernah merasa
was-was. Takut file penting
Anda diintip orang, di-copy,
atau diakses oleh orang yang
tidak berhak. Apalagi jika file
tersebut tidak di protect de-
ngan password. Jika Anda dapat
memonitor dan melihat siapa
saja yang terhubung ke kompu-
ter Anda dan sedang membuka
file apa saja, tentu kekhawa-
tiran Anda akan berkurang.

Tapi bagaimana cara me-
ngetahui komputer mana saja
yang terhubung dengan PC An-
da dan file apa saja yang se-
dang diakses olehnya? Windows
XP Professional menyediakan
solusinya. Anda dapat menge-
tahui informasi tersebut dan
memutuskan koneksinya jika
salah seorang rekan Anda se-
dang mengintip file Anda, me-
lalui Computer Management
yang berada di Administrative
Tools. Lengkapnya, dapat Anda
simak pada langkah-langkah
berikut:
1. Klik [Start]>[Control

Panel]>[Performance and

Maintenance]>
[Administrative Tools].

2. Klik dua kali [Computer
Management].

3. Begitu window Computer
Management terbuka,
masuklah ke Computer
Management(local)\
System Tools\Open Files\.

4. Pada bagian kanan window
akan nampak nama file yang
sedang dibuka, nama
pengaksesnya, beserta
beberapa informasi lain

5. Jika Anda menemukan sese-
orang yang sedang meng-

akses file yang bukan hak-
nya, klik kanan mouse pada
nama file tersebut, lalu pilih
[Disconnect].
Untuk memutuskan seluruh

koneksi, Anda tidak perlu mela-
kukannya satu per satu. Cukup
klik kanan mouse pada bagian
kosong di window tersebut,
kemudian pilih [Disconnect All
Open Files] pada menu yang
muncul atau langsung klik
[Action]>[Disconnect All Open
Files] melalui menu bar.

Steven Andy Pascal
steven@e-pcplus.com

Bagi Anda yang komputernya terhubung ke jaringan atau LAN
dan ingin mencegah dimanfaatkannya fitur Sharing dan Print
Sharing, maka yang diperlukan adalah memproteksinya lewat
registry. Untuk itu ikutilah langkah-langkah berikut ini:
1. Jalankan Registry Editor.
2. Masuk ke key HKEY_CURRENT_USER\Software\Microsoft\

Windows\CurrentVersion\Policies\Network.
3. Buat DWORD Value dengan nama NoFileSharing, dan isikan

Value Data-nya menjadi 1.
4. Buat DWORD Value lagi kali ini dengan nama NoPrintSharing,

dan isikan Value Data-nya menjadi 1.
5. Tutup Registry Editor Anda. Selamat mencoba.

Fadlan Setiaji
aji-edl@plasa.com

Dalam Microsoft Excel 2000, kita diberi fasilitas Undo.
Default-nya hanya sebanyak 16 kali.

Dengan menggunakan Regedit, kita bisa menambahnya
sebanyak yang kita inginkan dengan cara sebagai berikut:
1. Klik Start>Run, ketikan Regedit.
2. Masuk ke key HKEY_CURRENT_USER\Software\

Microsoft\Office\9.0\Excel\Options.
3. Tambahkan  DWORD value baru dengan cara

Edit>New>DWORD, kemudian beri nama UndoHistory.
4. Kemudian masukan nilainya terserah Anda misalkan 25, itu

berarti jumlah Undo yang akan tersedia.
5. Kemudian restart atau log off untuk merasakan perubahannya.

Yopi Purnama Cipta
Yopi_kasep@hotmail.com

Windows XP:
Mengatur Tingkat

Prioritas Suatu Aplikasi
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Jika Anda ingin punya menu [Start Windows] yang simpel, mengurangi
beberapa menu yang jarang Anda perlukan seperti [Help] dan [Favorites] adalah salah
satu solusinya. Terkadang jika kita akan menghilangkan beberapa menu pada Start
Windows kita menggunakan software pihak ketiga, sekarang tidak perlu lagi.  Yang
perlu dilakukan adalah mengedit registry Windows.
1. Klik [Start]>[Run], ketikkan regedit.
2. Masuk pada key HKEY_CURRENT_USER\Software\Microsoft\Windows\

CurrentVersion\ Policies \Explorer.
3. Klik kanan pada jendela sebelah kanan [New]>[DWORD Value].
4. Beri nama sesuai dengan tabel dibawah ini (perhatikan besar kecilnya huruf) dan

sesuai dengan menu yang ingin Anda akan hilangkan.
5. Klik dua kali pada value tersebut isikan Value Data-nya dengan angka 1 untuk

mengaktifkan dan 0 untuk mematikan.

Ada cara alternatif agar Anda tidak perlu terlalu repot dengan menuliskan nama
dan data value, ikuti langkah langkah berikut.

1. Buka Notepad, melalui [Start]>[Programs]>[Accessories]>[Notepad]
Ketikkan
  REGEDIT4

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies]
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer]
"NoSMHelp"=dword:00000000
"NoRecentDocsMenu"=dword:00000000
"NoFavoritesMenu"=dword:00000000
"NoLogOff"=dword:00000000
"NoRecentDocsHistory"=dword:00000000
"ClearRecentDocsOnExit"=dword:00000000
"NoWindowsUpdate"=dword:00000000
"NoPrinterTabs"=dword:00000000
"NoClose"=dword:00000000
"NoFind"=dword:00000000
"NoRun"=dword:00000000
"NoSetFolders"=dword:00000000
"NoSetTaskbar"=dword:00000000
"NoFolderOptions"=dword:00000000
"NoChangeStartMenu"=dword:00000000
"NoControlPanel"=dword:00000000
"NoSMMyDocs"=dword:00000000
"NoSMMyPictures"=dword:00000000
"NoNetHood"=dword:00000000

2. Ubah angka 00000000 menjadi 00000001
untuk mengaktifkan. Anda tidak perlu
menuliskan semua cukup menu yang Anda
pilih saja yang diketik.

3. Save dengan nama file dengan berexstensi
*.Reg. klik [OK].

4. Klik dua kali file tersebut lalu [OK] dan [OK] kembali.
5. Restart komputer Anda.

Bambang Eko wwa
ibeng_wwa@plasa.com

Memunculkan Nama Anda pada
Title Bar Windows Media Player

Jika Anda biasanya melihat tulisan “Windows Media Player” pada
Title Bar Windows Media Player (standar dari Windows), Anda mungkin bosan
melihatnya. Jika Anda ingin mengganti tulisan tersebut menjadi nama Anda, bisa saja
untuk itu lakukanlah langkah-langkah berikut ini :
1. Jalankan Registry Editor Anda.
2. Masuk ke key

HKEY_CURRENT_USER\Software\Policies\Microsoft\WindowsMediaPlayer.
3. Buat String Value baru dengan cara klik kanan pada panel sebelah kanan, dan

pilih [New]>[String Value].
4. Berikan nama String Value

tersebut dengan nama Titlebar.
5. Klik ganda String Value tersebut

dan isikan Value Data-nya
dengan nama Anda.

6. Tutup Registry Editor Anda.

Sekarang jalankan Windows
Media Player Anda, lihatlah Title
Bar-nya dan nama Anda akan
muncul pada Title Bar tersebut,
bukan tulisan “Windows Media
Player”. Untuk mengembalikan Title Bar tersebut menjadi tulisan semula, cukup
hapus String Value yang baru kita buat tersebut. Selamat mencoba.

Fadlan Setiaji
aji-edl@plasa.com

Menghilangkan Ikon-ikon pada
Control Panel

Mungkin bagi sebagian dari kita yang jarang sekali menggunakan
sebagian ikon yang terdapat pada Control Panel seperti Modems, ODBC Data
Source, Telephony, dan lain sebagainya. Ikon-ikon tersebut rasanya tidak ada gunanya.
Atau bagi Anda yang tidak ingin setting di dalam Control Panel seperti setting Key-
board, Mouse, atau bahkan Display Desktop diubah-ubah oleh tangan-tangan jahil.
Sebenarnya ikon-ikon tersebut berhubungan dengan file berekstensi CPL (*.CPL) yang
berada di folder Windows\System Anda dan untuk menghilangkan ikon-ikon tersebut
sederhana saja. Sebagai contoh kita akan menghilangkan ikon Modem, untuk itu
lakukan langkah-langkah berikut ini:
1. Buka Windows Explorer Anda, dan masuk folder Windows\System.
2. Cari file Modem.cpl.
3. Setelah ketemu pindahkan file tersebut dari folder Windows\System ke mana saja.
4. Buka kembali Control Panel Anda dan ikon Modem Anda akan hilang.

Namun ada cara lain agar ikon-ikon
tersebut hilang tanpa memindahkan file
berekstensi CPL tersebut dari folder
Windows\System. Untuk itu Anda dapat
mencari file Control.ini yang berada di
folder Windows. Setelah ketemu klik dua
kali file tersebut dan cari kata don’t load dan
tambahkan dibawahnya nama file CPL tadi
yang ikonnya mau dihilangkan diikuti atribut
negatif. Apabila kita ingin menghilangkan
ikon Modem berarti tambahkan
modem.cpl=no. Bila Anda tidak yakin file CPL mana yang berasosiasi dengan ikon yang
akan kita hilangkan, klik dua kali file CPL tersebut pada Windows Explorer.

Setelah Anda mengetahui bagaimana cara menghilangkan ikon-ikon pada Control
Panel, Anda dapat membuat shortcut dari ikon-ikon tersebut dan langsung menuju tab
yang Anda kehendaki. Misalkan jika Anda klik ganda ikon Display pada Control Panel
atau  klik kanan Desktop Anda dan pilih Properties maka akan terbuka jendela
Display Properties, dan langsung membuka tab Background. Bagaimana jika Anda
ingin membuat shortcut agar tab yang terbuka adalah tab Screen Saver, bukannya tab
Background. Caranya adalah klik kanan Desktop Anda, dan pilih [New]>[Shortcut].
Pada bagian Location, isikan "CONTROL DESK.CPL,,1". Kemudian klik Next dan pada
bagian nama shortcut-nya Anda bisa isikan Screen Saver atau yang lainnya sesuai
selera Anda. Seperti yang Anda ketahui berdasar keterangan sebelumnya Desk.cpl
adalah file pada folder Windows\System yang berasosiasi dengan ikon Display pada
Control Panel, sedangkan angka 1 dibelakang dua buah koma menunjukkan nomer
dari tab yang akan terbuka.

Jadi bila Anda ingin tab yang terbuka adalah Background berarti angkanya adalah
0 atau jika ingin tab yang terbuka adalah Appearance maka angkanya adalah 2 dan
seterusnya sesuai dengan urutan posisi tab dari kiri ke kanan. Hal ini dapat diterapkan
juga pada ikon-ikon lain pada Control Panel, seperti Multimedia, Mouse, dan lain
sebagainya. Selamat mencoba.

Fadlan Setiaji
aji-edl@plasa.com

Menciutkan Start Menu
pada Windows 9x/Me

Start menu

Shutdown
Log Off
Run
Help
Search/find
Documents
Favorites
My picture
My documents
Control Panel
Printer
Network Neighborhood
Taskbar & start menu
Setting Folder Options
Windows Update
Mematikan fungsi recent docs
Menghindari penggantian start
menu
Menghilangkan file menu
Membersihkan recent doc saat
keluar dari windows

value

NoClose
NoLogOff
NoRun
NoSMHelp
NoFind
NoRecentDocsMenu
NoFavoritesMenu
NoSMMyPictures
NoSMMyDocs
NoControlPanel
NoPrinterTabs
NoNetHood
NoSetTaskbar
NoFolderOptions
NoWindowsUpdate
NoRecentDocsHistory
NoChangeStartMenu

NoFileMenu
ClearRecentDocsOnExit
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    Aplikasi-aplikasi
Manipulasi Foto Digital

Alex Pangestu
alex@e-pcplus.com

Photo Cleaner
Seindah Warna Aslinya
Sayang sekali kalau warna di dalam foto tidak sesuai dengan yang
diharapkan seperti terlalu terang atau terlalu gelap, bisa juga ada beberapa warna
muncul tidak pas. Keuntungan dunia digital, foto bisa dimanipulasi, termasuk
memperbaiki foto sehingga foto menjadi seindah warna aslinya.

Para expert biasanya menggunakan aplikasi Adobe Photoshop yang mampu
memperbaiki foto dengan tingkat detail yang kompleks. Para pemula bisa
menggunakan shareware bernama Photo Cleaner yang bisa diperoleh di situs
www.photocleaner.com. Pemakaian shareware ini dibatasi hanya selama 30 hari.
Lewat dari itu, tidak boleh tidak, registrasi harus dilakukan.

Photo Cleaner memiliki kemampuan memperbaiki suatu foto digital dengan
mengatur level, ukuran, warna dan ketajaman. Selain memperbaiki, Photo Cleaner
juga dapat digunakan untuk memperindah foto dengan menambah vignette,
manipulasi pada tepi-tepi foto agar obyek di tengah foto terekspos, serta dengan
menambah frame alias bingkai. Ada lagi yang unik, kita bisa menambahkan cap
copyright pada foto.

Hanya ada 3 tahap untuk memperbaiki foto. Tahap pertama adalah memilih
foto yang akan diperbaiki dengan mengklik [Original] di menu yang berada di
sebelah kiri. Setelah itu, klik [Setting] untuk mengatur perbaikan. Jika semua sudah
sip, klik [Result]. Secara otomatis, proses perbaikan berlangsung. Lamanya proses
perbaikan tergantung dari pengaturan yang kita pilih dan ukuran foto yang
diperbaiki. Kalau prosesnya sudah selesai, foto hasil perbaikan segera muncul.

Sayangnya Photo Cleaner tidak menampilkan foto sebelum perbaikan untuk
dibandingkan dengan hasil setelah perbaikan. Bukankah lebih baik foto awal
ditampilkan untuk dibandingkan dengan hasil perbaikan sehingga perbedaan
antara kedua foto bisa terlihat? PC+

Merge Application
Menyatukan
Dua Gambar
Merge Application adalah freeware yang dapat digunakan untuk
menyatukan dua foto. Foto-foto tersebut diatur tingkat transparansinya untuk
menentukan foto mana yang lebih dominan dan foto mana yang merupakan
pelengkap. Aplikasi dengan ukuran 865KB ini dapat di-download dari http://
homepage.ntlworld.com/philip.haydon/mergeimage.htm.

Sangat mudah menyatukan foto dengan Merge Application ini. Yang
pertama dilakukan adalah membuka dua file foto. Pada window Destination
hasilnya bisa kita lihat. Hasil pada window Destination belum tentu benar.

Untuk memperbaikinya Merge Application menyediakan fitur Merge Align,
yang bisa diakses dari [View]. Di window Merge Align, foto pertama diatur dengan
klik kiri ditambah dengan drag. Sedangkan foto kedua diatur dengan klik kanan
ditambah dengan drag.

Gambar mana yang lebih dominan bisa ditentukan dengan menggunakan
[Edit]>[Merge]. Di sini kita bisa mengatur jenis penggabungan. Secara keseluruhan,
ada 7 macam penggabungan. Untuk mengatur tingkat transparansi foto, digunakan
Bias. Pada window yang sama, metode contrast bisa diatur.

Penggabungan yang sudah selesai bisa langsung dicetak atau disimpan di
harddisk. Untuk mencetak bisa dilakukan dengan mengklik [File]>[Print].
Sedangkan untuk menyimpan sebagai file, bisa dilakukan dengan mengklik
[File]>[Save Destination As].

Dengan demikian, foto-foto bisa dibuat lebih menarik dan bervariasi. Selamat
mencoba. PC+

Dalam bidang web
design, ukuran suatu foto
yang di-upload ke dalamnya
adalah hal penting yang mesti
diperhatikan. Semakin besar
ukuran foto, semakin lama
ditampilkan di suatu halaman.
Ukuran foto bisa diubah
dengan menggunakan aplikasi
semacam Adobe Photoshop,
aplikasi pengolah foto. Namun
ada suatu aplikasi yang secara
khusus berfungsi untuk
mengoptimalkan ukuran file
foto agar cocok untuk di-upload

ke situs. Aplikasi tersebut bernama
Photo Resizer yang merupakan
freeware. Aplikasi dengan ukuran
903KB ini dapat di-download di
www.showyourphotos.com.

Dari namanya saja sudah jelas
bahwa aplikasi ini berfungsi untuk
mengubah ukuran foto. Berbagai
setting yang ada di Photo Resizer
sangat sederhana. Para
penggunanya hanya perlu
memasukkan nilai panjang, lebar,
berapa persen pengurangan
kualitas dan filter. Setelah itu giliran
Photo Resizer menjalankan

tugasnya.
Informasi mengenai foto asli

disertakan pada bagian [Original
Photo] sedangkan informasi foto
setelah di-resize ditampilkan setelah
tombol [Resize] diklik. Dengan
demikian pengurangan ukuran
dapat dengan jelas dilihat. Setelah
selesai, foto yang sudah diubah
ukurannya bisa disimpan atau
langsung dikirimkan melalui e-mail.

Jadi dengan menggunakan
Photo Resizer, urusan tukar-
menukar gambar melalui e-mail
atau urusan meng-upload gambar
ke situs bisa dilakukan dengan
mudah dan cepat. Sayangnya tidak
ada suatu template untuk ukuran
thumbnail. PC+

Photo Resizer
Optimasi untuk Publikasi
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Panorama Maker 3.0
Foto bak Kereta
Pemandangan alam
memang menarik untuk
diabadikan menjadi sebuah foto.
Kadangkala, saking luasnya
pemandangan yang indah, sebuah
kamera tidak mampu menangkap
semuanya. Seiring dengan
perkembangan di dunia digital,
pemandangan indah yang terbentang luas kini tetap dapat diambil.
Tidak hanya pemandangan, obyek-obyek yang tidak dapat
tertampung lainnya juga tetap dapat diabadikan.

Tekniknya adalah dengan membagi obyek menjadi beberapa
bagian. Misalkan, suatu obyek yang memanjang secara horizontal,
maka obyek dipotret beberapa kali dari kiri ke kanan. Dengan
demikian, tidak hanya sekali kita mengambil gambar. Perlu diingat,
antara foto satu dengan foto di sebelahnya harus ada sedikit
perpotongan. Mengapa? Karena proses penyatuan dilakukan
dibagian yang berpotongan.

Kalau kamera yang digunakan adalah kamera digital, foto-foto
dapat langsung ditransfer ke PC. Sedangkan jika kamera yang
digunakan adalah kamera analog, maka foto-foto harus di-scan dulu.

Untuk menggabungkan gambar-gambar tersebut, kita perlu
bantuan aplikasi. Aplikasi yang PCplus coba adalah Panorama
Maker 3.0. Aplikasi dengan ukuran 20,8MB ini dapat diperoleh di
www.arcsoft.com. Aplikasi ini adalah shareware dengan masa
percobaan 15 hari.

Panorama Maker 3.0 mampu melakukan penggabungan
horizontal, vertikal, 360 derajat dan tile. Ukuran hasil penggabungan
bisa dipilih antara Small, Medium, dan Large. Ukuran hasil yang
dipilih mempengaruhi kecepatan dan ketelitian. Semakin kecil
ukuran yang dipilih, semakin cepat proses penggabungan dan
semakin kecil kemungkinan kesalahan pada hasil akhir. Panorama
Maker 3.0 juga mampu secara otomatis memperbaiki exposure atau
tingkat pencahayaan.

Berikut ini langkah-langkah menggabungkan foto dengan
Panorama Maker 3.0:

1. Langkah pertama yang dilakukan untuk menggabungkan
gambar dengan Panorama Maker 3.0 adalah memilih jenis
penggabungan, memilih ukuran hasil penggabungan, serta
memilih aktif tidaknya perbaikan exposure.

2. Langkah kedua adalah mengimpor foto ke dalam Panorama
Maker 3.0. Setelah foto diimpor, kemudian foto diurutkan
tergantung kepada jenis penggabungan. Panorama Maker 3.0
memiliki fitur yang memungkinkan untuk mengimpor gambar
langsung dari scanner atau kamera digital.

3. Setelah pengaturan pada langkah ke dua selesai, proses
penggabungan akan dilaksanakan. Hasil penggabungan dapat
dilihat setelah proses selesai. Hasil penggabungan ini belum
permanen, masih bisa diedit. Pada beberapa bagian mungkin
masih ada yang belum pas. Klik [Fine tune], kemudian klik pada
bagian foto yang dirasa aneh untuk melakukan perbaikan.

4. Pada saat perbaikan, ada dua foto yang berdampingan yang di
dalamnya terdapat beberapa lingkaran yang warnanya berbeda-
beda. Lingkaran merah di
sebelah kiri berpasangan
dengan lingkaran merah di
sebelah kanan. Posisi lingkaran
merah di sebelah kiri harus
berada di posisi yang sama
dengan lingkaran merah di
sebelah kanan. Jika perbaikan
sudah selesai, klik [OK].

5. Hasilnya pun muncul. Pan-
orama Maker 3.0 secara
otomatis meng-crop gambar.

Foto terakhir ini bisa langsung
disimpan atau diedit dulu atau
langsung dicetak melalui printer.
Editing yang bisa dilakukan
terhadap foto adalah brightness,
contrast dan rotate.

Panorama Maker 3.0 mampu menggabungkan foto menjadi
panorama yang berputar alias 360 derajat. Dengan menggunakan
pilihan [Panorama], foto bisa di-rotate sehingga seolah-olah yang
melihat sedang berada di tengah-tengah obyek. Untuk membuat
panorama ini, dibutuhkan minimal 6 foto. Panorama ini bisa di-
export menjadi file QuickTime (*.mov). PC+

Morphing adalah
animasi perubahan
bentuk. Perubahan bentuk
bisa bermacam-macam, namun
yang dibahas di sini adalah
morphing yang
menyebabkan
perubahan ekspresi
pada foto wajah.
Wajah cemberut pun
menjadi tersenyum.
Untuk membuat
morphing foto ini,
ada sebuah aplikasi
yang bernama
WinMorph, yang
bisa di-download dari
www.debugmode.com/
winmorph/ dengan
ukuran 4,26MB.

Untuk membuat morphing
dibutuhkan 2 buah foto. Foto
pertama adalah foto ekspresi
awal, sedangkan foto ke dua
adalah foto ekspresi terakhir.
WinMorph akan menciptakan
transisi di antara kedua foto
sehingga tampak menjadi
sebuah video. Transisi ini
disimpan dalam bentuk AVI,
sehingga bisa dilihat dengan
menggunakan Windows Media
Player.

Langkah-langkah yang
perlu dilakukan untuk membuat
morphing dengan WinMorph

adalah:
1. Menentukan area utama yang

berubah, misalnya kepala.
Penentuan ini dilakukan pada
foto 1 dan foto 2.

2. Menentukan area-area yang
berada di dalam area utama,
misalnya mata, hidung, mulut

WinMorph
Cemberut Jadi Tersenyum

dan sebagainya. Penentuan
ini juga dilakukan pada foto 1
dan foto 2.

3. Sesudah klik pada
[Ascociate Shape]
yang berada di tool
box sebelah kiri.
Setelah diklik, pada
foto 1 dan foto 2
muncul area-area
yang tadi sudah
ditentukan.

4. Klik [Preview Mode]
di menu bar.
Sembunyikan foto
asli dengan mengklik
[Show/Hide Current Frame]
yang ada di menu bar sebelah
atas agar yang
muncul hanya area
yang sudah
ditentukan.
Kemudian klik

seluruh area
pada salah
satu foto.
5.   Kalau
seluruh area
sudah terpilih,
klik lagi
[Show/Hide
Current
Frame].
Kemudian untuk mem-
publish-nya menjadi
AVI, klik [Render] pada

menu bar di sebelah atas.

Selain membuat
morphing dari foto, freeware
ini juga dapat digunakan
untuk membuat wrap dari
foto. Untuk wrap ini,
perubahan bentuk yang

terjadi hanya sedikit, misalnya
hanya pada bagian mulut.

Ayo perbaiki foto biar
kelihatan lebih ganteng atau
cantik! PC+
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Arman Kania
aruman_8@yahoo.com Big Mutha Trucker:

Bersaing Memperebutkan Warisan

K

Ada beberapa kekurangan
dalam game ini. Misalnya
pengendalian truk yang kurang
realistis. Selain itu, kerusakan
dalam game ini tidak
digambarkan dengan realistis.
Truk akan berasap saja bila rusak.
Dan konyolnya adalah bila ada
pengendara motor liar naik ke
atas trailer refrigerator karena
pada trailer model  ini tidak
terdapat tangga di belakangnya
seperti layaknya trailer tanker.
Cukup aneh bila melihat seorang
pengendara liar “menempel”
seperti Spiderman dan naik ke
atas truk.

Sayangnya lagi pemain tidak
bisa memakai senjata. Padahal
permainan akan lebih seru bila
bisa kebut-kebutan sambil saling
tembak. Tidak lupa gameplay
yang cukup monoton karena
game ini bertema tidak jauh dari
mengantarkan barang dari satu
kota ke kota lain. Bila nantinya
merasa bosan, Anda bisa
mencoba misi-misi yang cukup
unik dalam game ini. Seperti
permainan tarik tambang dengan
menggunakan truk yang
menuntut kekuatan tangan
pemain untuk menekan tombol
keyboard. Selain itu game ini

tidak mempunyai dukungan
jaringan. Padahal akan
menyenangkan bila kita bisa
balapan dalam sebuah jaringan
dengan teman-teman kita.

Kesimpulannya, game ini
cukup menyenangkan untuk
dimainkan. Bila Anda
penggemar game yang
sederhana namun fun, game ini
cocok untuk Anda. Apalagi
game ini tidak menuntut
hardware yang canggih. PC+

Tersebutlah suatu
perusahaan keluarga
yang bergerak dalam

bidang transportasi
darat. Pemilik

perusahaan ini, yaitu
seorang ibu yang

berniat pensiun dan
mewariskan

perusahaannya
kepada salah satu dari

empat anaknya.

etika
permainan
dimulai, pemain harus
memilih satu dari

empat bersaudara ini, yang
masing-masing memiliki truk
yang berbeda. Setelah itu, baru
beraksi untuk mengumpulkan
uang sebanyak mungkin dalam
waktu 60 hari. Pemenangnya
berhak memperoleh warisan
dari sang ibu.

Permainan dalam game ini
berorientasi kepada berapa
banyak keuntungan yang
diperoleh pemain ketika
mengantarkan barang dari satu
kota ke kota lain. Ada 5 kota
dalam game ini.

Di garasi, truk bisa
dimodifikasi. Di sini pula
kendaraan diperbaiki dan diisi
bahan bakarnya. Tipe-tipe
modifikasi yang terdapat dalam
game ini cukup banyak. Pemain

bisa memasang bumper besar di
truknya atau spoiler pengarah
angin. Tapi berhati-hatilah dalam
membelanjakan uang.

Dalam game ini toko
memegang peranan penting.
Dalam bertransaksi dituntut
kelihaian. “Beli murah jual
mahal”, begitu hukumnya. Setiap
barang  tidak selalu cocok
dengan tipe trailer. Terdapat 3
tipe trailer dalam game ini, yaitu
Flatback untuk membawa
barang-barang biasa, Tanker
untuk membawa barang-barang
bersifat cair, Refrigerator untuk
membawa barang-barang yang
perlu disimpan pada suhu dingin.
Trailer-nya sendiri bisa dibeli di
garasi.

Di bar,
informasi penting
bisa didapatkan.
Seperti barang apa
yang sedang sangat
dibutuhkan pada
suatu kota.
Hubungan dengan
rentenir atau misi-
misi khusus bisa
diperoleh di tempat
ini pula.

Dalam
perjalanan

mengantarkan barang, pemain
dihadapkan banyak rintangan
yang menghadang. Seperti polisi-
polisi atau sekelompok
pengendara motor liar yang
membajak truk. Tapi hal yang
paling mengganggu adalah
mobil-mobil yang berlalu-lalang.

Grafik dalam game ini tidak
begitu istimewa. Namun cukup
bagus dan halus. Dengan begini
setidaknya game ini tidak
memerlukan hardware yang
“berat”.

Tata suaranya juga tidak
begitu istimewa. Kecuali suara
klakson truk yang menurut saya
sedikit memesona. Dengan
klakson ini, semakin terasa siapa
raja jalanan di sini

Spesifikasi Sistem :

• Microsoft Windows 98/98
SE/ME ( Millennium
Edition )/2000/XP

• Prosesor Pentium-III
500MHz (700MHz atau
lebih direkomendasikan)

• RAM 96MB (128MB atau
lebih direkomendasikan)

• CD-ROM 4x (8X atau lebih
direkomendasikan)

• DirectX 8.1 compatible
3D Hardware Accelerator
16MB ( 32MB
direkomendasikan)

• Sound card 16-bit DirectX
8.1 compatible

• Sekitar 985MB ruang
kosong di harddisk
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Memasang Printer

N

Vincent Bayu T.B
vincent@e-pcplus.com

Printer merupakan
salah satu peripheral
yang sangat penting

dan mengalami
perkembangan  pesat

dewasa ini,
baik dari resolusi

cetak maupun fitur-
fitur inovatifnya.
Mulai dikenalnya

sistem operasi Linux
sebagai alternatif

justru memunculkan
fenomena  label

“Linux ready”
atau “Linux

compatible”.  Hal ini
menunjukkan

semakin banyaknya
dukungan vendor

peripheral maupun
piranti IT terhadap

Linux.

amun
demikian,
dukungan vendor
peripheral juga harus

kita imbangi dengan versi
Sistem Operasi yang up-to-date.
Semakin baru versi Linux kita,
maka semakin baik dan lengkap
dukungan terhadap periferal.
Sebagai contoh pengalaman,
redaksi mencoba memasang
printer Canon BJC 1000SP yang
boleh dikata sudah agak
ketinggalan ke Linux Redhat 7.2

(Enigma).  Walaupun driver telah
tersedia dalam Printer
Configuration sistem operasi
Linux Redhat 7.2, tetap saja
printer ini “ngambek”.  Setelah

dicoba dengan  Linux Redhat 9.0
(Shrike) dan memilih standar
GIMP, printer ini akhirnya “mau
jalan”.  Oleh karena itu, redaksi
menyarankan agar Anda selalu

mengikuti perkembangan sistem
operasi yang satu ini demi
kemudahan kita.

Proses pemasangan printer
pada Linux Redhat 9.0 ini

disajikan dalam tampilan grafis
yang semakin menarik dan se-
derhana.  Pengaturan (setting)
printer ini harus dilakukan oleh
root.  Jadi, Anda harus login
sebagai root dan memasukkan
password untuk root dahulu.
1. Langkah pertama adalah

klik [Main Menu] di main
bar, [System Setting],
kemudian pilih [Printing].

2. Kotak dialog Printer
Configuration akan tampil.
Klik [New].

3. Klik [Forward] dan beri
nama printer.

4. Klik [Forward], pilih tipe
komputer.  Jika mengguna-
kan koneksi paralel, pilih
/dev/lp0  dan jika
menggunakan koneksi
USB pilih /dev/usb/lp0. Jika
belum terdeteksi, klik
[Rescan Devices]. Tentukan
Queue Type, jika komputer
tidak terhubung ke jaringan
(standalone), pilih [Local
Printer/Locally connected].
Jika komputer terhubung
dengan jaringan Windows,
pilih [Networked Windows]
(SMB).

5. Klik [Forward].  Pilih merek
printer di dalam daftar
dukungan printer. Tentukan
merek beserta serinya.  Jika
ada pilihan GIMP print*,
aktifkan.

6. Klik [Forward] dan klik
[Apply].

7. Coba jalankan printer
dengan Test Print. PC+
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hingga saat
tulisan ini
dibuat),
Springdale ini
terdiri dari tiga
buah varian.
Adapun ketiga
varian tersebut
adalah i865PE,
i865G, dan
i865P.

Dari ketiga
varian ini,
berdasarkan
informasi yang
diperoleh dari
Intel, i865P belum mendukung
secara resmi penggunaan FSB
(Front Side Bus) sebesar 200MHz
(800MHz efektif). Untuk i865PE
dan i865G keduanya sudah
mendukung secara resmi
penggunaan FSB 200MHz. Khusus
untuk i865G terdapat solusi grafis

secara terintegrasi.
Pada fokus kali ini,

Springdale yang dibahas hanya
difokuskan pada yang telah
mendukung penggunaan FSB
200MHz secara resmi. Dengan
kata lain hanya i865PE dan i865G.

Seperti telah pernah
PCplus bahas

beberapa waktu lalu,
Intel belum lama ini

mengeluarkan chipset
terbarunya untuk

kelas performance.
Chipset tersebut

adalah i875P yang
memiliki kode nama

Canterwood.

ari segi
performa, memang
Canterwood ini
merupakan chipset

andalan Intel. Tetapi dari segi
harga, Canterwood bukanlah
yang menyenangkan. Ini akan
berakibat mainboard-
mainboard yang menggunakan
chipset i875P  memiliki harga
yang relatif mahal.

Ini menyerupai chipset Intel
terdahulu yang memiliki kode
nama Tehama alias i850.
Sebagai alternatif, Intel
menawarkan chipset terbarunya
yang memiliki kode nama
Springdale. Springdale ini
memiliki kinerja yang secara
teori tidak sebaik Canterwood,
namun menawarkan harga
yang lebih kompetitif. Tidak
seperti Canterwood yang hanya
memiliki satu varian (setidaknya

Tanpa PAT dan ECC
Springdale ini memiliki

spesifikasi yang bisa dikatakan
mirip dengan Canterwood.
Perbedaan utama dari Springdale
dengan Canterwood, setidaknya
menurut Intel, adalah pada fitur
PAT. PAT alias Performance

Acceleration
Technology ini
hanya terdapat
pada chipset
Intel yang
diberi kode
nama
Canterwood.

Tanpa
dilengkapi
dengan fitur
PAT ini,
Springdale
secara teoretis
akan memiliki
kinerja yang

berada di bawah Canterwood.
Tentunya kinerja yang lebih
rendah ini akan lebih kelihatan
pada aplikasi-aplikasi yang
memang bisa dikatakan
mengakses memori utama
secara intensif pada kondisi
tertentu. Hal ini sejalan dengan

Salah satu kombinasi yang membentuk Springdale, i 865 PE dan ICHS
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fungsi utama dari PAT yang
memang ditujukan untuk
mengurangi jumlah clock yang
diperlukan pada saat
mengakses memori untuk
kondisi tertentu. Bila kondisi ini
tidak terjadi, secara teori pula
kinerja dari Canterwood akan
menyerupai Springdale. Salah
satu fitur lain yang tidak
terdapat pada Springdale
adalah dukungan terhadap ECC
(Error Correction Code).

Fitur-fitur yang lain bisa
dikatakan tetap tersedia pada
Springdale ini. Berhubung
harga memori utama yang
mendukung ECC bisa dikatakan
relatif mahal dibandingkan
yang “biasa”, penggunaan
memori utama yang
mendukung ECC bisa dikatakan
tidak populer pada personal
end user. Oleh karena itu, bagi
personal end user pada
umumnya, perbedaan yang
paling mencolok antara i875P
dengan i865PE adalah pada PAT,
sementara antara i875P dengan
i865G adalah pada PAT dan
solusi grafis terintegrasi. Untuk
i865G sendiri, solusi grafis
terintegrasi yang digunakan
adalah Intel Extreme Graphics 2
yang menggunakan teknologi
DVMT (Dynamic Video Memory
Technology).

Beberapa Fitur dari
Springdale

Seperti telah dikatakan di
atas, perbedaan utama antara

Springdale dengan Canterwood
bagi personal end user pada
umumnya adalah pada PAT. Yang
telah mengetahui fitur-fitur lain
dari Canterwood tidak akan
menemukan fitur yang baru pada
Springdale.

Adapun beberapa fitur yang
tersedia pada Springdale (juga
menggunakan ICH5/R sebagai
southbridge seperti halnya
Canterwood) ini seperti
dukungan resmi terhadap FSB
200MHz (800MHz efektif),
dukungan terhadap Hyper-
Threading, dukungan resmi
terhadap DDR400, mendukung
penggunaan dual kanal memori
utama, dukungan terhadap AGP
3.0 (8x), CSA (Communication
Streaming Architecture), Serial
ATA yang terintegrasi, dan Serial
ATA RAID (ICH5R). Khusus untuk
i865G tentunya ada tambahan
Intel Extreme Graphics 2.

Salah satu mainboard yang telah
menggunakan Springdale

Dual kanal DDR400 tanpa PAT

Dengan
dukungan
resmi
terhadap
penggunaan
FSB 200MHz,
Springdale
ini tentunya
telah
mendukung
Pentium-4
Northwood
terbaru yang
memang
menggunakan
FSB 200MHz.
Hingga saat

dibuatnya tulisan ini, Pentium-4
Northwood yang tertinggi
dimiliki oleh Intel adalah yang
memiliki kecepatan sebesar
3,2GHz. Dengan FSB sebesar ini,
bandwidth
antara
prosesor
dengan
northbridge
akan
meningkat
menjadi
6400MB/s.
Untuk
mencapai
keseimbangan
bandwidth
yang baik,
ditambah lagi
agar clock yang diberikan pada
prosesor maupun memori utama
adalah sinkron, pilihan yang
tepat adalah menggunakan dual
kanal DDR400. Hal ini jelas

didukung oleh Springdale
meskipun tanpa tersedianya PAT.
Secara teori sebuah sistem yang
menggunakan kombinasi seperti
ini akan memberikan kinerja
yang lebih baik dibandingkan
dengan sistem-sistem terdahulu,
kecuali yang menggunakan
Canterwood tentunya.

Seperti telah diketahui
bersama, Hyper-Threading bisa
meningkatkan kinerja sistem
dalam kondisi tertentu. Selama
ini baru Pentium-4 Northwood
dengan clock speed sebesar
3,06GHz dan 3,00GHz saja yang
mendukungnya. Harga yang
harus dibayarkan secara umum
untuk prosesor-prosesor tersebut
sayangnya tidaklah bisa
dikatakan terjangkau.

Dengan tersedianya varian

baru Pentium-4 (FSB 200MHz)
yang telah mendukung Hyper-
Threading dan memiliki harga
yang lebih terjangkau, Springdale
ini merupakan pilihan menarik

untuk bisa memanfaatkan
Hyper-Threading tersebut.
Selain itu, dukungan terhadap
AGP 3.0 menawarkan investasi
yang cukup aman untuk
beberapa waktu. Satu fitur lain
yang menarik adalah CSA
(Communication Streaming
Architecture). Dengan CSA ini,
dimungkinkan untuk
menghubungkan solusi Gigabit
Ethernet tidak pada
southbridge melainkan pada
northbridge. Solusi seperti ini
akan mencegah terjadinya
perebutan bandwidth dengan
peralatan lain yang terhubung
pada southbridge.

Perlu diingat bahwa untuk
slot PCI, bandwidth yang
disediakan adalah sebesar
133MB/s, sementara bandwidth
antara southbridge dengan
northbridge hanya sebesar
266MB/s. Ini membuat
bandwidth untuk berbagai
peralatan lainnya yang
terhubung pada southbridge
dan bukan terpasang pada slot
PCI juga sebesar 133MB/s. Untuk
Springdale yang menggunakan
ICH5R sebagai southbridge-nya,
fasilitas RAID juga tersedia
meskipun hanya untuk
penggunaan interface Serial
ATA. Khusus untuk i865G,
penggunaan Intel Extreme
Graphics 2 dengan DVMT bila
dikombinasikan dengan dual
kanal DDR400 diharapkan akan
memberikan kinerja grafis 3D
yang lebih baik lagi. PC+
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Perbedaan Kinerja
Canterwood dengan

Springdale

Seperti telah
dijelaskan di halaman
sebelumnya, dari segi

performa memang
Canterwood

merupakan chipset
andalan Intel, tetapi

tentunya juga dengan
harga yang lebih

tinggi. Untuk
memastikannya,

sebuah pengujian
tentu dibutuhkan.

pakah
memang benar
Canterwood sangat
jauh lebih superior

dibandingkan Springdale? Kita
lihat hasilnya. Namun sebelum
itu, ada baiknya kalau kita
bandingkan terlebih dahulu
spesifikasi masing-
masing produk secara
fisik dan teknis.

Intel Desktop
Board D875PBZ

Motherboard
reference design Intel
Desktop Board dengan
kode Bonanza ini memi-
liki PCB warna hitam.
Untuk slot ekspansi,
tersedia sebuah slot AGP
3.0 universal yang
mendukung AGP 4x/8x,
serta lima buah slot PCI.
Fitur audio pada
motherboard D875PBZ
yang kami terima tidak
disediakan, namun fitur
ini tersedia secara
optional bagi user yang
membutuhkannya. Jika
ada, fitur audio yang
disediakan adalah
SoundMAX 4 XL dengan
menggunakan Analog
Devices AD1985 CODEC.

Dengan form factor
ATX berukuran 292,61 x
243,84 mm, penempatan
komponen komponen
pada board cukup apik.
Dengan hanya
disediakannya lima buah
slot PCI, slot AGP dapat
diletakkan sedikit
renggang dengan slot
DDR DIMM. Yang sedikit
mengganggu adalah
sangat rapatnya
konektor daya utama
dengan konektor dua
buah konektor IDE serta
konektor floppy.
Sedangkan konektor
daya tambahan
diletakkan agak jauh ke
belakang motherboard.

Meskipun chip northbridge
Intel D875PBZ diletakkan secara
diagonal, namun pendinginan
yang berupa heat sink tanpa
fan diletakkan sejajar dengan
bentuk form factor ATX.

Pada board ini, prosesor
Intel ber-FSB 533 dan 800MHz
dapat dikawani oleh hingga
4GB memori DDR 333 dan 400
pada empat buah slot DDR 184-
pin yang tersedia. Fasilitas input
output yang didukung oleh

motherboard adalah delapan
port USB 2.0, sebuah port serial
dan parallel, dua buah port Serial
ATA IDE, dua buah port Parallel
ATA IDE dengan UDMA 33, ATA-
66/100, floppy disk, dan PS/2
untuk keyboard dan mouse.

Intel Desktop
Board D865GBF

Secara desain, motherboard
ini persis sama dengan produk
motherboard Intel Desktop Board
D875PBZ diatas. Peletakan
komponen-komponen pelengkap

pada board D865GBF seperti
chipset, kapasitor, konektor
power dan power tambahan,
hampir semua merupakan copy-
paste dari D875PBZ.

Bedanya, motherboard yang
kali ini diberi warna hijau tipikal

Intel Desktop Board sudah
dilengkapi dengan fitur audio
terintegrasi serta masih
mendukung prosesor Intel
dengan FSB400 dan modul
memori DDR 266. Fitur lain yang
membedakan adalah,
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motherboard D865GBF yang kami
terima dari Intel memiliki enam
buah slot PCI. Ini dimungkinkan
karena form factor motherboard
ini sedikit lebih lebar
dibandingkan dengan D875PBZ
yaitu sebesar 294.64 x 243.84 mm.

Tetapi, dengan tambahan
satu slot PCI lebih dibandingkan
dengan D875PBZ, slot AGP pada
motherboard D865GBF harus
digeser lebih merapat. Akibatnya
tuas pengunci slot memori akan
terhalang kartu grafis saat akan
memasang dan melepas modul
memori.

Pada motherboard chipset
i865G ini juga tersedia integrated
Intel Extreme Graphics 2 sebagai
fitur VGA onboard.

Pengujian
Dua buah motherboard

keluaran Intel tersebut kami
bandingkan. Untuk Intel
Desktop Board D875PBZ
(chipset i875P) BIOS yang
digunakan adalah
BZ87510A.86A.0017.P01
(dengan setting optimal)
sedangkan untuk Intel Desktop
Board D865GBF (chipset i865G),
BIOS yang digunakan adalah versi
BF86510A.86A.0033.

P06.0304231704 (dengan
setting optimal). Saat menguji,
kami membedakan pula kinerja
masing-masing bila mengguna-
kan mode dual channel DDR
dengan single channel DDR.

Perangkat pelengkap lain
yang kami gunakan saat
pengujian ini antara lain adalah
Kingston KVR400X64C25/512
(DDR-400 512MB) sebanyak  2
keping, kartu grafis MSI
Ti4800SE-VTD8x, harddisk Sea-
gate ST340016A (Barracuda
ATA IV 40GB 7200rpm), drive
optik dari Asus untuk instalasi,
power supply Enlight 420W,
dan monitor yang mendukung
resolusi 1024x768.

Kombinasi yang digunakan
adalah Pentium-4 3.00GHz
dengan i875P dan 1GB dual
kanal DDR-400, Pentium-4
3.00GHz dengan i875P dan 1GB
single kanal DDR-400, Pentium-
4 3.00GHz dengan i865G dan
1GB dual kanal DDR-400,

Pentium-4 3.00GHz
dengan i865G dan 1GB
single kanal DDR-400.
Semua pengujian dengan
mode AGP 8x.

Sistem operasi yang
digunakan adalah
Windows XP yang telah
dilengkapi dengan
Service Pack 1, Intel Inf
5.00.1012 (i875P dan
i865G), dan driver nVidia
versi 43.45.

Software pengujian
yang PCplus gunakan kali
ini tidak berbeda jauh
dengan beberapa
pengujian sebelumnya.
Software-software
tersebut adalah
SYSmark 2002,
3DMark2001 Pro,
Quake3 Arena Demo,
SiSoft Sandra 2003,
dan TMPGEnc
2.510.49.157
(mengubah 40.000 frame
dari file ASF menjadi for-
mat SVCD dengan meng-
gunakan CBR (Constant
Bit Rate) sebesar 1200kb/
s, motion search preci-
sion yang high quality,
dan video arrange
method yang full screen
dan keep aspect ratio.

Hasil pengujian se-
lengkapnya dapat Anda
lihat dari grafik yang
ter-lampir pada artikel
ini. Dari hasil pengujian
ter-sebut dapat dilihat
bah-wa menggunakan
Pen-tium-4 3.00GHz di
mode dual channel dan
single channel DDR,
kinerja chip i875P lebih
terasa keunggulannya

pada aplikasi grafis 3Dmark dan
Quake 3Arena serta aplikasi
pengolah video yaitu TMPG
Encoder.

Hasil uji memory band-
width pada motherboard
chipset i875P dengan dual
channel dan single channel DDR
juga lebih baik. Pada uji dengan
Sysmark 2002, selisih kinerjanya
nyaris tidak terasa. Agak
uniknya, kami mendapatkan
angka yang lebih baik pada
chipset i865G. PC+
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1. Memilih Format
File Fleksibel
antar Sistem
Operasi
Tidak beda dengan

Microsoft Windows, Linux juga
memiliki program-program
yang bisa dioperasikan oleh
semua orang.  Tapi, di sisi lain
kita tidak bisa mengingkari
bahwa saat ini –kalau boleh
digambarkan- satu kaki kita
sudah ada di freeware system,
Linux, sementara kaki lain masih
berpijak di sistem komersial,
Microsoft.  Akibatnya, suatu
saat kita mengolah data kerja di
Linux, tapi suatu saat harus bisa
diakses atau disempurnakan di
MS Windows.  Bagaimana
menyiasatinya?  Pilih saja
format-format file yang
fleksibel, di antaranya:
• Aplikasi penyunting kata

Abiword atau Open Office
menyediakan format RTF
(Rich Text Format) dan
MicrosoftWord 95. Format
file ini memungkinkan
untuk dibuka di Microsoft
Word.  Selain itu, ada format
.txt yang bisa dibuka di
mana saja.

• Aplikasi spreadsheet
Gnumeric dan Calc
menyediakan format .DIF
dan .XLS (MSExcel95).
Format file ini
memungkinkan untuk
dibuka di Microsoft Excel.
Tentunya yang versi ’95 dan
yang di atasnya.

• Aplikasi penyunting
gambar
GIMP atau Krayon
menyediakan format .JPEG
atau .TIFF.  Format file ini
memungkinkan file untuk
dibuka di Adobe Photoshop
dan berbagai program
penyunting gambar under
Windows lainnya.

2. Mengakses dan
menyimpan data
dari/ke Windows
Ingin melanjutkan

penyuntingan file yang
sebelumnya dikerjakan dan
disimpan di partisi Windows.

Atau, ingin menyimpan file
yang dikerjakan di Linux untuk

diedit lebih lanjut di Windows?
Bagaimana mengakses partisi dan
folder-folder tersebut?
a. Login sebagai root dan isi

password root.
b. Masuk ke terminal dan

berikan perintah:
mount –t msdos  /dev/hd(?)(n)
/mnt (n) adalah nomor partisi
Windows, (?) adalah nomor
harddisk tempat Windows
berada.
Contoh: mount –t msdos  /
dev/hdc2  /mnt (Gambar1)
Bukalah direktori /mnt
dengan folder browser dan
cari berbagai folder
Windows di sana. Copy dan
buka di program penyunting
Linux. Jika Anda ingin
menyimpan hasil
penyuntingan di folder
Windows, simpan di folder
Windows melalui  direktori /
mnt Linux. (Gambar 2)

3. Membuat
Screenshoot
dengan GIMP

a. Bukalah GIMP di Main Menu,
kumpulan program Graphics

b. Klik menu [File]>[Aquire]>
[Screen Shoot]

c. Klik pada area yang ingin di-
capture.

d. Klik kanan pada area hasil
capture, klik [File]>[Save as].
Pilih direktori tempat
menyimpan (biasanya di
direktori /home).  Beri nama
file, tentukan format file
(biasanya TIFF atau JPEG).
Klik [Save].

4. Mengunci
Komputer dengan
LockScreen
Anda bekerja, dan tiba-tiba

ingin ke belakang
atau meninggalkan
komputer sejenak,
tapi tidak ingin
orang lain
mengutak-atik
komputer?
Kuncilah dengan
Lock Screen.
a.Atur setting
waktu screensaver
dengan angka
kecil, misalnya 1
menit. Klik [Main
Menu]>[Control
Center]>[Screen
Saver].  Sebelum

screen saver menyala, jangan
tinggalkan komputer dahulu.

b.Klik [Main
Menu]>[Lock
Screen]
Satu hal yang
harus diingat,
sebelum
melakukan
penguncian Anda
harus ingat
password root dan
user Anda.  Akses
kembali ke
komputer

mengharuskan pengisian
password ini. (Gambar 3)

5. Mengatasi Masalah
Instalasi Source
Code
Bagi para pemula atau

mereka yang baru saja bermigrasi
ke sistem operasi Linux, mereka
masih mendambakan cara
installasi yang menyerupai
Windows, yaitu secara grafis.
Cara itu hanya mendandalkan
mouse (keyboard hanya
digunakan untuk mengisi
konfigurasi atau setting saja). Hal
ini sah-sah saja. Namun, perlu
diketahui, bahwa paket yang
dikemas dalam bentuk RPM atau
DEB biasanya selalu tertinggal
beberapa versi minor di belakang
paket dengan versi tarball
terbaru, meskipun pada
umumnya, paket dengan versi
tarball selalu diluncurkan lebih
dahulu. Hal ini menuntut usaha
lebih untuk mengubah jenis
paket dari source code ke dalam
bentuk RPM. Tidak semua
produsen bersedia melakukannya
karena berbagai macam alasan,
misalnya ukurannya yang
membengkak, tidak efisien bagi
pengembangan paket yang
berubah dengan cepat, tidak bisa
disesuaikan dengan arsitektur
dari user, rentan gagal (biasanya
karena masalah dependency),
tidak adanya pilihan kustomisasi
oleh user, dan sebagainya.

Installasi dari source code
seringkali merupakan
menakutkan, karena juga harus
berurusan dengan masalah
kompilasi.  Namun sudah saatnya
menghapus image tersebut dari
pikiran Anda, karena sebenarnya
instalasi paket dari source code

menawarkan lebih banyak
kesempatan untuk mengenali
cara kerja sistem dengan
membaca source code,
menentukan lokasi tempat paket
akan diletakkan,
mengoptimalkan kinerja dengan
cara memilih arsitektur dan
pengaturan (setting) yang sesuai,
dan sebagainya.

Berikut ini beberapa tips
yang dapat digunakan sebagai
petunjuk sebelum melakukan

instalasi dari source
code:
a. Terlebih
dahulu harus
diketahui bahwa
instalasi source
code tidak
menyimpan daftar
paket yang terinstal
seperti pada paket
RPM sehingga kita
harus bisa
mengingat atau
paling tidak
mencatat daftar
paket yang kita
instal melalui
source code untuk
digunakan pada
saat kita hendak
menguninstal paket

tersebut.
b. Dapatkan paket source versi

terbaru yang biasanya
mengandung berbagai
perbaikan dan juga
penyempurnaan dari versi
sebelumnya. Tentukan juga
jenis arsitektur yang sesuai,
karena bisa berpengaruh

dengan kinerja dari paket
tersebut.

c. Apabila Anda ingin
melakukan upgrade sebuah
paket RPM dengan paket
source code, akan lebih baik
jika menghapus terlebih
dahulu paket dalam bentuk
RPM agar instalasi paket dari
source code tidak akan
menimpa paket RPM,
melainkan membuat duplikat
paket yang sama dengan versi
yang lebih baru. Jika Anda
mempunyai sisa harddisk yang
cukup lega, maka Anda bisa
menginstal keduanya untuk
membandingkan
perbedaannya.

d. Bacalah selalu file INSTALL,
README, README.TXT,
INDEX.HTML yang biasanya

terkandung dari setiap paket
source code. File tersebut
menjelaskan langkah-
langkah dan pengaturan
(setting) yang diperlukan
untuk mengompilasi dan
menginstal paket tersebut
(Gambar 4).

e. Anda bisa menghapus
direktori tempat source code
berada untuk menghemat
tempat, setelah melakukan
instalasi. Sebelumnya,
berikan perintah make clean
dan make distclean yang
akan menghapus semua file
yang diciptakan selama masa
instalasi dan kompilasi,
sehingga Anda bisa
menginstal paket yang sama
untuk user yang berbeda.

f. Lakukan ujicoba pada setiap
pengaturan (setting) yang
ada jika Anda tertarik untuk
meningkatkan kemampuan
paket tersebut, misalnya
paket PHP yang diinstal
dengan opsi -- with mysql
akan dapat mempergunakan
paket MySQL sebagai
database server.

g. Untuk meng-uninstall paket
dari source code, gunakan
sebuah rutin yang biasanya
telah dibuat dalam paket
untuk menghapus file,
perintah make uninstall.
Sayangnya, hal ini hanya
berlaku bagi paket yang
didistribusikan di bawah
proyek GPL. Artinya, sebuah
paket yang dibuat oleh
orang awam belum tentu
memasukkan rutin uninstall
dalam paket mereka.

5. Pengaturan Alias
Anda masih terbiasa

dengan beberapa perintah
MSDOS? Itu bukanlah sebuah

masalah, karena Anda masih
bisa mempergunakan perintah-
perintah tersebut pada Linux.
Bagaimana caranya? Tentu saja
dengan menciptakan sebuah
alias baru untuk perintah-
perintah tersebut pada sistem
operasi Linux, sehingga dapat
dikenali dengan baik.
a. Buka file .bash_profile

pada home directory Anda
dengan text editor
kesayangan Anda (dalam
contoh digunakan Vi).

b. Tambahkan baris
alias <nama_alias> =
“<perintah_pada_linux>”
Contoh: Untuk membuat
alias perintah dir pada
Windows dan berfungsi
untuk menampilkan isi
direktori tambahkan baris

Gambar 1

Gambar 2

Gambar 3

Gambar 4
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berikut ini (Gambar 5)
alias dir=”ls -al”

c. Simpan file dan logout.
Lakukan login ulang dan

cobalah perintah dir pada
Linux Anda.
Sayangnya, hal ini hanya

berlaku bagi single user saja

(hanya orang yang mengedit
file .bash_profile-nya).

Lalu, bagaimana dengan
sistem secara keseluruhan?
a. Edit file /etc/profile.d/

alias.sh, dan tambahkan alias
yang Anda inginkan, lalu
restart komputer Anda
(Gambar 6).

b. Setelah restart, maka alias
tersebut akan berlaku untuk
semua user yang ada pada
komputer Anda.
Jangan lupa, Anda butuh
hak akses root untuk
mengubah file alias.sh.

c. Untuk melihat daftar alias
Anda, gunakan perintah alias
-p pada shell.
(Gambar 7).

6. Mengubah
Tampilan Window
Login
Pada saat kita login pada

shell melalui text mode,
biasanya akan muncul informasi
tentang sistem operasi Linux
kita. Hal ini sebenarnya
merupakan isi dari sebuah file
yang ada pada direktori /etc,
yaitu file issue. Kita bisa
mengubah isi file /etc/issue
tersebut menggunakan text
editor untuk mengubah
tampilan login kita. Namun,
perlu diperhatikan bahwa pada
saat peristiwa upgrade, file ini
juga akan dipakai oleh bebe-
rapa distro Linux.  Oleh karena
itu, akan lebih baik jika Anda
melakukan backup terlebih
dahulu sebelum memulai
memgubahnya (Gambar 8).

7. Mencari File
Dengan Locate
Bagi Anda yang terbiasa

dengan pencarian file pada

(Gambar 5)

(Gambar 6)

(Gambar 7)

(Gambar 8)
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Windows, maka Anda harus
mulai membiasakan diri dengan
pencarian melalui shell atau
command line, karena biasanya
proses pencarian file di Linux
dilakukan pada shell dan bukan
pada mode grafis. Ada perintah
yang biasa digunakan untuk
mencari sebuah file, yaitu find.
Namun, penggunaan perintah
find akan lebih cocok jika kita
memerlukan kriteria pencarian
tertentu, seperti misalnya
mencari file dengan ukuran
yang lebih besar dari 100KB,
berumur lebih dari 7 hari, dan
sebagainya. Bagaimana dengan
pencarian biasa yang hanya
mencari lokasi? Untuk
kemudahan, gunakan perintah
locate yang akan mencari file
dari seluruh direktori yang ada.

Contoh: untuk mencari file
dengan nama pine, maka
ketikan perintah locate pine
dan hasilnya akan tampak
seperti pada Gambar 9.

Perlu diketahui bahwa
perintah locate akan membaca
file database /var/lib/slocate/
slocate.db yang berisi
kumpulan index dari setiap file
dalam komputer kita. Jika Anda
seringkali meng-install atau
membuat file baru, Anda perlu
memperbarui database tersebut
dengan perintah slocate -u
yang akan mengindeks setiap
file pada komputer Anda dan
menyimpannya dalam database.
Penggunaan perintah ini hanya
dapat dilakukan oleh user root.
Jika Anda tidak melakukan
update dalam waktu 8 hari,
maka ketika Anda
menggunakan perintah locate,
akan muncul peringatan seperti
pada Gambar 10.

8. Mengembalikan
File Teks yang
Terhapus
Bila tanpa sengaja sebuah

file teks terhapus, jangan panik.
Ada tips milik Michael Hamilton
yang masih dapat digunakan.
Bila bisa mengingat beberapa
teks dari file, tahu di partisi

mana file itu sebelum terhapus
dan masih tersisa space di partisi
tersebut maka masih ada
kemungkinan mengembalikan
file tersebut. Michael Hamilton
menggunakan perintah egrep
dan strings untuk
menyelesaikan kasus ini.

Misalnya, kita kehilangan
100 baris file dengan frase
“PCPLUS", diikuti oleh

"DOWNLOAD" dan masih ada
sisa space di partisi DOS.  Kita
bisa mendapatkan 100 baris teks
tersebut dengan baris perintah:

# egrep -100
'PCPLUS.+DOWNLOAD' /dev/hda3
> /mnt/dos/dokumen

Mudah-mudahan ke 100
baris teks tersebut bisa dibaca di:

# strings /mnt/dos/dokumen |
less

9. Mengubah
Tampilan Lilo
Pada saat meng-install Linux,

biasanya kita diberi pilihan untuk
menginstall Lilo (Linux Loader)
dalam versi teks ataupun mode
grafis. Sebagian besar dari kita
tentu akan menginstal dalam
versi grafis. Namun ada kalanya
kita juga ingin melihat
bagaimana tampilan lilo dalam
versi teks, bukan? Lalu
bagaimana caranya? Mudah saja.

a. Buka file /etc/lilo.conf yang
mengatur konfigurasi lilo.

b. Cari bagian yang berisi vga.
Pilihan inilah yang akan
mengatur tampilan lilo dalam
versi teks maupun grafis. Pada
kondisi default-nya, semua
tampilan lilo akan di-set ke
teks, namun, ketika user
meng-install Lilo dalam versi
grafis, maka pada setiap
pilihan diberikan pilihan vga

yang akan menimpa setting
global tersebut.

c. Kita dapat melihat pada
pilihan linux (label yang
bertuliskan linux), vga diset
ke ukuran 1024. Jika Anda
ingin mengubah tampilan Lilo
tersebut, maka ubahlah
pilihan tersebut menjadi
vga=normal. Ubah juga
setting pada Control Panel

dari sistem operasi Linux
Anda. Dengan asumsi Anda
menggunakan sistem operasi
Linux Mandrake, bukalah
Mandrake Control Panel,
masuk ke bagian boot, lalu
pilih menu [boot config].
Setelah itu, pilih menu
[configure] dan tentukan Lilo
with text mode. Klik [OK]
untuk menyimpan seting dan
restart komputer Anda untuk
melihat perubahan yang
terjadi.

10. Berpindah ke
shell dari X-
Window
Untuk berpindah dari X-

Window ke shell dapat dilakukan
dengan menggunakan Terminal.

a. Terminal dapat
dijalankan dengan mengklik
shorcut-nya yang terletak di
[Start]>[System Tools]>[Terminal].
Sebuah jendela Terminal
kemudian akan muncul seperti
pada Gambar 11. Jendela ini
mirip dengan MS-DOS Prompt
atau Command Prompt pada
sistem operasi Windows.

b. Nah, jika di Windows
Anda tinggal tekan [Alt]+[Enter]
jika ingin tampilan MS-DOS
Prompt full screen, maka di Linux
Anda dapat menggunakan
kombinasi tombol
[Ctrl]+[Alt]+[Fn], dengan n=1-7
untuk mendapatkan tampilan
shell yang full screen. Ketujuh
terminal ini dapat Anda gunakan
untuk bekerja bersama-sama.
Pada Redhat, X-Window
umumnya terletak di terminal ke
7 (kombinasi [Ctrl]+[Alt]+[F7]).
Terminal-terminal tersebut
disebut dengan ttyn, dengan n
mengikuti kombinasi tombol
[Ctrl]+[Alt]+[Fn] yang ditekan.
Jadi, jika Anda menekan
kombinasi tombol
[Ctrl]+[Alt]+[F2], maka Anda
masuk ke tty2.

11. Membuat
launcher
Launcher adalah sebutan

untuk shorcut di Linux.
a. Untuk membuat launcher

di desktop, klik kanan pada
desktop dan pilih [New
Launcher].

b. Untuk membuat launcher
di panel (sebutan Linux untuk
taskbar) klik kanan di panel lalu
pilih [Add to Panel]>[Launcher].
Sebuah kotak dialog seperti
terlihat pada Gambar 12 akan
muncul.

Misalnya, kita ingin membuat
shortcut untuk dokumentasi PHP
yang file-nya terletak di /usr/
share/doc/php/index.html,
maka isikan PHP Manual pada
kotak teks Name, lalu (bila perlu)
berikan komentar secukupnya
pada kotak teks Comment.
Tuliskan mozilla /usr/share/doc/
php/index.html. pada bagian
Command. Bagian ini
berarti launcher
tersebut akan
mengaktifkan aplikasi
browser mozilla
dengan dokumen file:
///usr/share/doc/php/
index.html.

c. Untuk memilih
ikon dari launcher
tersebut, Anda
tinggal klik di kotak
Icon. Di sana akan
muncul daftar pilihan
ikon yang dapat Anda
pilih sesuai selera.

12. Setting tampilan
X-Window

Untuk mengganti
background, caranya mudah saja.

a. Klik kanan pada desktop
dan pilih Change Desktop
Background. Sebuah kotak
dialog seperti pada Gambar 13
akan muncul. Anda tinggal
memilih background yang Anda
sukai. Untuk mengatur resolusi
dan seting hardware yang
berkenaan dengan display, Anda
dapat menggunakan menu
[Start]>[System
Setting]>[Display].

b. Jika pada saat mengatur
resolusi terjadi “kecelakaan”,
artinya tampilan X-Window
justru menjadi kacau, jangan
panik. Masuklah ke terminal,
misalnya di tty1 dan login
sebagai root. Gantilah nama file
XF86Config yang terletak di /
etc/X11 menjadi
XF86Config.old misalnya. Lalu

gantilah nama file
XF86Config.backup menjadi
XF86Config. Nah, setting Anda
akan kembali ke setting semula
setelah di-restart.

13. Melihat Free
Space di
Harddisk

Untuk melihat masih se-
berapa banyak ruang kosong di
harddisk Anda, gunakan
KDiskFree. KDisk-Free diaktif-
kan dari [Start]>[SystemTools]>
[More System Tools]. Informasi
yang ditampilkan akan terlihat
seperti Gambar 14.

Gambar 9

Gambar 10

Gambar 12

Gambar 13

Gambar 11
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14. Auto Complete
Perintah-perintah shell di

Linux umumnya pendek-
pendek, seperti ls, man, rm,
mv, dan lain-lain. Namun,
tentunya ada juga satu-dua
yang panjang. Shell Linux (pada
RedHat 9 menggunakan shell
bash) menyediakan kemampuan
untuk otomatis melengkapi
perintah yang akan Anda tulis
dengan menekan tombol [Tab].

Misalnya Anda ingin
mengetikkan perintah whereis,
maka Anda dapat
melakukannya dengan cara:

# whe [tab]
Otomatis, shell akan

melengkapinya menjadi whereis

Bagaimana jika ternyata
ada beberapa kemungkinan?
Sebagai contoh, ada sejumlah
perintah Linux yang diawali

dengan huruf wh, seperti who,
whois, whoami, dan lain-lain.
Misalnya Anda baru mengetikkan
wh dan langsung diikuti dengan
[Tab]. Apa yang terjadi? Shell
Linux akan memberikan
peringatan berupa bunyi bip
pada speaker. Artinya perintah
itu masih memiliki beberapa
kemungkinan atau malah tidak
ada. Tekan [Tab] sekali lagi. Jika
sekali lagi muncul bunyi bip,
berarti perintah tersebut tidak
ada, tetapi jika ada beberapa
kemungkinan, maka seluruh
kemungkinan tersebut akan
dimunculkan. Contoh:

# wh [tab] [tab]
whatis  which  whiptail

whoami
whereis  while  who

whois
Nah, Anda tinggal memilih

satu dari antara beberapa
kemungkinan tersebut. Jika
pilihan yang tersedia sangat
banyak, maka umumnya Linux
akan bertanya apakah semua
pilihan tersebut akan
ditampilkan. Contoh:

# c [tab] [tab]
Display all 116 possibilities?

(y or n)
Jika Anda tekan [Y], maka

seluruh kemungkinan perintah
yang diawali dengan huruf c
akan ditampilkan.

15. Menampilkan
teks per layar
Jika terdapat suatu teks

yang sangat panjang pada editor

Vi, maka teks tersebut dapat
ditampilkan per layar sehingga
Anda mudah melihatnya.
Perintah yang digunakan adalah

more.
Contoh:
# more /etc/httpd/conf/

httpd.conf
File /etc/httpd/conf/

httpd.conf adalah file yang
menyimpan konfigurasi httpd
atau web server Apache.

Perhatikan bahwa di bagian
bawah layar akan muncul teks --
more-- beserta persentase dari
dokumen yang telah ditampilkan.
Untuk "menggerakkan"
dokumen tersebut, gunakan
tombol-tombol berikut ini:

[Enter]: turun satu baris ke
baris berikutnya

[Spasi]: menggulung satu
layar ke bawah

[B]: kembali ke atas
[Q]: keluar dari dokumen
[H]: menampilkan daftar

tombol yang dapat digunakan
Selain digunakan di

depan, perintah more juga dapat
digunakan di belakang sebagai
pipeline. Penggunaan pipeline
adalah sebagai berikut:

perintah | pipeline
Misalnya: Anda ingin melihat

suatu isi direktori dengan
perintah ls -l dan ternyata isi
direktori itu banyak sekali.

Anda dapat menampilkan isi
direktori tersebut per layar
dengan menggunakan more
sebagai pipeline.

# ls -l|more
Dengan perintah ini, isi

direktori tersebut ditampilkan
per layar.

16. Shutdown atau
Restart
Jika karena suatu hal

Anda tidak dapat masuk ke X-
Window namun harus
melakukan shutdown atau
restart, Anda dapat
melakukannya dari shell dengan
perintah sebagai berikut:

Untuk shutdown: #
shutdown -h now

Untuk restart: # shutdown
-r now

Anda harus login sebagai
root untuk dapat melakukan
hal ini.

17. Melihat aplikasi
berjalan

Untuk melihat aplikasi yang
sedang berjalan gunakan
perintah:

# ps -ax
Anda harus login sebagai

root untuk dapat melakukan
perintah ini.

Linux akan menampilkan
seluruh aplikasi yang sedang
berjalan dalam urutan sebagai
berikut:

PID  TTY  STAT  TIME
COMMAND

Jika karena suatu keadaan
yang mendesak Anda harus
menghentikan sebuah program,
Anda dapat menjalankan
perintah:

# kill PID
PID adalah nomor identitas

aplikasi yang muncul dari
perintah ps -ax. PC+

Gambar 14
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Soltek SL-85MIR2-L:

Motherboard
Chipset i845GE

PT Berca Computel
www.soltek.com.tw

☎ (021) 2316352
77 dolar AS

Albatron FX5600EQ:

Kartu Grafis dengan
Memori Besar

Internasional Computer
www.albatron.com.tw

☎ (021) 6242709

Meskipun baru
beberapa tahun
ini berkiprah di dunia kartu
grafis, Albatron telah memiliki
reputasi cukup baik. Sejak era
GeForce-4, produsen yang
berasal dari Taiwan ini telah
mengukuhkan diri sebagai
salah satu pemain utama di
industri ini.

Sekarang, setelah chip
grafis untuk PC desktop buatan
nVidia kembali ramai di pasaran
dengan seri GeForce FX-nya,
Albatron juga telah
memproduksi kartu grafis
dengan chip baru ini.

Salah satu jajaran kartu
grafis buatan Albatron terbaru
yang sudah hadir di Indonesia
adalah GeForce FX5600. Untuk
produk jenis ini Albatron
memiliki empat jenis yaitu
FX5600 Ultra, FX5600EQ,
FX5600P

Motherboard
Soltek yang kita ulas kali
ini adalah seri SL-85MIR2-L.
Berbeda dengan versi SL-
85MIV3-L (PCplus edisi 133)
yang menggunakan chipset VIA
P4V266A, motherboard Soltek
ini menggunakan chipset Intel
845GE sebagai basis
teknologinya. Motherboard ini
juga dikenal sebagai
motherboard all in one.

Dari sisi form factor,
dimensi motherboard ini
berbasis micro ATX berukuran
24,5 x 24,5 cm. Juga seperti SL-
85MIV3, produk ini juga
memiliki kembaran yang tidak
dilengkapi dengan kontroler
jaringan terintegrasi yaitu SL-
85MIR2.

Pada motherboard ini, chip
northbridge Intel 845GE
dipasang bersama chip
southbridge Intel 82801DB
sebagai ICH4. Sebagai chip
northbridge, i845GE ini sudah
mendukung prosesor Intel
Pentium-4 soket 478 dengan
FSB 400 dan 533MHz. Untuk
dukungan memori utama, chip
ini dapat mengelola memori

Turbo, FX5600P. Kali ini yang kita
ulas adalah Albatron versi
FX5600EQ.

Perbedaan mencolok kartu
grafis ini dengan kartu grafis chip
GeForce FX5600 dari produsen
lain pada umumnya adalah
memori video yang disediakan.
Bila produsen lain umumnya
hanya menyediakan memori
video berkapasitas total 128MB,
Albatron menyediakan memori
video hingga 256MB pada kartu
grafis seri ini.

Secara fisik, kartu grafis yang
menggunakan PCB berwarna biru
ini tampak meyakinkan. Dengan
menyediakan konektor D-Sub 15
pin, DVI, dan TV-out, kartu grafis
ini dilengkapi dengan fasilitas
pendinginan yang baik. Untuk
menjaga suhu prosesor grafis
tetap normal, Albatron

menggunakan heat sink fan yang
cukup baik. Fasilitas pendinginan
memori video yang digunakan
juga baik, bahkan boleh dibilang
lebih mampu mendinginkan chip
memori dibandingkan dengan
beberapa produk kartu grafis
dari produsen lain.

Untuk memorinya sendiri,
Albatron menggunakan memori
jenis DDR 128-bit. Dengan engine
clock 325MHz dan memory clock
400MHz, kartu ini dapat
digunakan untuk menjalankan
aplikasi 3D terkini dengan
mulus. Saat digunakan,
Albatron FX5600EQ yang
mendukung standar bus
AGP 8x dan AGP 4x ini
dapat menghasilkan
resolusi hingga
2048x1536 pada refresh
rate 75Hz.

Chip grafis nVidia
GeForce FX5600 ini

merupakan chip grafis versi
menengah dari seri GeForce FX
dan ditujukan untuk bersaing
dengan ATi Radeon 9600. Kartu
grafis Albatron yang
menggunakan chip GeForce

DDR266 dan DDR333 hingga
kapasitas maksimal 2GB pada dua
buah slot DDR DIMM 184-pin
yang disediakan.

Meskipun pada chipset
sudah tersedia teknologi
onboard video yaitu Intel
Extreme Graphics, Soltek
masih menyediakan pula
sebuah slot AGP 4x bagi
pengguna yang kurang
puas dengan kinerja
grafis terintegrasi dari
Intel itu. Yang perlu
diperhatikan, untuk
menghindari kerusakan
secara hardware, hanya
kartu grafis AGP 1,5V saja
yang dapat dipasangkan.

Sebagai pasangan yang
saling melengkapi, chip
southbridge pada motherboard
yang dipoles warna silver ini
menyediakan dukungan
terhadap mode Ultra ATA 33/66/
100, kontroler yang mampu
menampung enam buah
perangkat USB 1.1 ataupun 2.0,
menyediakan 6 channel audio
onboard, dan fitur hardware
monitoring. Untuk menyediakan
fasilitas jaringannya, Soltek

menggunakan jasa chip RTL8139C
buatan Realtek.

Sama seperti produk yang
kita bahas minggu lalu juga,
fasilitas ekspansi pada

motherboard ini adalah pada tiga
buah slot PCI. Ini merupakan fitur
standar motherboard micro ATX.
Soltek tidak menyertakan slot
CNR, AMR, ataupun ACR yang
tidak terlalu banyak digunakan

oleh pengguna umumnya.
Seperti yang umum juga

terjadi pada motherboard untuk
kelas pengguna kantoran
ataupun rumahan biasa, secara
default FSB pada motherboard
diturunkan untuk menjaga
kestabilan sistem. Pada
motherboard ini system clock
yang tercatat adalah 133,0MHz,
sedangkan system bus-nya
tercatat pada 531,98MHz. Namun
demikian, Soltek tidak menutup
kemungkinan bagi pengguna
motherboard ini untuk
mengubah setting FSB melalui

BIOS keluaran AMI
yang disediakan.

Setting yang
dapat dipilih

adalah
mulai dari

100 hingga 200 dengan
peningkatan per 1MHz.

Motherboard Soltek SL-
85MIR2-L ini kami uji dengan
prosesor Intel Pentium-4 2,4GHz
FSB533MHz. Untuk memorinya,
kami menggunakan sekeping
memori Kingmax DDR PC-3200

SysMark 2002
Rating :244
Internet Content :328
Office Productivity:182

SisoftSandra 2003
ALU :6483 MIPS
FPU :1340 MFLOPS
ISSE2 :3153 MFLOPS

3D Mark 2001
640 x 480  16bit :7246
640 x 480  32bit :6623
800 x 600  16bit :6324
800 x 600  32bit :5492
1024 x 768  16bit :5102
1024 x 768  32bit :4013

Quake III Arena
640 x 480  16bit :238,2fps
640 x 480  32bit :199,3fps
800 x 600  16bit :180,9fps
800 x 600  32bit :140,3fps
1024 x 768  16bit :120,4fps
1024 x 768  32bit :90,9fps

Quake III Arena
1024 x 768  16bit :216,9fps
1024 x 768  32bit :202,6fps
1280 x 1024  16bit :163,0fps
1280 x 1024  32bit :144,7fps
1600 x 1200  16bit :115,7fps
1600 x 1200  32bit :100,1fps

3D Mark 2001
1024 x 768  16bit :7943
1024 x 768  32bit :8299
1280 x 1024  16bit :6354
1280 x 1024  32bit :6553
1600 x 1200  16bit :4339
1600 x 1200  32bit :5113

3D Mark 2003
1024 x 768 :2404
1280 x 1024 :1744
1600 x 1200 :1312

FX5600 ini juga ditujukan untuk
pengguna penggemar nVidia dari
kelas mid end. Tetapi, dengan
memori video sebanyak yang
disediakan oleh Albatron,
tentunya kartu grafis ini bukan
sekedar kartu grafis mid end
biasa dari nVidia.

Saat menguji kinerja
Albatron FX5600EQ, kami sempat
mencoba menaikkan core clock
sedikit demi sedikit hingga ke
angka 375MHz. Pada clock ini,
tampilan pada sistem operasi
ataupun aplikasi kerja lainnya
masih normal meskipun pada
aplikasi 3D terutama game,
gambar sudah tampak pecah.
Tetapi pada angka 366MHz kartu
grafis ini masih mampu untuk
menjalankan aplikasi uji 3DMark
2003 dan Quake 3 Arena dengan
baik.

Kami menguji kartu grafis ini
dengan software uji
3DMark2001, 3DMark 2003, serta
Quake 3 Arena. Untuk sistemnya
kami menggunakan motherboard
Asus A7N8X, prosesor AMD
Athlon XP 2000+, dua keping
memori Corsair DDR400

berkapasitas 256MB, harddisk
Seagate Barracuda ATA IV
7200rpm kapasitas 40GB,
dengan sistem operasi Win-
dows XP Professional. Untuk
driver-nya kami menggunakan
nVidia Detonator XP versi
44.03. (fmn)

A
RE/PC

plus

dengan kapasitas 512MB.
Untuk tampilan grafis kami
menggunakan VGA card
dengan chip GeForce4 MX440SE
dari XFX, sedangkan untuk
menyimpan data, kami
menggunakan Seagate Barra-
cuda ATA IV 7200rpm kapasitas
40GB. Sebagai sistem operasi
kami menggunakan Windows
XP Professional dengan
software uji standar yaitu
Sysmark 2002, Sisoft Sandra
2003, Quake 3 Arena, dan
3DMark 2001. (fmn)
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PCPartner A4MS4-A23:

Pentium-4
dengan ATi RS200

PT Prima Data Abadi Karya
www.pcpartner.com.hk

☎ (021) 6121340
85 dolar AS

SysMark 2002
Rating :218
Internet Content :298
Office Productivity:159

SisoftSandra 2003
ALU :6038 MIPS
FPU :1340 MFLOPS
ISSE2 :3093 MFLOPS

3D Mark 2001
640 x 480  16bit :3280
640 x 480  32bit :3005
800 x 600  16bit :2667
800 x 600  32bit :2357
1024 x 768  16bit :1979
1024 x 768  32bit :1686

Quake III Arena
640 x 480  16bit :80,9fps
640 x 480  32bit :72,5fps
800 x 600  16bit :57,8fps
800 x 600  32bit :51,2fps
1024 x 768  16bit :38,7fps
1024 x 768  32bit :33,6fps

Salah satu produk
terbaru buatan PCPartner
yang mulai masuk ke pasaran
Indonesia adalah PCPartner
A4MS4-A23.
Motherboard ini
merupakan
produk dengan
chipset ATi A4
RS200 yang dapat
digunakan untuk
prosesor Intel
Pentium-4 soket 478
dengan FSB 400 ataupun
533. Dari segi faktor
bentuknya, produk ini
merupakan motherboard
jenis micro ATX yang memiliki
ukuran 24,3 x 24,3 cm.

Untuk digunakan sebagai
basis sistem PC desktop yang
digunakan untuk menjalankan
aplikasi standar, motherboard
ini sudah dapat memenuhi
persyaratan. Tiga buah slot PCI
untuk ekspansi dan sebuah slot
AGP juga disediakan meskipun
onboard grafis dari ATi sudah
ada.

Untuk memberikan
konektivitas ke jaringan,
PCPartner menyediakan
kontroler RTL8100BL. Kontroler
buatan Realtek ini mendukung
operasi 10/100 Mb/s, fungsi
Wake-On-LAN, dan remote-
wake up. Namun begitu,
meskipun pengguna
motherboard ini tidak
membutuhkan fasilitas LAN,

fitur LAN onboard
ini tidak bisa dinonaktifkan.

Untuk memori utamanya,
motherboad ini menyediakan
dua buah slot DDR DIMM 184-pin
yang mendukung penggunaan
memori DDR PC-1600 dan PC-
2100. Kapasitas total yang dapat
ditampung adalah 1GB. Sama
seperti dengan produk yang
pernah kita bahas beberapa edisi
lalu, pada motherboard ini
tersedia dukungan Integrated
128-bit 3D/2D Graphics Engines
yang menggunakan core chip
grafis Radeon 7000. Solusi grafis
ini menyediakan dukungan
Hardware Motion Compensation
& Hardware MPEG2 Decode
(DVD), Integrated 24-bit 300MHz
RAMDAC, serta mendukung dua
display yaitu CRT dan TV dengan

fasilitas TV-
Out.

Untuk dapat
menggunakan fasilitas

TV-Out, pengguna mother-
board ini tinggal memasangkan
bracket yang sudah disediakan ke
bagian belakang casing lalu
menyambungkan konektornya ke
headernya di motherboard.

Chipset ATi yang
menyediakan grafis terintegrasi
RS200 ini untuk video memorinya
menggunakan teknologi unified
memory architecture yang artinya
menggunakan sebagian alokasi
memori utama (DRAM) untuk
digunakan sebagai memori video.
Kapasitas untuk share memori
video-nya sendiri pada
motherboard pilihan yang
disediakan adalah mulai dari
32MB sampai 256MB share
memori.

Kondisi itu tentunya jika
memori utama yang disediakan
berukuran di atas 256MB. Kalau
memori yang terpasang hanya
256MB dan penggunanya
mengeset share VGA memory

sebesar 256MB juga, setelah di
save dan exit, BIOS akan
memberikan setting onboard
VGA share-nya secara otomatis ke
8MB, meskipun sebenarnya pada
BIOS opsi ini tidak tersedia untuk
dipilih.

Bila dibandingkan dengan
motherboard yang sekelas
berchipset SiS ataupun VIA,
kinerja motherboard dengan
chipset ATi ini sedikit lebih baik.
Kinerja grafis onboard dan
tersedianya fitur TV-Out
merupakan salah satu nilai lebih
produk ini.

Motherboard ini kami uji
dengan prosesor Pentium-4
2,4GHz, sekeping memori
DDR400 512MB dari Kingmax,
dan harddisk Seagate Barracuda
ATA IV 40GB. Untuk  grafisnya,
kami set onboard video memory-
nya ke 256MB. Saat pengujian,
kami menggunakan OS Win-
dows XP Professional dengan
software benchmark
Sysmark2002, Sisoft Sandra
2003, serta Quake 3 Arena dan
3DMark2001. (fmn)

ARE/PCplus



28 |

plusProduk IV • 09 - 15 Juli 2003
PCplus 134

SP521:
Speaker 2.1 Bertenaga dari Sonic Gear

USB 2.0 OnlyDisk:
Storage Mungil, Kapasitas Besar dari Netac

PT Multipro Daya Prima
www.netac.com
☎ (021) 6227567

Rp. 640.000,-

Samsung CDWriter SW-252:

Kecepatan Baca Tulis
Maksimalnya 52x

PT Samsung Electronics
www.samsung.com/products

☎ (021) 7973439
52 dolar AS

PT Leapfrog Indonesia
☎ (021) 66604784

75 dolar AS

Netac, salah satu
perusahaan yang
mengembangkan storage
thumb drive ini, memiliki
beberapa seri produk yang
cukup menarik. Salah satu yang
baru diterima PCplus adalah
Only Disk seri USB 2.0. Ada
beberapa pilihan kapasitas
yang bisa dipilih mulai dari
32MB hingga 256MB. PCplus
menerima produk berkapasitas
128MB.

Dari segi bentuk fisik,
produk  dengan dimensi
82x29x15 mm ini tidak terlalu
luar biasa. Penampilan produk
yang berwarna metalik ini
hanya dipermanis oleh dua
buah lampu berwarna biru di
kedua sisinya, yang akan

Produk drive optik
dari Samsung yang sudah
memiliki pangsa pasar yang
cukup besar di Indonesia adalah
CD-ROM. Selain harganya yang
terjangkau, produk ini juga
dapat dengan mudah dijumpai
di toko-toko komputer yang
tersebar di mana-mana.

Samsung tentunya ingin hal
yang sama terjadi pada produk
CD-writer mereka. Dengan
bersenjatakan produk
terbarunya, vendor yang berasal

Satu lagi produk
Sonic Gear yang diterima
PCplus. Kali ini tipe yang
diberikan adalah SP521, yang
merupakan bagian dari Platinum
Series dengan desain subwoofer
yang sedikit berbeda dibanding
produk sebelumnya.

Yang paling menarik dari
produk ini adalah subwoofer-
nya. Tidak seperti produk-
produk yang pernah diuji
sebelumnya, SP521 yang
berwarna dasar hitam ini
memiliki desain cukup unik,
dengan bentuknya yang
cenderung horizontal. Dari
spesifikasi teknisnya, subwoofer
ini memiliki kekuatan sebesar 28
watt (RMS) dan dilindungi oleh
magnetic shield sehingga cukup

menyala jika produk ini
ditancapkan ke PC yang tengah
beroperasi. Untuk menjaga
interface USB versi 2.0 yang
dipakai dari debu dan kotoran
lainnya, Netac juga melengkapi
produk yang beratnya hanya
sekitar 15 gram ini dengan
sebuah penutup. Sama seperti
produknya lain yang pernah
diterima PCplus, USB 2.0 OnlyDisk
ini juga dilengkapi dengan
sebuah switch pengunci yang
dapat berfungsi untuk
melindungi data dari
penghapusan secara tak sengaja.

Sama seperti produk sejenis,
produk yang tidak membutuhkan
power tambahan selain dari USB
ini juga sangat mudah digunakan
baik pada notebook, PC, maupun

pada Macintosh tanpa
memerlukan driver khusus. Hanya
padaPC dengan sistem
operasiWindows 98, Linux
dengan kernel di bawah versi
2.4.x, dan Mac OS di bawah OS
9.0 yang harus menggunakan
driver khusus. Namun, itu pun
telah diantisipasi Netac dengan
memberikan CD driver pada
kemasan jualnya.

Pada kemasan jualnya, selain
menyertakan CD driver produsen
yang bermarkas di Cina ini juga
menyertakan kabel USB
tambahan sepanjang 1,5 meter.
Tak lupa sebuah gantungan juga
disertakan sebagai pelengkap
tambahan produk ini.

PCplus menguji produk ini
dengan menggunakan sistem

berbasis Pentium-4 dengan
menggunakan Windows XP.
Dengan menggunakan file
sebesar 98,7MB produk ini diuji
unjuk kerjanya.  Dilihat dari
kecepatan transfer datanya,
produk yang telah
mengaplikasikan USB 2.0 ini
memang cukup lumayan. Dari
hasil pengujian,

kecepatan tulisnya mencapai
0,976 MB/s sementara kecepatan
bacanya mencapai 4,953MB/s.

Sebagai satu storage,
produk dengan kapasitas
sebesar ini memang sudah
cukup memadai. Apalagi
dengan interface USB dari versi
2.0 membuat kemampuan
transfer datanya lebih cepat,
selain juga kompatibel dengan
perangkat lain yang masih
menggunakan USB 1.1. Buat
pengguna yang mobile, produk
ini bisa dijadikan salah satu
pilihan. (sil)

dari Korea ini sudah mulai
melakukan penetrasi ke pasaran

drive optik untuk tulis
menulis ini dengan produk

Samsung SW-252.
Sebagai sebuah

perangkat drive optik
yang sedang marak
di pasaran, produk
buatan Samsung ini
memiliki kecepatan

tulis maksimal ke media
CD-R hingga 52x. Untuk

menulis dan menulis ulang ke
media CD-RW, kecepatan
maksimalnya adalah 24x,
sedangkan untuk membaca dari
media CD adalah 52x.

Teknologi yang didukung
oleh CD-writer ini adalah Mount
Rainier dan tentunya juga sudah
dilengkapi dengan Buffer
Underrun Protection. Untuk
meminimalisir kegagalan saat
sedang bekerja, Samsung SW-252
ini menyediakan buffer sebesar
8MB. Saat membakar, beberapa
mode yang didukung di antaranya

adalah Packet Writing, Disc At
Once, Track At Once, dan lain-lain.

Pada paket yang PCplus
terima, dalam kemasan produk ini
dilengkapi dengan sebuah kabel
IDE, kabel audio, empat buah
sekrup, sebuah bundle software
pembakar Nero Burning ROM, CD
User’s Guide, dan sebuah quick
installation guide.

Kami melakukan pengujian
CD writer ini pada PC Mugen e-
Station 2500 yang menggunakan
prosesor Pentium-III 933EB dengan
memori SDRAM sebesar 320MB.
Untuk software pembakarnya,
kami menggunakan Nero
Burning Rom versi 5.5.10.0

dengan sistem operasi Microsoft
Windows 98SE. Media CD yang
kami gunakan adalah CD-R yang
dapat ditulisi hingga kecepatan
52x dan CD-RW yang bisa ditulisi
dengan kecepatan 24x.

Saat kami melakukan
pembakaran ke media CD-R dan
CD-RW, kami menggunakan data
sebesar 652MB. Untuk
menyelesaikan pembakaran data,
CD-writer ini membutuhkan
waktu 157 detik untuk menulis ke
CD-R atau dengan kecepatan tulis
rata-rata 28,35x. Saat kami
melakukan pengujian untuk
menulis ke media CD-RW, data
yang kami bakar tersebut dapat

aman ditaruh di komponen PC
yang lain macam monitor. Selain
dilengkapi lubang di bagian
depannya sehingga suara bass
dapat dikeluarkan dengan cukup
baik, Sonic Gear juga
menyertakan sebuah bass reflex di
bagian samping kanan yang
dilindungi dengan kain peredam.

Sebagai pusat dari semua
kendali audio, bagian subwoofer
yang juga menyatu dengan
power-supply-nya ini juga
dilengkapi dengan tombol-tombol
pengatur, mulai dari tombol
volume, balance, treble, maupun
bass. Masing-masing tombol ini
juga dipercantik dengan adanya
lampu-lampu indikator berwarna
kuning keemasan sehingga cukup
memudahkan penggunanya

ketika mengatur audio di ruang
gelap. Tak lupa disertakan pula
sebuah switch on/of pada bagian
belakang.

Sementara, 2 speaker
satelitnya yang masing-masing
memiliki power output sebesar 6
watt (RMS) ini juga berwarna
dasar hitam dengan warna perak
sebagai pemanisnya. Interface
yang digunakan masih tetap sama
yaitu menggunakan kabel standar
yang disambungkan ke jack
penjepit di bagian belakang
subwoofer. Sementara, agar
terhubung dengan PC, SonicGear
juga dilengkapi dengan sebuah
kabel audio standar.

Produk ini sendiri memiliki
spesifikasi teknis yang cukup
lumayan. Dengan frekuensi

respon antara 60Hz
hingga 18000KHz,
SP521 secara teknis
sudah cukup memadai
untuk
mendengarkan
suara, baik pada
musik maupun
film. Sementara
sound to noise
ratio yang
dimilikinya juga
cukup rendah
untuk
mengurangi suara
desis maupun
gangguan lainnya.

PCplus mengujinya
dengan menggunakan sistem PC
dengan soundcard Realtek 1950
AC97. Saat mendengarkan CD
audio dengan setting default,
terlihat suara bass-nya memang
cukup bertenaga. Hanya saja,
besarnya bass harus diatur di
bawah setengah kekuatan penuh
agar bisa  seimbang dengan

ARE/PCplus

diselesaikan dalam waktu rata-
rata 283 detik atau dengan
kecepatan tulis rata-rata 11,56x.

Untuk hasil bakarannya,
ketika diuji dengan Nero CD
Speed 1.02 kami tidak
menemukan adanya masalah
apapun yang cukup
mengganggu sehubungan
dengan pembacaan file hasil
bakaran pada media CD-R. Hasil
surface test yang diperoleh juga
cukup baik. (fmn)

ARE/PCplus

speaker satelitnya
dan tidak terlalu boomy.
Sementara, treble-nya sudah
cukup memuaskan ketika diatur
pada posisi tengah. (sil)
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Masalah Dokumen
MS Word

Rekan-rekan milis, di
dokumen saya ada file
Microsoft Word yang sudah
nggak saya pakai lagi. Saat saya
mau hapus, langsung muncul
pesan yang isinya kurang lebih
seperti berikut: "Access is
denied, make sure that your
disk is not write protected".
Yang saya herankan, kenapa
pesan seperti ini bisa muncul
padahal file itu ada di harddisk.
Saya sudah coba mengklik
kanan lalu pilih Properties.
Kolom box read only-nya sudah
nggak dicentang, tetapi tetap
saja file ini menolak untuk bisa
dihapus.

Bagaimana nih cara
menghapus file yang satu ini?
Tolong ya, saya baru belajar
komputer sih. Atas bantuan
rekan-rekan saya ucapkan terima
kasih.

Sigit Riswandi

Jawab:
File-nya berekstensi apa sih?

Doc? Coba Anda hapus dari
dalam DOS mode atau Safe
Mode. Kalau Anda menggunakan
sistem operasi Windows 98,
lakukan restart ke DOS mode lalu
delete dari sana. Kalau pada
komputer Anda ada software
Norton Utilities, versi 2002
misalnya, coba Anda jalankan
tool yang namanya Norton
Wipe Info. Tool ini mungkin bisa

Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan mendaftar dengan mengirimkan e-mail  kosong ke mailplus-subscribe@yahoogroups.com. Agar keanggotaan Anda segera
diaktifkan, balas e-mail konfirmasi yang dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda dapat mengirimkan e-mail pertanyaan ataupun tukar menukar pengalaman
seputar dunia komputer. Jangan lupa untuk memeriksa account e-mail Anda secara rutin. Jika Anda tertarik untuk berdiskusi langsung secara online, silakan Anda join ke server DALnet pada
channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu e-mail berisi beberapa message), kirim e-mail kosong ke mailplus-digest@yahoogroups.com. Sebagai informasi,

setiap hari Jum’at hingga Minggu adalah hari bebas di milis ini. Setiap anggota dapat mem-posting e-mail diluar seputar masalah komputer asalkan tidak mengandung SARA, pornografi,
bajak-membajak software, flamming, dan sebagainya. Jika Anda tidak ingin menerima e-mail OOT (Out Of Topic), kirim e-mail ke mailplus-nomail@yahoogroups.com, dan silakan Anda
aktifkan kembali ke mode normal dengan mengirim e-mail ke mailplus-normal@yahoogroups.com.

            •Redaksi

membantu Anda untuk
mengatasi file-file bandel yang
tidak bisa diatur seperti file Anda
tersebut.

Adhitya F. Anggoro, Cock Wirawan

Seputar CD Writer

Halo rekan-rekan milis, gue
lagi bingung nih. Begini
masalahnya, CD-ROM gue yang
sekarang gue miliki sudah koit,
trus gue pengen beli CD-writer
sebagai gantinya, tetapi sampe
sekarang gue masih ragu.
Soalnya ada yang bilang ke gue
kalo CD writer sebaiknya dipake
untuk nge-burn aja. Kalo untuk
baca CD pake CD-ROM aja. Apa
CD-writer kalo digunakan

sekaligus untuk fungsi-fungsi
tersebut tetap awet? Soalnya
dana gue terbatas nih. Ada yang
bisa bantu klarifikasi?

Sardo Martinus M

Jawab:
Sebenarnya CD-writer bisa

difungsikan seperti CD-ROM
biasa koq.

Mungkin orang-orang suka
sayang aja sudah mahal-mahal
beli CD-writer lalu dipakai untuk
membaca CD bajakan, apalagi
untuk memutar VCD film yang
sudah banyak baretnya. Asalkan
Anda menggunakannya dengan
normal, aman-aman saja koq. Ya
seperti tadi, memang bisa
memperpendek umur optiknya,
tetapi kalau Anda bukan

penggemar CD program atau
film seharga lima ribuan, ya
tidak ada masalah.

Kalau ada yang
mengatakan CD-writer
sebaiknya digunakan untuk
menulis CD saja, mungkin ada
benarnya juga. Karena harga
yang relatif lebih mahal
dibandingkan dengan CD-ROM
drive biasa, jadi biar ada
pembagian tugas sama
perlindungan investasi gitu.
Kalo masalah umur pemakaian
kalo gak salah ditentukan sama
jumlah pemakaian, semakin
sering digunakan, umurnya
semakin pendek juga.

Adhitya F. Anggoro, Alexander,
Calculus

✔

+

Menghilangkan Program di Systray

Teman-teman milis sekalian, bagaimana sih caranya
menghilangkan atau menambahkan program di Systray? Pada
komputer yang saya gunakan, ada beberapa program yang tidak saya
perlukan dan ingin saya hilangkan.

Saya sudah lakukan klik kanan pada icon di Systray lalu di
[Close]. Memang program tersebut langsung hilang, tetapi kalau
komputer saya restart, program itu muncul lagi. Gimana nih caranya
yang baik dan benar? Terima kasih atas perhatian teman-teman.

GammaOK

Jawab:
Anda menggunakan sistem operasi apa? Kalau Anda

menggunakan Microsoft Windows 98, coba jalankan langkah-
langkah seperti berikut ini:

Klik [Start]>[Run] setelah itu ketik msconfig pada kolom yang
tersedia lalu jalankan dengan menekan [OK] atau tombol [Enter].
Setelah muncul menu baru, pada tab Startup, hilangkan tanda
centang pada program-program yang tidak ingin Anda load saat
start-up. Setelah selesai dengan pilihan Anda, klik [Apply] lalu restart
komputer Anda.

Adhitya F. Anggoro

✔

+

Komponen
Dua Juta Rupiah

Teman-teman milis tolong
bantuin aku dong. Aku punya
dana cuma sekitar dua jutaan,
dan aku bermaksud untuk
membeli seperangkat komputer
tetapi tanpa monitor dan prin-
ter (karena sudah ada). Yang
aku mau tanyakan, apakah de-
ngan dana segitu sudah cukup
bila aku ingin membeli kompie
berbasis Pentium-III 667MHz ?

Rencanaku, kompie ini nan-
tinya aku akan pakai buat
kerjaan yang under DOS, se-
dangkan untuk OS-nya aku cu-
kup menggunakan Windows 98.
Rencananya lagi, setiap harinya
kompie tersebut harus nyala
kira-kira 12 jam. Sehingga meng-
haruskan komponennya yang
tahan panas dan harddisk-nya
yang paling bagus (walaupun
menurutku space-nya nggak per-
lu besar-besar amat) serta aku
ingin juga ada CD-writer-nya.

Tolong dong teman-teman,
kasih tahu komponen dan merk
apa saja yang nantinya saya
perlukan? Untuk jawabannya
Rani ucapin terima kasih.

Dina Maharani

Jawab:
Hmmmm... Kalo mengguna-

kan Pentium-III sih kayaknya
masih rada-rada mahal tuh. Lagi
pula, memangnya Pentium-III
667MHz masih ada yang jual
barunya? Setahu saya, kalau
tidak barang remark, second,
paling-paling stok lama. Kenapa
nggak coba menggunakan Intel
Celeron 1,7GHz? Untuk
motherboard-nya bisa pakai yang
ada onboard VGA-nya kayak
yang chipset-nya Intel 846G?
Atau mau lebih murah, cari yang
chipset-nya buatan SiS seperti
SiS650. Sisa dana bisa buat beli
DDR-SDRAM, HDD dan CDRW
plus casing, keyboard dan mouse.
Itupun kalau dananya masih

mencukupi. Coba kita hitung-hi-
tungan sederhana secara
kasarnya. Harddisk 20GB
5400rpm sekitar 500rb, CD-RW 40x
sekitar 400rb, Casing 300W sekitar
200rb. Total 1.100rb, sisa 900rb
dapet apa?
Sistem dengan Pentium-III
• Celeron 1 GHz (socket 370)

sekitar 500rb
• Mobo 815e (VGA onboard)

sekitar 600rb

• SDRAM PC133 256MB sekitar
300rb

Sistem dengan Celeron
• Intel Celeron 1.7GHz (socket

478) sekitar 550rb
• Mobo VGA onboard 845G

sekitar 800rb
• DDRAM PC2100 256MB sekitar

300rb.
Cuma kurang sedikit. Masa-

lahnya saat ini di beberapa toko

harga SDRAM lebih mahal dari
DDR-SDRAM. Kalau Anda tetap
harus dua juta rupiah, berarti ha-
rus mencari komputer second.
Coba Anda browsing ke
www.bhinneka.com bagian
bursa atau www.iklanbaris.co.id
buat nyari yang jual Pentium-III
dengan mobo + SDRAM seharga
900rb.

Anthoria Febianto, prammz,
Adhitya F. Anggoro
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Silvester Sila Wedjo
sila@e-pcplus.com

M

Mudahnya Mengonversi
File CD Audio ke MP3

Apakah Anda punya
lagu favorit yang

ingin diputar terus
menerus pada PC

namun file-nya terlalu
besar karena masih

dalam format CD
audio sementara CD-

ROM drive Anda ingin
dipakai buat

menjalankan program
aplikasi yang lain?

asalah
semacam ini
sering dihadapi para
pengguna PC yang

tidak bisa mengopi langsung
file CD audio ini ke dalam
harddisk karena sisa ruangnya
sudah terbatas.
Itulah sebabnya dibuat
software yang memungkinkan
adanya perubahan tipe format
file ke format lain yang
ukurannya lebih kecil,
misalnya ke format MP3, dan
lain-lain.

Salah satu software yang
cukup baik dan sangat mudah
digunakan buat urusan
semacam ini adalah InterVideo
WinRip. Software ini menjadi
bawaan pada salah satu merek
motherboard karena
kemudahan penggunaannya,
bahkan buat pengguna awam
sekalipun.

Lalu, bagaimana cara
mengonversinya? Langkah-
langkah di bawah ini bisa
dijadikan patokannya.

Langkah-langkah ini hampir
sama bila Anda menggunakan
software sejenis lainnya untuk
mengonversi file semacam ini.
Yang pasti, sangat mudah
mengonversikan file audio dari
format satu ke  format lain.

1. Masukkan file
    sumber ke dalam
    drive pemutar CD

Langkah ini adalah langkah
paling pertama untuk
mengonversi file musik Anda ke
format lain semisal MP3.

Anda tinggal memasukkan
ke dalam CD-ROM drive atau
DVD drive sumber file audio/
sumber  yang Anda miliki dan
ingin dikonversi.

Kalau file audio ini sudah
ada di dalam harddisk, Anda
tinggal pastikan folder mana
tempat file tersebut berada.

2. Masuk KeSoftware
    Pengonversi

Di sini kebetulan yang
digunakan adalah InterVideo
Winrip yang mampu
mengonversi file dari format
audio yang satu ke format
audio yang lain. Setelah masuk
ke menu utama software ini,
ada beberapa pilihan yang bisa
Anda klik sesuai dengan
kebutuhan Anda.

Bila Anda hendak
mengonversikan file audio,
Anda tinggal klik menu [Play/
Record Audio CD]. Setelah itu,
Anda bisa pilih menu
selanjutnya dengan mengklik

pilihan [WinRip Audio CD Player/
Encoder].

3. Pilih Lagu yang
    Akan Dikonversi

Pada tampilan layar
selanjutnya, Anda diharuskan
mencari sumber file audio yang
hendak dikonversi.

Bila file tersebut terletak
pada CD-ROM drive, maka Anda
tinggal mencari file audio sumber
ke tempat tersebut. Jika sumber-
nya adalah CD audio, pada layar
kemudian akan muncul semua

lagu yang ada pada CD tersebut.
Di sini Anda tinggal memilih

lagu mana yang hendak Anda
konversi, dengan cara memberi
tanda check pada baris menu
Record  pada masing-masing lagu.

4.Memilih Format
   File Tujuan

Setelah itu, Anda diharuskan

memilih format file
tujuan sesuai
dengan kebutuhan
Anda. Caranya
dengan mengklik
menu
[Properties]>[Record
Format]. Ada tiga
pilihan yang
disediakan di sini
yaitu  WAV, MP3,
dan WMA.  Di sini
Anda tinggal
memberi tanda
centang di format
yang Anda
inginkan.

5.Meletakkan
   File Hasil
   konversi

Langkah
selanjutnya adalah
meletakkan file
hasil konversi. Pada
langkah ini, Anda
tinggal mengklik
menu [Properties]>

[Record Path]
agar file hasil kon-
versi diletakkan
pada folder yang
diinginkan. Anda

bebas memilih di folder mana
nantinya file hasil konversi akan
diletakkan.

6. Menentukan
    Bitrate Format MP3

Langkah ini adalah langkah
penting agar file MP3 hasil
konversi Anda bisa dinikmati
dengan nyaman. Pada software
ini Anda bisa masuk ke ke menu
[Properties]>[Preference]>[Recording].
Klik menu [Record & Compress to
MP3 format] yang dilanjutkan
dengan memilih bitrate-nya.

Untuk file MP3
standar, bitrate
yang dipakai
biasanya adalah
128Kbps.

Namun, bila
Anda ingin suara
yang diperdengar-
kan punya kualitas
yang lebih baik
lagi, Anda bisa
menaikkan sendiri
bitrate tersebut
sesuai keinginan
dan kebutuhan
Anda.

Pada tampilan
menu ini juga

disediakan Recording Path,
tempat di mana nantinya file
hasil konversi diletakkan.

Namun, kalau langkah 5
sudah Anda jalankan.

Anda tidak usah lagi
mengaturnya karena secara
otomatis file hasil konversi akan
menuju folder yang telah Anda
tetapkan.

Pilih Play/Record Audio CD sebagai
langkah  awal

Klik tombol WinRip untuk masuk
ke menu utama konversi file

7. Mengonversi File
Langkah terakhir yang harus

Anda lakukan adalah melakukan
konversi. Caranya adalah dengan
mengklik tombol [Record] pada

bagian kanan atas menu utama.
Secara otomatis, software ini
akan mengkonversikan file audio
ke MP3 satu per satu dengan set-
ting yang telah dibuat sebelum-
nya. Hanya dalam hitungan
menit saja, semua file sudah
dikonversi. Hasilnya bisa Anda
lihat di folder tempat Anda me-

Saat memulai konversi, software akan
memberitahukan sampai dimana proses
tersebut berlangsung

Pilih bitrate yang sesuai dengan
kebutuhan Anda

Beri tanda centang untuk lagu
yang akan dikonversi

Periksa file hasil konversi difolder
yang telah anda persiapkan

letakkan file hasil pada setting
sebelumnya. Mudah bukan.
Sekarang Anda tak usah kha-
watir lagi harddisk  akan kepe-
nuhan hanya lantaran menyim-

pan file audio yang berukuran
besar. Memang ada sedikit pe-
nurunan dalam kualitas audio-
nya karena format MP3
merupakan file audio yang ter-
kompresi. Namun, konversi se-
macam ini bisa jadi alternatif-
nya untuk menghemat harddisk
Anda. Selamat mencoba! PC+
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Inovasi Komputer
Berbahasa Indonesia

Gangsar Wicaksono
Gangsar1982@yahoo.com

O

Komputer merupakan
alat yang sangat

penting peranannya
dalam kehidupan

manusia pada saat ini
terutama pelajar dan

mahasiswa.
Mahasiswa banyak

menggunakan
komputer untuk

mengerjakan tugas-
tugas maupun skripsi,

tesis, atau disertasi.
Bagi mahasiswa
teknik, peranan

komputer sangat
penting karena

banyak perhitungan-
perhitungan

matematis yang harus
diselesaikan dengan
software (perangkat

lunak) komputer
seperti Turbo Pascal,

FORTRAN, MATHLAB,
dan lain-lain. Selain

itu ada juga software
komputer yang

digunakan untuk
tugas pendesainan
dan pensimulasian

seperti AutoCAD dan
Solidwork untuk

desain, ANSYS untuk
simulasi.

perating
System dan
software pada
komputer kebanyakan

menggunakan bahasa Inggris
sebagai bahasa pengantar
utamanya. Ada juga program
komputer yang memasukkan
data bahasa Cina, Jerman,
Jepang dan Rusia, tetapi sampai
saat ini penulis belum
menemukan program komputer
khusus teknik yang
menggunakan bahasa
Indonesia. Hal ini disebabkan
kebanyakan software komputer
untuk teknik dibuat di luar
negeri sehingga memakai
bahasa yang umum dipakai di
luar negeri, yaitu bahasa
Inggris. Software berbahasa
Indonesia untuk non-teknik
seperti software hukum,
perpajakan dan akuntansi
sudah banyak beredar di
Indonesia walaupun secara
kuantitas tidak begitu besar.

Komputer yang berbahasa
Indonesia mempunyai
keuntungan dan kerugian.
Keuntungannya antara lain
mudah dimengerti oleh orang
awam yang tidak bisa
berbahasa Inggris dan dapat
meningkatkan SDM bangsa
Indonesia. Sedangkan
kerugiannya antara lain tidak
bisa dipakai oleh orang yang
tidak bisa berbahasa Indonesia
dan pangsa pasarnya terbatas
hanya kepada orang yang bisa
berbahasa Indonesia.

Salah satu masalah yang
dialami programer Indonesia
dalam mengembangkan
software adalah pembajakan.
Indonesia adalah salah satu
negara yang mempunyai
tingkat pembajakan software

yang terhitung tinggi. Hal ini
menyebabkan para programer
tersebut kesulitan dalam
mengembangkan suatu sistem
software. Masalah ini sangat sulit
untuk diatasi oleh pemerintah
sehingga pembajakan software
menjadi hal yang biasa di
masyarakat. Tetapi hal ini tidak
menutup kemungkinan
programer Indonesia untuk
mengembangkan software
komputer berbahasa Indonesia
yang aplikatif dan dengan biaya
terjangkau.

Salah satu cara untuk
mengembangkan software
berbahasa Indonesia dengan
biaya terjangkau adalah
menggunakan Operating System
Linux dan menggunakan
software open-source (software
yang kodenya bisa didapatkan
dengan gratis dan tanpa biaya
lisensi). Linux adalah sistem
operasi yang berbeda dengan
generasi Windows buatan
Microsoft. Pengguna Linux tidak
perlu direpotkan dengan masalah
lisensi dan aktivasi sistem operasi
seperti yang sering dialami oleh
pengguna Windows. Program
Linux didistribusikan secara gratis
dan bagi pemakainya hanya
dikenakan biaya pemaketan dan
pengiriman. Kode Linux dapat
diubah-ubah sesuai dengan
keinginan programer komputer
sehingga programer Indonesia
dapat membuat suatu sistem
operasi Linux yang menggunakan
bahasa Indonesia. Pada saat ini
salah satu OS Linux berbahasa
Indonesia yang ada adalah Linux
Trustix Merdeka.

Hal yang sama dapat
dilakukan untuk membuat
software berbahasa Indonesia
yang aplikatif dan dengan harga
terjangkau dibandingkan dengan
software buatan luar negeri yang
harganya relatif mahal. Banyak
sekali program komputer yang
didistribusikan secara bebas di
Internet, begitu pula dengan
kodenya. Programer Indonesia
dapat men-download kode
program tersebut dan menyusun
sendiri program komputer yang
diinginkan. Untuk software
teknik, sekarang banyak sekali
kode-kode program untuk
software teknik yang
didistribusikan lewat Internet.
Walaupun tidak selengkap dan
serumit program teknik yang
sudah disebutkan di atas,
program-program teknik ini
dapat dikembangkan sesuai
dengan keinginan dan kreativitas
programernya terutama yang
berkaitan dengan bahasa
panduannya.

Cara lain untuk
memudahkan pengguna
software komputer agar lebih
komunikatif dengan software
tertentu adalah dengan cara

memecah kode-kode program
software tertentu yang
berbahasa Inggris dan kemudian
dibuat kembali sehingga menjadi
software yang berbahasa
Indonesia. Software ini kemudian
didistribusikan ke masyarakat
secara gratis atau komersial (
dengan menarik bayaran). Cara
ini dapat mempermudah
programer komputer Indonesia
untuk membuat dan
mengembangkan software-
software berbahasa Indonesia
dengan lebih baik lagi.

Walaupun software
berbahasa Indonesia dapat
dibuat secara massal, tetapi
supaya mempunyai pasar yang
luas terutama di luar negeri,
programer komputer harus
memasukkan data-data bahasa
asing. Pengguna komputer yang
tidak bisa berbahasa Indonesia
tidak akan mendapat kesulitan
jika software yang ditanganinya
menggunakan bahasa pengantar
bahasa Inggris atau bahasa asing
lainnya. Jadi Operating System
dan software yang menggunakan
bahasa Indonesia dan bahasa
asing dalam satu paket dapat
memudahkan masyarakat
Indonesia dan bangsa asing
untuk berinteraksi dengan
komputer tersebut.

Penggunaan komputer ber-
bahasa Indonesia ini secara lang-
sung maupun tidak langsung juga

dapat meningkatkan manfaat
pemakaian komputer di Indonesia
karena tidak semua orang
Indonesia bisa berbahasa Inggris.

Yang menarik, belakangan
Microsoft juga akan
mengembangkan software
berbahasa Indonesia.
Pengembangan ini salah satunya
dilatarbelakangi oleh keinginan
Microsoft untuk menjual
software-nya sesuai dengan
harga “Indonesia”. Menurut Ari
Kunwidodo, wakil presiden
direktur Microsoft Indonesia,
sekarang ini sebelum software
buatan Microsoft belum ada versi
Indonesianya, pihak Microsoft
Indonesia tidak bisa menjual
software secara lebih murah
dibandingkan dengan negara
lain, karena apabila hal itu
dilakukan akan mempengaruhi
penjualan di tingkat regional.
Logikanya, negara-negara
tetangga akan memborong
produk yang dikeluarkan oleh
Indonesia, sehingga
mengacaukan harga di pasaran.

Apakah software berbahasa
Indonesia ini bisa direalisasikan
segera? Pertanyaan ini masih sulit
dijawab karena bahkan Microsoft
Indonesia pun sampai saat ini
masih mengalami kesulitan untuk
memilih bahasa baku/standar
yang bisa menerangkan arti-arti
sesuai dengan kata dalam bahasa
Inggris. PC+

Apabila software berbahasa Indonesia mulai populer, kendala
bahasa yang dialami oleh sebagian masyarakat Indonesia bisa
diatasi.
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Simulasi Efek Kecepatan
dengan Photoshop

Vincent Bayu T.B.
vincent@e-pcplus.com

EFEK PANNING

1. Buka foto bahan
dasar, klik menu
[Window]>[Show
layer].  Klik ganda bar
layer, jadikan layer
normal.

2. Klik ikon [Add Layer
Mask]. Pilih nada
gelap, gunakan
Paintbrush Tool
untuk
menyembunyikan
bagian gambar yang
tidak perlu.  Ukuran
brush bisa
disesuaikan dengan
menekan tombol [
dan ].  Turunkan
opacity brush saat
menghapus tepian
subyek foto agar
tidak terkesan tajam
(seperti guntingan).

3. Aktifkan layer, buat
seleksi pada roda
dengan Eliptical
Marquee Tool.  Klik
menu
[Filters]>[Blur]>[Radial
blur]>[Spin].  Atur
intensitas efeknya.
Lakukan untuk roda
yang lain.

Rekaman obyek statis dalam foto sangat, sangat
menjemukan.  “Bumbu” efek gerak atau

kecepatan akan membantu menjadikan foto
eye catching.  Kita bisa melakukannya dengan

“kekasih” kita: kamera dan komputer.  Mari
kita lakukan dengan Adobe Photoshop.

4. Klik [Arrow] pada
panel layer, duplikat
layer.  Klik menu
[Filters]>[Stylize]>[Wind].
Atur intensitas efek,
tekan [OK]. Klik ikon
[Add Layer Mask]
(sama dengan
Langkah 2).  Hapus
efek kecepatan pada
wajah dan bagian
lain yang
mengganggu.

5. Masukkan gambar
latar belakang.  Klik
menu [Select]>[All],
klik menu
[Edit]>[Copy].
Aktifkan gambar
tujuan, klik menu
[Edit]>[Paste].  Atau,
gunakan Move Tool
untuk drag gambar
background ke
bidang kerja.
Tempatkan di urutan
layer belakang.

6. Save pekerjaan Anda.

Klik ganda disini

OpacityPaintbrush Tool Mask Aktif

Nada Gelap Ikon Add Layer Mask

Ellips Tool Layer Aktif

Klik untuk aktifkan Layer

Erase Tool
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EFEK ZOOMING

1. Buka foto, sama
dengan Langkah 1
Efek Panning.

2. Buat seleksi di
sekeliling subyek foto
dengan Pen Tool.
Rapikan kurva
dengan Direct
Selection Tool.  Jika
titik kendali kurang,
tambah dengan Add
Anchor Point Tool.
Bagian ini memang
memerlukan
ketelatenan kita.

3. Klik tab panel Path.  Klik ikon Load
path as Selection.  Klik kembali
tab panel layer.  Klik menu
[Select]>[Feather].  Tujuannya, agar
tepian subyek tidak tajam.  Beri
nilai toleransi besar, misalnya 10.
Klik menu [Select]>[Inverse].

4. Klik menu
[Filters]>[Radial
Blur]>[Zoom].  Beri
nilai tinggi.  Klik [OK].

5. Save pekerjaan Anda.

Bukan hal yang sulit untuk Anda coba, karena setiap orang pasti punya daya
imajinasi dan kreativitas.  Selamat mencoba. PC+

Pen Tool

Direct Selection Tool

Ikon Load Path as Selection
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Update BIOS
Kini Lebih Mudah

dan Aman

Bagi sebagian
pengguna PC, istilah
BIOS mungkin belum

pernah didengar.
Istilah sistem operasi
Windows boleh jadi
merupakan sesuatu

yang lebih umum
didengar. Padahal,

dari segi hal
vitalitasnya, BIOS jelas

lebih vital
dibandingkan dengan
sistem operasi seperti

halnya Windows.

isa
dikatakan,
BIOS merupakan
software yang paling

penting pada sistem. BIOS yang
paling umum dimaksudkan
adalah BIOS dari mainboard.
Tidak hanya mainboard saja
yang menggunakan BIOS ini.
Komponen lain seperti kartu
grafis dan CD-Writer juga
menggunakan BIOS ini.

Karena fungsi dari BIOS
yang sangat vital ini, BIOS
sangat mempengaruhi kinerja
dari komponen yang
bersangkutan. PCplus sudah
pernah membahas mengenai
pentingnya BIOS ini. Oleh
karena itu kinerja suatu
komponen bisa menjadi lebih
baik bila BIOS yang digunakan
diganti dengan yang lebih baru.

Update BIOS
Karena manfaat yang dita-

warkan oleh BIOS yang lebih
baru, meng-update BIOS menja-
di suatu hal yang menarik untuk
dilakukan. Sayangnya, bila
mengupdate BIOS dilakukan dan
update yang dilakukan tidak de-
ngan sempurna alias tidak
berhasil, bisa jadi komponen
yang bersangkutan tidak lagi
dapat digunakan sebagaimana
mestinya.

Dengan kata lain, meng-
update BIOS ini memiliki risiko
yang tinggi. Di samping itu,
meng-update BIOS ini dahulu ha-
nya dianjurkan dilakukan pada
lingkungan DOS murni yang be-
lum dilengkapi dengan hal lain,
misalnya driver CD-ROM Drive.
Kedua hal ini sering kali
membuat meng-update BIOS ini
tidak dilakukan oleh pengguna
PC, khususnya yang belum
berpengalaman.

Sejalan dengan
semakin tertariknya
pengguna PC ter-
tentu untuk senan-
tiasa menggunakan
BIOS yang terbaru,
para produsen kom-
ponen penyusun PC,
khususnya main-
board, mulai mena-
warkan tingkat ke-
manan yang lebih
baik dalam meng-
update BIOS. Para
produsen ini juga
mulai menawarkan
software untuk
meng-update BIOS
yang dirancang
untuk berjalan pada Windows. Di
samping itu, untuk software yang
masih berjalan di DOS,
peningkatan juga dilakukan.

Peningkatan ini umumnya
berupa menu sehingga pengguna
tidak perlu lagi mengetik
perintah yang panjang dalam

meng-update BIOS. Meskipun
begitu harus diingat semua hal
yang lebih baik ini tidak menjadi
suatu hal yang standar. Oleh
karena itu tidak semua produsen
komponen penyusun PC tadi
menerapkan hal-hal
di atas. Buku ma-
nual yang diberikan
sering kali memberi-
kan informasi yang
memadai untuk me-
ngetahui solusi apa
saja yang tersedia
dalam hal BIOS ini.

Aman dan
Mudah

Seperti telah
disebutkan di atas,
meng-update BIOS
memiliki resiko yang
tinggi. Salah satu
akibat yang bisa
diperoleh bila
update tidak

sempurna/berhasil adalah tidak
bisa digunakannya lagi
komponen yang bersangkutan.

Salah satu kasus yang cukup
umum adalah kasus di mana
mainboard yang di-update BIOS-
nya menolak untuk dinyalakan.
Bila ini terjadi, mainboard
tersebut tidak akan bisa
digunakan sampai BIOS yang
error tersebut diganti dengan
yang baik.

Karena menolak untuk
dinyalakan, BIOS yang baru
tentunya tidak bisa
diprogramkan pada chip yang
bersangkutan menggunakan
mainboard tersebut.

Hal yang umum dilakukan
adalah melepas chip yang
digunakan untuk menyimpan
BIOS tersebut dan
memprogramnya menggunakan
alat lain yang khusus dirancang
untuk itu.

Sering kali hal ini
memerlukan chip lain yang
sejenis dan menyimpan BIOS
yang diinginkan sebagai sumber.
Hal ini membuat proses recovery
ini tidak mudah untuk dilakukan.

Saat ini sebagian produsen
motherboard sudah menawarkan
tingkat keamanan yang lebih

baik untuk
mencegah hal
seperti di atas.
Adapun
pengamanan yang
diberikan seperti
menggunakan dua
buah chip untuk
menyimpan BIOS
ataupun adanya
kemampuan untuk
tetap bisa menyala
dan melakukan
recovery terhadap
BIOS dengan
prosedur tertentu.

Untuk yang
menggunakan dua
buah chip untuk

menyimpan BIOS, bila BIOS pada
chip pertama mengalami
kerusakan, komponen tersebut
akan beralih ke chip kedua yang
masih menyimpan BIOS yang
baik. Bila kedua chip tersebut
menyimpan BIOS yang rusak,
barulah timbul masalah. Selama

chip pertama memiliki BIOS yang
baik, BIOS pada chip kedua tidak
akan digunakan.

Pengamanan seperti ini akan
membuat proses update yang
tidak sempurna/berhasil tidak

akan membuat
komponen
tersebut menjadi
bermasalah
ataupun tidak
dapat digunakan.

Salah satu
produsen yang
paling pertama
menggunakan
solusi seperti ini
adalah Gigabyte.
Sepengetahuan
penulis saat ini
tidak hanya
Gigabyte yang
menggunakan
solusi seperti ini.

Di samping
menggunakan dua

buah chip untuk menyimpan
BIOS, sebagian produsen
memberikan kemampuan pada
produknya untuk tetap bisa
menyala dan melakukan
recovery meskipun terjadi
proses update yang tidak
sempurna/berhasil.

Memang tidak semua
kondisi update yang tidak
sempurna/berhasil akan
membuat suatu komponen
tidak akan menyala, namun
produk yang dimaksud di atas
adalah produk di mana pada
kondisi yang biasanya akan
membuat suatu komponen
tidak menyala, produk tersebut
tetap bisa menyala dan
melakukan recovery. Salah satu
komponen seperti ini akan
memerlukan pengaturan
jumper ke posisi khusus dan
memasukkan floppy disk yang
telah berisi data tertentu pada
floppy disk drive.

Dari segi proses update-nya
sendiri, saat ini sebagian
produsen sudah menawarkan
software untuk melakukan
update BIOS melalui sistem
operasi Windows yang populer,
tidak lagi harus melalui DOS
murni. Dengan sistem operasi
Windows terbaru yang saat ini
tidak memberikan lagi pilihan
untuk masuk ke dalam DOS
murni, tawaran seperti ini juga
mengurangi kerepotan yang
harus dilakukan dalam meng-
update BIOS.

Di samping itu, biasanya
dahulu perintah yang harus

diberikan juga lumayan
panjang untuk melakukan
update BIOS melalui DOS murni.

Dengan software yang
berjalan pada Windows, tinggal
dijalankan saja proses updating
tersebut.

Seandainya terdapat opsi
yang harus dipilih, biasanya
juga menu yang tersedia mudah
untuk digunakan. Bagi yang
melakukan update BIOS dari
DOS murni, software yang
diberikan produsen saat ini juga
sering kali tidak lagi
memerlukan perintah yang
panjang. Tidak jarang telah
dilengkapi dengan menu yang
mudah juga.

Dengan berbagai
peningkatan yang telah
diberikan oleh beberapa
produsen dalam meng-update
BIOS ini, update BIOS untuk
produk tertentu tidak lagi me-
nyeramkan seperti dahulu. PC+

Pada chip ini BIOS disimpan

Dual BIOS. BIOS kedua merupakan “pemain cadangan” bila
pemain utama cedera alias rusak. Selama pemain utama sehat,
BIOS kedua menganggur.

BIOS tidak hanya digunakan oleh mainboard. Sebagian besar
komponen pada PC memanfaatkan fungsi BIOS ini.

Untuk produk tertentu, update BIOS sudah bisa
dilakukan melalui Windows
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Implementasi
Koneksi ke MySQL

( bagian 2 - habis )

Yahya Kurniawan
yahya@e-pcplus.com

P

Minggu lalu Anda
telah belajar

menerapkan koneksi
PHP ke MySQL dan

menampilkan data-
data yang diambil ke

browser. Nah,
sekarang kita akan

belajar sesuatu yang
lebih "advanced".

ada
pembahasan
yang diberikan
minggu lalu, contoh-
contoh skrip yang

diberikan masih "polos", tidak
ada perangkap kesalahan sama
sekali.

Padahal perangkap
kesalahan ini merupakan hal
yang sangat vital karena
koneksi ke MySQL ini cukup
rentan terhadap kesalahan.
Tentu saja hal ini masuk akal
karena melibatkan dua
software (yaitu PHP dan MySQL)
yang melakukan kerjasama.
Dalam hubungan antar dua
orang manusia pun seringkali
terjadi kesalahpahaman bukan?

Untuk itu kali ini kita akan
memoles contoh-contoh yang
diberikan minggu lalu dengan
menambahkan perangkap
kesalahan agar jika terjadi
kesalahan kita tahu bagaimana
untuk memperbaikinya.

Perangkap kesalahan yang
akan digunakan adalah
operator kontrol error. Sintaks
penggunaan operator kontrol
error ini adalah dengan
menambahkan karakter at (@)
di depan suatu fungsi kemudian
diikuti dengan pernyataan "or
die(pesan)".

Berikut adalah contohnya
penggunaan operator kontrol
error tersebut.

<HTML>
<HEAD>
<TITLE>Kontrol Error </TITLE>
</HEAD>

<BODY>
<?
$x = M_PI;
?>

y adalah akar dari x <BR>
jika x = <?=$x?> maka y =

<?
$pesan = "Ada yang salah
pada operasi ini";
$y = @sqrt($x) or

die($pesan);
echo $y;
?>
</BODY>
</HTML>

Jika skrip tersebut
dijalankan, maka browser akan
memberikan hasil sebagai
berikut:

y adalah akar dari x
jika x = 3.1415926535898
maka y = 1.7724538509055

Sekarang sengaja kita buat
suatu kesalahan, misalnya M_PI

ditulis dengan MPI, maka
browser akan memberikan hasil
sebagai berikut:

y adalah akar dari x
jika x = MPI maka y = "Ada
yang salah pada operasi ini"

Kini kita terapkan operator
kontrol error tersebut pada
contoh skrip minggu lalu.

<HTML>
<HEAD>
<TITLE>Database </TITLE>
</HEAD>

<BODY>
<?
$host = “localhost”;
$user = “root”;
$pwd = “rahasia”;
$db = “pcplus”;
$sql = “select * from table1”;
$conn =
@mysql_connect($host,$user,$pwd)
or

die("Koneksi gagal");
mysql_select_db($db);
$qry = mysql_query($sql) or

die("Query salah");

?>
<TABLE BORDER>
<TR>

<TD BGCOLOR=#f32142>
Nama </TD>
<TD BGCOLOR=#f32142>
Alamat </TD>
<TD BGCOLOR=#f32142>
Telpon </TD>
<TD BGCOLOR=#f32142>
Email </TD>
<TD BGCOLOR=#f32142>
Tanggal Lahir </TD>

</TR>
<?
while ($row =
mysql_fetch_array($qry)) {
?>

<TR>
<TD BGCOLOR=#f7efde>
<?=$row['nama']?> </TD>
<TD BGCOLOR=#f7efde>
<?=$row['alamat']?> </TD>
<TD BGCOLOR=#f7efde>
<?=$row['telpon']?> </TD>
<TD BGCOLOR=#f7efde>
<?=$row['email']?> </TD>
<TD BGCOLOR=#f7efde>
<?=$row['tgllhr']?> </TD>

</TR>
<?
}
?>

</TABLE>
</BODY>
</HTML>

Setelah skrip ini kita perba-
harui seperti di atas, maka jika
terdapat kesalahan, browser
akan memberikan pesan kesala-
han. Jika koneksi gagal, maka
akan muncul pesan "Koneksi

gagal" dan jika pernyataan SQL
yang salah maka akan muncul
pesan "Query salah".

Namun kadang-kadang pesan
seperti ini masih belum cukup.
Jika koneksi gagal, apa penyebab
kegagalannya? Jika query salah, di
mana letak kesalahannya?

PHP menyediakan suatu
fungsi lagi bernama mysql_error().
Fungsi ini akan menghasilkan
suatu teks yang berisi kesalahan
yang terjadi.

Dengan demikian pesan
kesalahan akan menjadi lebih jelas
dan kesalahan jadi lebih mudah
untuk diperbaiki. Kita revisi lagi
contoh skrip di atas menjadi
sebagai berikut:

<HTML>
<HEAD>
<TITLE>Database </TITLE>

<BODY>
<?
$host = "localhost";
$user = "root";
$pwd = "";
$db = "pcplus";
$sql = "select * from table1";
$conn = @mysql_connect
($host,$user,$pwd) or

die("Terdapat
kesalahan, yaitu: " .
mysql_error());
@mysql_select_db($db) or

die("Terdapat
kesalahan, yaitu: " .
mysql_error());

$qry = @mysql_query($sql) or
die("Terdapat

kesalahan, yaitu: " .
mysql_error());
?>
<TABLE BORDER>
<TR>

<TD BGCOLOR=#f32142>
Nama </TD>
<TD BGCOLOR=#f32142>
Alamat </TD>
<TD BGCOLOR=#f32142>
Telpon </TD>
<TD BGCOLOR=#f32142>
Email </TD>
<TD BGCOLOR=#f32142>
Tanggal Lahir </TD>

</TR>
<?
while ($row =
mysql_fetch_array($qry)) {
?>
<TR>

<TD BGCOLOR=#f7efde>
<?=$row['nama']?> </TD>
<TD BGCOLOR=#f7efde>
<?=$row['alamat']?> </TD>
<TD BGCOLOR=#f7efde>
<?=$row['telpon']?> </TD>
<TD BGCOLOR=#f7efde>
<?=$row['email']?> </TD>
<TD BGCOLOR=#f7efde>
<?=$row['tgllhr']?> </TD>

</TR>

<?
}
?>

</TABLE>

</BODY>
</HTML>

Nah, sekarang pesan
kesalahan mejadi lebih jelas.
Sekarang kita sengaja buat
kesalahan pada skrip tersebut.
Misalnya baris yang bertuliskan
$db = "pcplus"; kita ganti
menjadi $db = "pcpluss"; (ada
dua huruf s). Peringatan yang
muncul pada browser adalah:

Terdapat kesalahan,
yaitu: Unknown database
'pcpluss'

Dengan demikian kita lang-
sung tahu bahwa yang salah
adalah penulisan nama data-
base yang seharusnya “pcplus”
tetapi ditulis “pcpluss”.Kita
coba lagi dengan kesalahan
lain. Misalnya pernyataan SQL
diganti dari "select * from
table1" menjadi "select *
from tabel1" (table1 diganti
tabel1). Browser akan memberi-
kan pesan sebagai berikut:

Terdapat kesalahan,
yaitu: Table 'pcplus.tabel1'
doesn't exist

Dengan demikian kita lang-
sung tahu bahwa yang salah na-
ma tabel yang dipilih, sehingga
kesalahan lebih mudah dilacak.

Minggu depan PCplus akan
memberikan contoh-contoh
aplikasi database dengan PHP
dan MySQL. PC+

Bagi Anda yang suka
memutar MP3 lewat Winamp,
pada Title Bar Winamp Anda
pasti terdapat kata Winamp.
Sebenarnya tulisan itu dapat
berganti menjadi It’s Really
Whips The Llama’s Ass..
Tetapi trik ini hanya untuk
Winamp seri 2.x. Untuk itu
yang perlu dilakukan adalah
buka Winamp Anda dan pilih
Base Skin untuk skin Winamp
Anda. Ketikkan nullsoft, setiap
selesai mengetik karakter l
tekan tombol Esc sebelum
menekan huruf selanjutnya.
Jadi urutannya adalah n – u – 1
– Esc – 1 – Esc – s – o – f – t.
Setelah itu tulisan Winamp
pada Title Bar Winamp Anda
akan berganti tulisan menjadi
It’s Really Whips The Llama’s
Ass.. Trik ini sebenarnya juga
bisa diterapkan pada skin lain
yang Anda miliki, namun tidak
semuanya trik ini dapat diterap-
kan. Ingat kalau trik ini bisa

diterapkan pada skin lain, ke-
mungkinan tulisan Winamp pa-
da Title Bar Anda akan ber-
ganti menjadi tulisan lain dan

bukan It’s Really Whips The
Llama’s Ass..

Fadlan Setiaji

aji-edl@plasa.com

Mengganti Nama
Title Bar Winamp
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Mega Workshop
Jilid 2 Digelar

Agustus

Sesuai janji PCplus
kepada para peserta

yang tidak bisa
mengikuti Mega

Workshop pertama
yang diadakan Juni

lalu, PCplus kembali
menggelar Mega

Workshop Jilid 2 di
tempat yang sama,

yaitu di Hi-Tech Mall
Jl. Kusuma Bangsa

Surabaya. Memetik
pelajaran dan berkat

saran-saran peserta
dari mega workshop

yang pertama,
PCplus akan

meningkatkan
kualitas

penyelenggaraan
yang kedua.

ega Work-
shop II akan
diselenggarakan pada
tanggal 28-30 Agustus

mendatang, sekaligus juga untuk
merayakan hari kemerdekaan RI
yang ke-58. “Saat ini kami sedang
mengupayakan doorprize yang

menarik, selain kaos yang kami
bagikan untuk peserta,” ujar
Jimmy Rambing, bagian promosi
PCplus.

Bagi yang terlambat
mendaftar pada Mega Workshop
pertama, segeralah mendaftar!
Jangan sampai kehabisan tempat

seperti yang Anda alami pada
workshop yang lalu. Prosedur
pendaftaran tetap seperti dulu,
cukup menggunting formulir
pendaftaran yang mulai dimuat
pada PCplus edisi minggu depan
(135), lalu serahkan formulir
tersebut ke Mualim/Irwan di

Jalan Raya Gubeng 98
Surabaya, telp. 031-5049492
atau ke Mbak Ririn di Hi-Tech
Mall, PT Sasana Boga Parkir
Mobil Lt. I Jl. Kusuma Bangsa
116-118 Surabaya, telp. 031-
5316557. Segera mendaftar,
karena tempat terbatas! (din)

M

Lomba Merakit PC
Bagi peserta Mega Workshop yang pertama atau bagi Anda yang telah mahir merakit

PC, daftarkan diri Anda dalam Lomba Merakit PC dan Lomba Troubleshooting PC yang
diadakan pada tanggal 12-13 Juli mendatang, bersamaan dengan diselenggarakannya
Festival Komputer Indonesia ke-5 di World Trade Center, Surabaya. Hadiah yang
disediakan sangat menarik, antara lain pocket PC, scanner, printer, dan lain-lain. Selain
lomba tesebut, juga diadakan lomba untuk anak-anak.

Kalau Anda berminat hubungi saja kantor perwakilan PCplus di Surabaya, Jl. Raya
Gubeng 98 telp. 5049492 dengan Irwan/Mualim. Anda bisa mendaftar di sana atau
langsung pada saat pelaksanaan, tapi pastikan Anda tidak keliru jadwal!

Workshop Instalasi PC
Berdasarkan hasil survei pada Mega Workshop bulan Juni lalu, banyak peserta yang

berharap lebih mendalami persoalan tentang instalasi software PC. Menurut Dino,
Marketing Communication PCplus Jawa Timur, Microsoft Surabaya sudah menyatakan
kesediaannya untuk mendukung acara ini. “Untuk format workshop-nya sudah kami
rancang, hanya saja kami masih mengatur waktu dan tempatnya agar bisa harmonis
dengan jadwal kegiatan PCplus yang lain di Jawa Timur,” ujar Dino.

Dalam workshop ini akan dijelaskan secara tuntas mengenai instalasi software sistem
operasi, permasalahan umum, dan instalasi driver peralatan lain. “Dengan mengikuti
worskhop ini, pengguna komputer awam jadi tidak sekedar memakai saja, tapi juga
mampu untuk memperbaiki sendiri Windowsnya jika ada masalah. Kalau Windowsnya
hang, atau jika ada aplikasi yang hilang, peserta jadi tidak panik, karena tahu
masalahnya,” ujar Dino.

Workshop Audio Video Editing
Majalah InfoKomputer bekerja sama dengan SAM Design dan Tabloid PCplus

mengadakan workshop “audio-video editing” pada tanggal 28-30 Juli mendatang di
Hotel Santika Surabaya. Menurut Alexander yang akrab dipanggil Andre, bagian promosi
Majalah InfoKomputer, dalam workshop ini peserta akan mendapatkan ilmu yang
lengkap mengenai masalah dalam audio-video editing, “Mulai dari proses transfer dari
handycam atau kamera ke komputer, sampai dengan pembuatan VCD,” ujar Andre.

Masih menurut Andre, “Dalam workshop ini peserta tidak hanya mendapatkan teori
saja, tapi langsung praktek. Tiap peserta akan menghadapi satu unit komputer dan
langsung mempraktekkan apa-apa yang diajarkan. Worskhop dimulai jam 08.30 dan
berlangsung selama 10 jam sampai dengan jam 18.00. Beaya pendaftaran hanya Rp.
300.000,- termasuk makan siang dan coffee break.”

Overclock
Bersamaan dengan diselenggarakannya SCOMDEX tahun ini, PCplus bersama

APKOMINDO Jatim juga sedang dalam tahap pembicaraan serius untuk mengadakan
lomba overclock nasional. Menurut Chandra Prayogo, Sekjen APKOMINDO Jatim,
pihaknya memang berencana untuk memeriahkan SCOMDEX tahun ini dengan kegiatan-
kegiatan yang sangat bermanfaat untuk masyarakat.

“Untuk kegiatan-kegiatan tersebut kami bekerja sama dengan PCplus. Acara yang
akan diadakan sudah dalam taraf pembicaraan serius, antara lain roadshow workshop
dan seminar merakit PC ke kampus dan lomba overclock tingkat nasional,” ujar Chandra.
Berbeda dengan tahun-tahun sebelumnya, SCOMDEX tahun ini kemungkinan besar akan
diadakan di AJBS Jl. Ratna (eks pabrik bir Bintang). (din)

Foto-foto: dok.PCplus
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS

MOTHERBOARD

VIA P4PB-Ultra+RAID P4X400,
ATX, FSB533, DDR333/400, RAID 103
VIA P4PB400-L  P4X400, ATX,
FSB533, DDR333/400 68
VIA P4PB266EN, P4X266, ATX,
FSB 533, 3 DDR 68
VIA P4MA-Pro, Via P4M266,
M-ATX, FSB 400, VGA, LAN 52

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 110
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 137
Asus P4PE/L , i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 110
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 247
Asus P4T533-C, i850E, FSB 533,
ATA100, 4RDRAM 168
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 84
Asus P4B533-E/L, i845E, FSB533,
ATA133, 3DDR, RAID, LAN, audio 158
Asus P4B533-E, i845E, FSB533,
ATA133, 3DDR, RAID, Audio 137
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 90
Asus P4B533-V, i845G, FSB533,
ATA100, 3DDR, audio, VGA onboard 124
Asus P4S8X/L 1394, SiS648, FSB533,
3DDR, AGP8x, audio, Serial ATA, 1394 138
Asus P4S8X/L , Sis648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 113
Asus P4S133, SiS645, FSB400,
3SDR PC-2700, ATA100, audio 62
Asus P4S533-X, SiS645dx, FSB533,
2DDR, audio, VGA onboard 73
Asus A7V8X/L 1394, KT400,
ATA133, AGP8x, FSB266, 3DDR,
audio, LAN, 1394 131
Asus A7S333, SiS745, ATA100,
5 PCI, 4 USB 1.1 79
Asus A7N266-C, nVidia415D,
3DDR, ATA100, 5PCI, 4USB 1.1 113
Asus A7N8X Deluxe/GD, NForce2, A
TA133, 5 PCI, 3DDR, audio dolby,
AGP8x 173
Asus A7N8X Deluxe, NForce2,
ATA133, 5 PCI, 3DDR, audio dolby,
AGP8x 168
Asus A7N8X, NForce2, ATA133,
5PCI, 3DDR, Codec, LAN, 1394 137
Asus A7V266VM, VIA KT266A,
ATA100, 3PCI, 3DDR 70

APLUS AP973, i845G, FSB 533MHz,
2DDR, Intel Graphic, ATX, AC97 76
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 77
APLUS AP978 Ii845GL, ATX, 400FSB,
SOUND AC97, 2 SDRAM 54
APLUS AP971A+ VIA P4M266,
ATX, 400FSB, SOUND AC97,
2 SDRAM, S3 Savage4 4XAGP 50
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 50
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A2 VIA P4M266A,
ATX, 533FSB, SOUND AC97, 2DDR 53
APLUS AP971A VIA  P4M266A,
M.ATX, 533FSB, SOUND AC97,
2SDRAM 50
APLUS AP982 VIA KT400, ATX,

266FSB, SOUND AC97, 3DDR 65
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 645Combo, SiS 645, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 6PCI 66
MSI 645E MAX-U, SiS645DX, ATX,
FSB533, 3DIMM, ATA133, AGP4X, 6PCI 73
MSI 651M COMBO-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 76
MSI 648 MAX, SiS 648x, ATX,
FSB533, 3DIMM, ATA133, AGP8X, 6PCI 88
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA,
AGP8X 160
MSI 655 MAX LS, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA,
AGP8X 110
MSI 645GLM, I845gl, Matx, FSB400,
2DIMM, ATA100, AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 96
MSI 865PE Neo2, I865pe, ATX,
FSB800, 2GBDDR, ATA133, AGP8X,
5PCI 130
MSI 845PE Max2-FISR, i845PE,ATX,
FSB533, 2GBDDR, ATA133, AGP4X 163
MSI K7N2-L, nForce2, ATX, FSB400,
3GB DDR, ATA133, AGP8X, 5PCI 115
K7N2G-L, nForce2, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 5 PCI 130
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 85
KT4V Ultra FISR, Via KT400, ATX,
FSB333, 3GBDDRR, ATA133, SATA 158

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 77
Gigabyte GA-7VA, VIA KT400, ATX,
Soket A, ATA133 89
Gigabyte GA-7N400-L1, nForce2 ultra,
ATX, Soket A, ATA133, Raid, Firewire 112
Gigabyte GA-7N400 Pro, nForce2 ultra,
ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2
Ultra, FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-8SG800,  SiS 648,
ATX, FSB800, ATA133, AGP8X, 5PCI 82
Gigabyte GA-8ST800, SiS 645DX,
ATX, FSB800, ATA133 73
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 187
Gigabyte GA-8IE800, i845E,ATX,
FSB533, ATA100 87
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 132
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 107
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 242

Jetway J-603TCF, VIA PLE33,
soket 370, M-ATX, FSB100, ATA100 52
Jetway J-P4XFBU, VIA P4X266E,
soket 478, ATX, FSB533, ATA133 62
Jetwat J-615TCS, i845E, soket 370,
M-ATX, FSB133, ATA133 56
Jetway J-615TCF, I845e, M-ATX,
soket 370, FSB133, ATA133 81
Jetway J-830CH, SiS730SE, ATX,
soket 462, FSB266, ATA100 63
Jetway J-P4MDPT, VIA P4M266A,
M-ATX, soket 478, FSB533, ATA133 64
Jetway J-S446, SiS645/961, ATX,
soket 478, FSB400, ATA100 66
Jetway J-845EPRO+ RAID, i845E,
ATX, soket 478, FSB400/533, ATA133 90
Jetway J-845GLM, i845GL, M-ATX,
soket 478, FSB/400, ATA100 67

Fujitsu-Siemens D-1627A, i845PE,
ATX, FSB800, 4DDR, 5PCI, ATA100,
RAID 175
Fujitsu-Siemens D1561A, I865G,
M-ATX, FSB800, 4DDR, 3PCI,
ATA100, LAN 155
Fujitsu-Siemens D1562A, I865g,
M-ATX, FSB800, 4DDR, 3PCI,
ATA100, LAN 167
Fujitsu-Siemens D1520, I845GE,
M-ATX, FSB533, 2DDR, 3PCI,
ATA100, LAN 121
Fujitsu-Siemens D1522A, i845GE,
M-ATX, FSB533, 2DDR, 3PCI,
ATA100, LAN 145
Fujitsu-Siemens D1495-A, SIS645DX,
M-ATX, FSB533, 3DDR, 5PCI,

ATA133, LAN 91
Fujitsu-Siemens D1555, SIS648, ATX,
FSB533, 3DDR, 5PCI, ATA133. LAN 112

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 80
Iwill P4E, i845PE, soket 478,
FSB 400/533, DDR, Audio,
F1 series, ATA133 & 100 76
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing, SCSI 999
Iwill mP4G2, i845GV, FSB 533MHz,
2DDR, VGA onboard, LAN 68

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D,
DDR266, RAID, 6ch audio, AGP PRO,
6 PCI 120
Soyo P4S Dragon Ultra,
Sis645A2+961, RAID, 6ch audio,
AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7  i875P, FSB800MHz, 4 DDR,
AGP 8X, 5 PCI 145
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BE7-G, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 127
Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 112
Abit BG7, i845G, FSB 533MHz,
3DDR, AGP 4X, 5 PCI 126
Abit BG7E, i845GE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 100
Abit TH7 II RAID, i850, FSB 400MHz,
4 RIMM, AGP 4X, 5 PCI 149
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 95
Abit SD7-533, SiS 645, FSB 400MHz,
3 DDR, AGP 4X, 5 PCI 95
Abit SA7, SiS 645DX, FSB 533MHz,
3 DDR, AGP 4X,  5 PCI 75
Abit AT7 Max, Via KT333,
FSB 266MHz, 2 DDR, AGP 4x, 3 PCI 150
Abit AT7 Max II, Via KT400,
FSB 266MHz, 2 DDR, AGP 8X,  5PCI 181
Abit KD7, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 87
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 97
Abit NF7-M, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 123

MEMORI

Nexus SDRAM PC-133 64MB 17
Nexus SDRAM PC-133 128MB 22
Nexus SDRAM PC-133 256MB 34
Nexus DDR PC-2100 128MB 19
Nexus DDR PC-2100 256MB 35
Nexus DDR PC-2100 512MB 55
Nexus DDR PC-2700 256MB 36
Nexus DDR PC-2700 512MB 69

Visipro 128MB (4 IC) PC 133 23
Visipro 128MB (8 IC) PC 133 38
Visipro 256MB (8 IC) PC-133 40
Visipro 256MB (16 IC) PC-133 67
Visipro 512MB PC-133 75
Visipro 128MB (4 IC) PC-2100 23
Visipro 128MB (8 IC) PC-2100 Call
Visipro 256MB (8 IC) PC2100 40
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 79
Visipro 128MB (4 IC) PC-2700 24
Visipro 128MB (8 IC) PC-2700 25

Visipro 256MB (8 IC) PC2700 42
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 82
Visipro 256MB PC3200 (8IC) 52
Visipro 512MB PC3200 Call
Visipro 64MB PC800 36
Visipro 128MB PC800 (4IC) 52
Visipro 256MB PC800 (8IC) 105

V-Gen SDRAM PC-133 (8IC) 64MB 16
V-Gen SDRAM PC-133 (4IC) 128MB 20
V-Gen SDRAM PC-133 (8IC) 128MB 28
V-Gen SDRAM PC-133 (8IC) 256MB 36
V-Gen SDRAM PC-133 (16IC) 256MB 61
V-Gen SDRAM PC-133 (16IC) 512MB 70
V-Gen DDR PC-2100 (8IC) 128MB 20
V-Gen DDR PC-2100 (8IC) 256MB 38
V-Gen DDR PC-2700 (8IC) 256MB 40
V-Gen DDR PC-2100 (16IC) 512MB 74
V-Gen DDR PC-2700 (16IC) 512MB 76
V-Gen DDR PC-3200 (8IC) 256MB 51
V-Gen DDR PC-3200 (16IC) 512MB 98
V-Gen RDRAM PC-800 64MB Call
V-Gen RDRAM PC-800 128MB 50
V-Gen RDRAM PC-800 256MB Call

Kingston SDRAM PC-133 128MB 20
Kingston SDRAM PC-133 256MB 33
Kingston SDRAM PC-133 512MB 64
Kingston DDR PC-2100 128MB 17
Kingston DDR PC-2100 256MB 32
Kingston DDR PC-2100 512MB 61
Kingston DDR PC-2700 256MB 32
Kingston DDR PC-3200 256MB 38
Kingston DDR PC-3200 512MB 74
Kingston RDRAM PC-800 128MB Call
Kingston RDRAM PC-800 256MB 106
Kingston RDRAM PC-800 512MB 246
Kingston RDRAM PC-1066 128MB 75
Kingston RDRAM PC-1066 256MB 111

NCPRO 128MB DDR PC-3200 20.5
NCPRO 256MB DDR PC-3200 46.5
NCPRO 256MB DDR PC-2700 34
NCPRO 512MB DDR PC-2700 73
NCPRO 128MB DDR PC-2100 18
NCPRO 256MB DDR PC-2100 33

COMPACT FLASH

NCPRO Flash memory 32MB 16
NCPRO Flash memory 64MB 17.5
NCPRO Flash memory 128MB 29
NCPRO Flash memory 256MB 58

Visipro Flash Memory 64MB 24
Visipro Flash Memory 128MB 35
Visipro Flash Memory 256MB 63

Visipro Flash Memory 512MB 125

Kodak CompactFlash 32MB 25
Kodak CompactFlash 64MB 38
Kodak CompactFlash 96MB 45
Kodak CompactFlash 128MB 65
Kodak CompactFlash 256MB 120

Kingstone Compact Flash
64MB 23
Kingstone Compact Flash
128MB 33
Kingstone Compact Flash 256MB 57

SMART MEDIA CARD

NCPRO Flash Memory 32MB 12
NCPRO Flash Memory 64MB 19.5
NCPRO Flash Memory 128MB 27.5

Kingston Flash Memory 64MB 25
Kingston Flash Memory 128MB 39

USB FLASH MEMORI/MP3/
PEN DRIVE

Prolink USB Pen Drive,
MP3 64MB 89
Prolink USB Pen Drive,
MP3 128MB 120
Prolink USB Pen Drive,
MP3 256MB 175

NCPRO pen drive 32MB 18
NCPRO pen drive 64MB 25.5
NCPRO pen drive 128MB 41
NCPRO pen drive 512MB 100

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound, 128MB, multi MP3,
voice recording, display 115
MagicStar 128 Turbo, USB 2.0,
128MB 70

MULTIMEDIA CARD

Kodak MMC 32MB 30
Kodak MMC 64MB 44
Kodak MMC 128MB 74

Kingstone MMC 64MB 28
Kingstone MMC 128MB 46
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KURSUS

DIKLAT KOMPUTER BERSERTIFIKAT  Rp.100.000,-
1.Teknisi Komputer+M.Board+Hardisk+Copy Bios
2. Design Grafis  3. Teknisi Monitor + TV
4. Network LAN + Admin Server + PC Kloning
Gratis : CD-Modul-Sertifikat-Drink-Konsultasi

NETWORK LAN - PC KLONING TANPA HARDISK
Komp lama bisa secepat P.4 - RAM 8 jadi 64
BELAJAR JARAK JAUH BISA - BERGARANSI
EXSYSCOM: 021.78889003 - 0815.997.1234
Jl.Raya Depok -depan UI - Blk Halte-Jakarta 12640

IZZAH COM KURSUS “PAKET HEMAT” Merakit
PC 75Rb, LAN (W 2000 Server) 75Rb, Web Design
150Rb, Photoshop 85Rb,  MS Office 85Rb, Pwr Point
75Rb, Praktis, cpt, Certificate. Jl. Rawamangun
Timur/78 Ph.47867273 http://izzahcomp.tripod.com

IT COURSE ASY-SYIFA
Belajar 5 hr/pkt.Teknisi:1.komp+mobo+copybios 60rb
2.Monitor 60rb.software:3.SPSS V.11 95rb 4.Visual
Basic 60rb. Sabtu Ahad:LAN+PC.Cloning+networking
60 rb. Terima Privat, olah & analisa data
SPSS.sertifikat.Jl.Akses UI 59 Kelapa Dua dekat
Kamp.E Gunadarma Depok.021-9202459

HARDWARE

Cy SERVICE CENTER
Pusat Elektronik Harco Mangga II Blok A2 no. 132

Telp: (021) 6126466/6125710
TERIMA SERVICE : MONITOR, NOTEBOOK,
POWER SUPPLY BRANDED (IBM,etc) CD-ROM,
CD-RW, DVD-ROM....SEMUA TYPE/MERK.
NOTE: Bergaransi selama 30 hari untuk sparepart yang
sama & jasa service, Dapat ditunggu & harga OK (dlm
waktu +/- 30 menit), Antar jemput barang dikenakan
tambahan biaya transport Rp. 25.000 WIL: Jakarta

Exsis Komputer Telp:7971432 - 7944889
Melayani servis panggilan :CPU, Monitor, Printer,
Motherboard,Install Software, Pasang Jaringan,
Internet, Upgrade, jual-beli cepat murah dan
bergaransi (minggu/libur tetap buka)

LAIN - LAIN

Belajar Sendiri bikin Web Database (PHP) via CD.
Instalasi Server instan,tutorial lengkap untuk
pemula-mahir,ratusan script siap pakai.Tersedia
pula ratusan web template siap pakai.Visit
www.earthweb.biz atau hub: harris (0811-831-835)

IKLAN BARIS

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor Call
Maxtor 6E030L 30GB 7200rpm
ATA133, 2MB Cache, dual processor 60
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 68
Maxtor 6Y060L 60GB 7200rpm
ATA133, 8MB Cache, dual processor 87
Maxtor 6Y080L 80GB 7200rpm
ATA133, 8mb cache, dual processor 96
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 134
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 205
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 300

Seagate Ux/Cuda 5400.1 20GB
ATA 100 53
Seagate Ux/Cuda 5400.1 40GB
ATA 100 57.9
Seagate Barracuda ATA IV /V
20GB 7200RPM ATA100 53.8
Seagate Barracuda 7200.7 40GB
ATA100 63.1
Seagate Barracuda 7200.7 80GB
ATA100 83.2
Seagate Barracuda 7200.7 120GB
ATA V/100 120
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 186.1
Seagate Barracuda SATA 80GB,
ATA100 130.3
Seagate Barracuda SATA 120GB,
ATA100 153.1

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 54
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 57
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 63
Maxtor 4R060J/4D060H,

60GB 5400rpm, ATA-133, 2MB cache 84
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 92
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache 146
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 200
Maxtor DiamondMax Plus
serial ATA 6Y080MO, 80GB
7200RPM, 8MB 145
Maxtor DiamondMax Plus
serial ATA 6Y120MO,
120GB 7200RPM, 8MB 185

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB
5400rpm 56
Samsung HDD 40GB
5400rpm 70

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB ORCA,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 165
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 205
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 500
IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB,
68/80pin, 7200rpm, SCSI160,
4MB cache 85
IBM IC35L009, 9GB, 68pin,

10Krpm, SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 95

Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah 10Krpm,
36,7GB U320, 36ES, 63,2ms, 4MB 190
Seagate Cheetah 10Krpm, 73GB,
U320, 36ES, 63,2ms, 4MB 530
Seagate Cheetah 15Krpm 18,4GB,
U160, x 3,9ms, 8MB cache 219
Seagate Cheetah 15Krpm 36,7GB,
U320, x 3,9ms, 8MB cache 397

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

VIA EZRA 1Ghz C3 EZRA 1GHz
(Tualatin) + Heatsink 39
VIA SAMUEL550Mhz C3 Samuel
550MHz + Heatsink 12

Athlon Xp 1700+ (Thoroughbred) 51
Athlon Xp 1800+ (Thoroughbred) 55
Athlon XP 1900+ (Palomino) 54
Athlon Xp 2000+ (Thoroughbred) 57
Athlon Xp 2100+ (Thoroughbred) 61
Athlon XP 2200+ ((Thoroughbred) 68
AthlonXP 2400+ fan (Thoroughbred) 80
AthlonXP 2600+ fan (Thoroughred) 93
AthlonXP 2600+ (FSB333) + fan 109
AthlonXP 2800+ (Barton FSB333) 111

AthlonXP 3000+ (Barton FSB333) 270

Intel Pentium-4 1,6GHz
(non memory)-423 126
Intel Pentium-4 1,8GHz,
tray (non memory), 478 call
Intel Pentium-4 3,06GHz,
box (non memory), 478 438
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 call
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 call
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,53GHz,
512KB cache L2, FSB 533, 478 call
Intel Pentium-4 2,66GHz
(non memory, 512) FSB 533 211
Intel Pentium-4 2,8GHz
(non memory, 512) FSB 533 380
Intel Pentium-4 3,06GHz,
512MB, FSB533, 478 Call
Intel Pentium-4 2,4CGHz,
512KB, FSB800, 478 Call
Intel Pentium-4 3.0GHz,
512KB, FSB800, 478 Call
Intel Celeron 1,7GHz, c/128 64
Intel Celeron 1,8GHz, c/128 73
Intel Xeon Pentium-4 1,4GHz,
c/512, MPGA 1258
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194
Intel Xeon Pentium-4 2,0AGHz,
512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
Intel Xeon 1000, 256KB cache L2,
133MHz 467

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

VGA CARD

Asus V9280 SuperFast 128MB 247
Asus V9180 Magic/T 64MB MX440-8X 84
Asus V9900, GeForceFX 5800,
AGP 8x, 128MB DDR 378
Asus V9520 Magic/T GeForceFX 5200,
128MB, AGP8X 95
Asus V8170DDR/T,
GeForce 4 MX 440SE, 64MB DDR 68
Asus V8170 Magic/T,
GeForce 4 MX 420, 64MB DDR 63
Asus V7100 Pro 64, GeForce 2 MX 400 45
Asus V7100 Combo,
GeForce 2 MX 400, 32MB 147
Asus V9280 SuperFast, GEForce4,
AGP 8X 128MB 278
Asus V9180 Magic/T,
GeForce4 MX440-8X, 64MB 89

Abit GF3 Ti 200, 64MB DDR 115
Abit GF2 T400, AGP 4X,
64MB SDRAM, TV-out, 59
Abit GF2 MX400, AGP 4X,
64MB SDRAM 54
Abit GF2 T200, AGP4X,
32MB SDRAM, TV-out 51
Abit GF2 MX200, AGP 4X,
32MB SDRAM 44

PixelView GF4 Ti4200-8x, GPU
250MHz, RAM Clock 500MHz, 128MB
DDR,TV-out & Video In, DVI Port 160
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KUIS Denger-denger sekarang chip
grafis keluaran terakhir dari SiS sudah
masuk ke pasaran Indonesia. "Beli ah",

pikir si Ciplus. "Biasanya harganya kan gak mahal-mahal amat", pikirnya lagi. "Tapi apa namanya ya?
Nanti aku salah beli", ucapnya dalam hati. Tolong dong si Ciplus sebutkan chip kartu grafis
terbaru dari SiS yang sudah masuk ke Indonesia. Tuliskan jawaban tersebut di sehelai kartu pos
dengan mencantumkan alamat yang jelas dan sudah dibubuhi Kupon Kuis asli (di pojok kanan).
Jangan menunda-nunda, karena jawaban sudah harus masuk ke meja Redaksi PCplus paling lambat
tanggal 04 Agustus 2003. PCplus akan memberikan 3 buah Speaker bagi 3 pemenang utama
& 2 buah Jaket bagi 2 pemenang hiburan dari Sonic Gear bagi yang menjawab dengan benar
dan beruntung! Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini

Jawaban Kuis No. 130/III/2002: Windows Server 2003

Pemenang Kuis Edisi 130/III/2002:
HADIAH SOUVENIR PCplus

1. Priyanto
Jl. Teratai Gg. Waru No. 191 Pemalang
Jawa Tengah 52311

2. Jamil
Jl. Temalate 3 STP 32 No.10
Perumnas Panak Kukang - Makassar 90222

3. Anrie S.
Jl. Palem Kuning No.120 Palem Semi
Karawaci - Tangerang 15810

4. Bambang W.
Pedurungan Tengah II/9
Semarang 50192

5. Yoshida Hendryko
Jl. Musik Raya Blok E No.2 BCS
Kelapa Gading - Jakarta 14250
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Nama             :

No. KTP/SIM :

Alamat           :

Telepon          :

E-mail            :

Bromo Room, Hotel Santika -
Jl. Pandegiling 45 Raya Darmo, Surabaya

Materi:
• Pengenalan proses capture
• Pengenalan software video editing
• Pengenalan software audio editing
• Praktek video editing
• Praktek audio editing
• Membuat VCD sendiri.

Peserta mendapatkan:
- 1 set makalah workshop,
- 1 buah sertifikat,
- 3 bulan berlangganan majalah
  InfoKomputer (Agustus, September
  dan Oktober 2003),
- 1 buah kaos InfoKomputer,
- 1x makan siang & 1x snack,
- 1 buah CD-R kosong untuk VCD
   hasil karya workshop.

Membuat Anda Semakin Pintar

28 - 30 Juli 2003

Pendaftaran:
Sdr. Mualim / Irwan - InfoKomputer Surabaya
Gd.KOMPAS, Jl. Raya Gubeng 98, Surabaya, Telp & Fax: (031) 504 9492

*Potongan harga 50 ribu, pendaftaran sebelum tanggal 18 Juli 2003

✁

supported by: Surabaya

Formulir Pendaftaran
Audio Video Editing Workhshop

PixelView GF4 Ti4200-8x/64, AGP 8x,
GPU 250MHz, RAM Clock 500MHz
64MB DDR, TV-out 130
PixelView GF4 MX440-8x,
GPU 250MHz, 128MB DDR 5ns,
RAM Clock 400MHz, TV out,
video in, DVI 85
PixelView GF4 MX440-8x/64, GPU 250,
64MB DDR 5ns, RAM clock 400MHz
TV-out,in, DVI 55
PixelView GF4 MX440SE/DDR, GPU
250MHz, 64MB DDR 4ns, TV out 48
PixelView GF4 MX440SE/sd,
GPU 250MHz, 64MB SDRAM, TV out 45
PixelView FX5800, AGP8X, DDRII,
VIVO, DVI 490
PixelView FX5600H, AGP8X,
DDR 3,5ns, VIVO, DVI 205
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 185
PixelView FX5200, AGP8X,
128MB DDR, TV OUT, DVI 98

MSI G4 MX440SES-T, AGP4X,
64MB SDR, TV OUT 58
MSI G4MX440 SET, AGP4X,
64MB SDR, TV OUT 64
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 91
MSI MX440-VTD8X, AGP 8X,
64MB DDR, DVI, VIDEO IN, TV OUT 110
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 165
MSI TI4200-VTD8X, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 185
MSI FX5200-TDR128, 128MB DDR,

DVI, VIDEO IN, TV OUT 135
MSI FX5600-VTDR, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 215

Elsa GloriaA4 980XGL nVidia Quadro4
900XGL, 128MB DDR, 650MHz DVI-I 802
Elsa GloriaA4 750XGL nVidia Quadro4
750XGL, 128MB DDR, 650MHz DVI-I 475
Elsa Synergy4, nVidia Quadro4 550XGL,
128MB DDR, 500MHz, DVI-I 301
Elsa Gladiac 518, nVidia GF4 MX440,
64MB DDRTV 103
Elsa Gladiac 517SEP nVidia GF4 MX440,
64MB DDR, video out, DVD 61
Elsa Gladiac 511, nVidia GF2 mx00,
64MB DDRAM, 47

Sapphire Radeon 9700 Atlantis pro,
128MB DDR, DVI VO (PAL) AGP 8X 366
Sapphire Radeon 9700 Atlantis,
128MB DDR, DVI VO 276
Sapphire Radeon 9500 Atlantis,
128MB DDR,DVI TVO 172
Sapphire Radeon 9000 Pro,
128MB DDR, VIVO (PAL) 106
Sapphire Radeon 7000,SDR,
TV-OUT(PAL),64MB 36
Sapphire Radeon 9800Pro
128MB DDR, DVI, AGP8X 470

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 25
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se nVidia
LMA II, 64 MB 128-bit DDR 350 Mhz,

CRT+TV out 70
DigiColor GF4 MX420 nVidia LMA II,
64 MB 128-bit DDR 350 Mhz,
CRT, TV out 60
DigiColor GF4 Ti 4200 nVidia LMA II,
128 MB 128-bit DDR, ViVo,
DVI+CRT, + TV out 165
DigiColor GF4 MX 440 AGP 8X
nVidia 128 MB 128-bit DDR,
CRT, + TV out 70

Impact mx440 64mb, AGP 4X DDR,
Tv out 48
Impact mx440 64mb DDR,
AGP8X tv out 58
Impact Ti4200 64mb, tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 159
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 97

Gigabyte R9700 Pro, radeon 9700pro,
TV-out S/RCA, DVI port DVI-I 342
Gigabyte R9500 , radeon 9500,
TV-out S/RCA, DVI port DVI-I 167
Gigabyte R9000 Pro,
ATI Radeon 9000Pro, 64MB DDR,
TV-out, S-Video, Twin View, DVI Port 97
Gigabyte R9000Pro II,
ATI Radeon 9000 Pro,  DDR, TV-out 137
Gigabyte R-9800 Pro, Radeon
9800Pro, 380MHz/ 680MHz,
128MB 547
Gigabyte R-9200 (VIVO), Radeon
9200, 250MHz/ 400MHz,
128MB 117

VIDEO EDITING CARD

Matrox RTX.10 550
Matrox RTX.100 965

Pinnacle Studio PCTV PCI 62
Pinnacle Studio DC10 plus ver 8.0 165
Pinnacle Studio Deluxe ver 8.0 285
Pinnacle MP20 VCD/SVCD/DVD 195
Pinnacle DV500DVD 470
Pinnacle Pro one V2 775
Pinnacle Pro one RTDV 985

Optibase Movie maker 100s 1260

tekram Digital Video Firewire 28

CD-RW DRIVE

Samsung CD ROM 52X 18

Aopen CD-ROM 56X OEM 23
Aopen CD-RW3248 32x12x48 50
Aopen CD-RW4850 48x12x50x 80
Aopen CD_RW 40x12x48 box 60
Aopen external CD-RW
40x12x48 box 135
Aopen DVD + CD RW
combo ultra slim, box 290

ION CD ROM 52X 19

Mitsumi CD-ROM 54x 22
Mitsumi CD-RW 48x24x48 48

Asus CD-RW external 5224 A-U
(USB) 52x24x48 137
Asus external slim combo
SCB 1608D 205
Asus DVD-R/RW 2x1x6x 341
Asus CRW 5224A, 52x24x48 60
Asus CRW 4824A, 48x24x52 55
Asus DVD 16x 48

TDK CDRW 48x24x48 IDE
( White Panel ) 53
TDK CDRW 48x24x48 IDE
( Black Panel ) 55
TDK CDRW 48x16x48
USB External 2.0 125
TDK CDRW 24x10x24 Slim
USB 2.0 180
TDK DVD R/RW Dual Format 290

RICOH CD RW 32x10x40 90

Plextor CD RW 48x24x48 Internal IDE 150
Plextor CD RW 8x8x24 external
USB slim 150
Plextor CD RW 24x10x40 external USB 190
Plextor CD RW 24x10x40
external USB slim 215
Plextor CD RW 12x10x32
SCSI external 285
Plextor CD RW Combo DVD+ CD RW 325

Pioneer DVD ROM  106SZ 55
Pioneer DVD-RW  A05 (2X8) 290

Whale CD ROM 56x 20
Whale CD-RW 52x24x52 47
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